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Anchor point
The point that remains stationary when you rotate, mirror, stretch, or scale an object. This point can be a handle 
on the object's selection box or its center of rotation.



Aspect ratio
The ratio of the width to the height of an image (x:y). For example, the aspect ratio of an image 640 x 480 pixels 
is 4:3. You can change an object's aspect ratio by stretching it in one direction.



Attributes
Editable characteristics that control the appearance of each object. For example, an object's fill attribute can be 
a solid color, a fountain fill, a pattern, or no fill. Text objects, on the other hand, have attributes such as typeface 
and character spacing.



Baseline
The imaginary line that aligns the bottom edges of a line of text.



Baseline shift
The baseline shift raises or lowers the baseline the imaginary line that aligns the bottom edges of a line of text.
By shifting the baseline, you can create subscript or superscript effects.



Brightness
In the HSB color model, the component that determines the amount of black in a color. See also Hue and 
Saturation.



Bullet
A dot or other character used to differentiate items in a list or add emphasis. You can choose a bullet style using 
the controls on the Paragraph dialog box.



Center of rotation
The point around which an object rotates. You can reposition the center of rotation using the mouse or by 
specifying exact values on the Transform dialog box.
The center of rotation is also the location of every object's built-in connector pin. By moving an object's center of
rotation, you also move its connector pin.



Character attributes
Characteristics for example, font, style, and point size
that control the appearance of text.



Character code
The number corresponding to a character in a character set, such as the ASCII or ANSI character sets.



Check box
A square box in a dialog box used to enable and disable options. An option is enabled when an X or check mark 
appears in the check box, and is disabled when the check box is empty. Click a check box to enable or disable it.



Clipboard
A temporary storage area where Corel Print Space places cut or copied objects. The Clipboard stores information 
until it is pasted into a layout or replaced by another object that has been cut or copied.



Cicero
A unit of measure equivalent to 12 didots. One inch equals 5.63 ciceros.



Click
To press and release a mouse button in a continuous motion.



Closed path
A continuous line that is joined at a point (or node) to form an object to which you can apply different fills and 
outlines.



CMY
A color model made up of cyan, magenta, and yellow. Use this color model if the drawing or image will be 
produced on a CMY device, such as a 3-ink printer. C, M, and Y values range from 0 to 255.



CMYK
The subtractive color model used in printing. Colors are created by assembling different densities of cyan, 
magenta, yellow, and black pigments on a surface.



CMYK255
A subtractive color model created by assembling different densities of cyan, magenta, yellow, and black 
pigments on a surface. C, M, Y, and K values range from 0 to 255.



Color palette
A tool that lets you select from an array of colors by clicking the mouse button. You'll find color palettes in the 
Shape Properties and Color Select dialog boxes as well as an on-screen palette that you can display anywhere on
the Corel Print Space window. You can also create your own color palettes with the colors you need to give your 
layouts the look you want.



Combine
To join multiple objects to create a single object.



Conical fill
A fill that shows a progression of colors in a circular path. You can apply custom or built-in conical fills that use a 
direct progression from one color to another or a cascade of different colors. Use conical fills to give shapes, 
shadows, and FlowLines a distinctive appearance.



Constrain
To restrict object movement to a particular plane, axis, or angle. Holding down the CTRL key while transforming 
or creating an object is the primary constraint method.



Corner radius
A term referring to the amount of rounding applied to an object's corners using the controls on the Shape 
Properties dialog box. By specifying a higher value for the corner radius, you increase the roundness of the 
selected object's corners.



Crosshairs
A pair of intersecting lines that can be dragged from the spot where the rulers meet to set the ruler origin.



Deselect
To indicate, by clicking on white space or selecting another object, that you do not want the next command or 
action to apply to the currently selected object.



Dialog box
A window displayed when additional information is needed to perform an action or command.



Double-click
To press and release the left mouse button twice in quick succession.



Drag
To move the mouse while holding down the left mouse button. Releasing the button completes the action.



Drag and drop
To drag an object to a new location using the mouse for example, dragging a Smart Library object into a layout.
You can also use drag and drop to import files created using other applications.



Drawing order
The sequence in which objects are drawn on the screen. When you use the Connect command, Corel Print Space 
connects the objects in the order in which you drew them.



Embedded object
Information from a file created in one program (the source program) that has been inserted into a file in another 
program (the destination program). For example, you can embed a Corel Print Space layout in a Microsoft Word 
document. You can edit the embedded information from within the destination program.



Filter
A program that translates one file format to another, or that processes the information in a file to produce a 
special effect, such as embossing. Corel Print Space uses filters for importing and exporting information.



Flyout
A menu command or tool that, when selected, displays two or more additional menu commands or tools.



Font
A set of characters in a given typeface and point size (see below). For example, 10 point Times Roman. Most 
fonts are available in families that include different styles such as bold and italic.

10 pts    18 pts    36 pts



Fountain fill
A fill that shows a progression of colors in a circular, square, straight, or radial path. You can apply custom or 
built-in fountain fills that use a direct progression from one color to another or a cascade of different colors. Use 
fountain fills to give shapes, shadows, and FlowLines a distinctive appearance.



Framed text
Text added and constrained within a non-printing frame that you create by dragging the mouse. By using framed
text, you can take advantage of advanced features like automatic wrapping and hyphenation, indenting, and 
bullets. You'll find framed text most effective for more extensive entries (for example, paragraphs) that call for 
advanced formatting techniques.



Grayscale
Color model that lets you choose from 256 shades of gray. Each color is defined as a single value between 0 and 
255, where 0 is darkest (black) and 255 is lightest (white). A single visual selector is used. A grayscale value can 
also be thought of in terms of the other color models: in RGB, a grayscale value corresponds to equal amounts of
all RGB colors; in CMYK, a grayscale value corresponds to zero C, M, and Y values with a positive K value; in HSB,
a grayscale value corresponds to zero H and S values with a positive B value.



Grid
A series of evenly spaced horizontal and vertical lines that can help you align objects. You can use the controls 
on the Grid and Ruler Setup dialog box to set the grid's parameters. For greater accuracy, you can also have 
objects in your layout snap to the grid.



Group
A set of objects that behaves as a single unit. All operations you perform on a group apply equally to each of its 
components.



Guidelines
Non-printing lines that you can use to help you align objects. You can place guidelines in the drawing window by 
dragging from the rulers or by using the controls on the Guidelines Setup dialog box. By enabling the Snap to 
Guidelines option, you can force objects to snap to a guideline when drawn or moved near it.



Handles
A set of eight black squares that indicate the corners and sides of an object's selection box. By dragging 
individual handles, you can scale, resize, or mirror an object.



Highlighting box
An invisible rectangle with eight visible handles that indicates and encloses the selected object. By dragging 
individual handles on an object's highlighting box (also called a selection box), you can scale or stretch the 
object.



HLS
Hue, lightness, and saturation are the components of the HLS color model, a variation on HSB and an alternative 
to RGB. Hue determines color (yellow, orange, red, etc.), lightness determines perceived intensity (lighter or 
darker color), and saturation determines color depth (from dull to intense). The circular visual selector defines 
the H value (0 to 360) and the S value (0 to 100); the vertical visual selector defines the L value (0 to 100).



Hot keys
A key or combination of keys that activates a command. Hot keys (also called keyboard shortcuts) give you quick
access to commands that you use frequently. You can change built-in keyboard assignments or assign new key 
combinations to any command. You can also create sets of keyboard assignments for use with different types of 
operations.



HSB
Hue, saturation, and brightness are the components in the HSB color model. Hue determines color, saturation 
determines color depth, and brightness determines the percentage of white used to make the color lighter or 
darker. This model is the closest approximation to how we perceive color.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other colors. Blue, green, 
and red, for example, are all hues. See also Saturation and Brightness.



Intersect
To create a new object using the area common to two or more objects. The resulting object takes on the fill and 
outline attributes of the topmost selected object.



Justify
An alignment option for framed text and text inside shapes that aligns the text between the right and left 
margins of the frame or object.



Landscape
A page oriented so that it prints from left to right across its longest dimension.



Layer
One of a series of transparent planes on which you can place objects in a layout. You can control how objects in 
your drawing overlay one another by moving the layer and the objects they contain. You can also choose to lock 
layers as well as make them invisible and non-printable.



Linear fill
A fill that shows a progression of colors in a straight line. You can apply custom or built-in linear fills that use a 
direct progression from one color to another or a cascade of different colors. Use linear fills to give shapes, 
shadows, and FlowLines a distinctive appearance.



Linked object
In Object Linking and Embedding (OLE), information from one file (the source file) that has been inserted into 
another file (the destination file) while maintaining a link to the source file. Changes made to the information in 
the source file are automatically made to the information in the destination files.



Marquee selecting
A method of selecting multiple objects by using the Pick tool and dragging the mouse to enclose them in a 
rectangle (called a marquee box).



Menu
A list of commands that appears when you click a name in the menu bar.



Menu bar 
The bar near the top of the Corel Print Space window that contains the names of its command menus.



Mirror
To create a mirror reflection of an object. You can mirror an object using the controls on the Transform dialog box 
or by holding down CTRL and dragging a side handle across the object.



Nested group
The grouping of two or more groups so that they behave as a single object.



Nodes
The points at the end of lines and curved segments. You can alter the shape of a line or curve by dragging one or
more of its nodes.



Nudge
To move an object in small increments using the arrow keys on the keyboard. You can adjust the nudge 
increment the distance the object moves each time you press an arrow key
using the Nudge number box on the Options dialog box.



Object
A generic term referring to any item you create or place in a layout. Objects include lines, shapes, graphics, and 
strings of text.



Object Linking and Embedding (OLE)
A method of bringing data objects from one Windows application into another.



OLE link
Refers to information that is created and stored in one program but is also referenced in another program. 
Changes made to the original information are automatically reflected in the in the other program. For example, 
you can link objects from Microsoft Word to Corel Print Space. Once this link is established, Corel Print Space 
automatically incorporates changes made to the Word file.



Path
The basic component from which lines and shapes are constructed in Corel Print Space. Paths can be open (for 
example, a line or curve) or closed (for example, a circle or polygon) and can constitute a single line or curve 
segment, or many segments joined together.



Pattern fill
A fill constructed by repeated instances of a particular pattern. You can create fountain fills using your own 
custom patterns or use the built-in patterns from Corel Print Space's pattern Smart Libraries.



Pica
A unit of measurement used primarily in typesetting. One pica equals approximately 1/6 of an inch (exactly 12 
points).



Polygon
A polygon is a shape with three or more sides. In Corel Print Space, you can create simple (for example, 
pentagons) or star-shaped polygons using the Polygon Tool.



Portrait
A page oriented so that it prints from left to right across its shortest dimension.



Printable page
The portion of the drawing window that will appear on the printed page. This area is enclosed by a rectangle with
a shadow effect below it and to its right. Although you can draw anywhere in the drawing window, only objects 
on the printable page appear in your print jobs.



Radial fill
A fill that shows a progression of colors in a series of concentric circles. You can apply custom or built-in radial 
fills that use a direct progression from one color to another or a cascade of different colors. Use radial fills to give
shapes, shadows, and FlowLines a distinctive appearance.



RGB
The initial letters in red, green and blue, the component colors in one of the color models you can use to create 
custom colors for use in color palettes and layouts.



Roll-up
A special type of window that contains controls often found in dialog boxes for example, command buttons, 
text boxes, list boxes and so on. Unlike most dialog boxes, roll-ups open after you apply the selected options, 
allowing you to make adjustments without having to re-open it. When you are not using a roll-up, you can roll it 
up and leave only the title bar visible.



Rotate
To reposition and reorient an object by turning it around its center of rotation. You can rotate an object using the 
mouse or by using the controls on the Transform dialog box.



Rulers
Measuring tools displayed on the left side and top of the editing window. You can control the unit of 
measurement and location of each ruler. Use the rulers to position the objects in your layouts.



Saturation
The component of the HSB color model that determines the purity or intensity of a color. As more colors are used
to mix a color, the color looks duller. See also Hue and Brightness.



Selection box
The invisible rectangle with eight visible handles that indicates and encloses the selected object. By dragging a 
handle on an object's selection box (also called a highlighting box), you can scale or stretch the object.



Snap
To force an object being drawn or moved to move next to a grid line or guideline.
When you connect objects and lines, Corel Print Space forces them to snap to connector pins and connection 
points to establish the connection you want.



Square fill
A fountain fill that shows a progression of colors in a series of concentric squares. You can apply custom or built-
in square fills that use a direct progression from one color to another or a cascade of different colors. Use square 
fills to give shapes, shadows, and FlowLines a distinctive appearance.



Status Bar
A display area that can show information about objects, ongoing operations, mouse position, and so on. You can 
specify the Status Bar's contents, appearance, and location within the Corel Print Space window.



Template
A file that provides the basic foundation for a specific layout or layout type. You can use any of Corel Print 
Space's built-in templates or create your own templates to suit your exact layout requirements.



Tick divisions
Evenly spaced division marks found between inch markers "ticks"
on the horizontal and vertical rulers. You can use the Grid and Ruler Setup dialog box to specify whether you want

8 or 10 division marks between each tick.



Tiling
The technique of repeating a small image to cover a larger surface. In Corel Print Space, you use tiling to create 
pattern fills. By decreasing the tile size, you increase the density of the fill.



Toolbar
A group of buttons that provides quick access to a series of related commands. You can use any combination of 
Corel Print Space's six preset toolbars or create your own containing the buttons and button arrangements you 
find most efficient.



Toolbox
The collection of buttons (normally found on the left side of the Corel Print Space window) used to perform tasks 
ranging from selecting and drawing objects to choosing outline and fill attributes.



Trim
To reshape an object by removing the area that is overlapped by another object. The object you trim retains its 
fill and outline attributes but has overlapped areas the area it shares with the object on top of it
removed.



True Type fonts
Fonts that print as vectors or bitmaps depending on the capabilities of your printer. True Type fonts print as they 
appear on screen and can be resized to any height.



Type Assist
Provides automatic formatting based on criteria you choose. You can use Type Assist to capitalize certain words 
or correct spelling and typographical errors automatically. You can also have Type Assist automatically replace 
shortcuts for common text strings or typographical errors for example, "asap" for "as soon as possible" or "teh"
for "the".



Unframed text
Text that is not constrained within the borders of an object or text frame. You'll find unframed text particularly 
effective for short text entries that require only simple character formatting.



Uniform color
A solid color, black, white, or shade of gray used to outline or fill objects. You can select uniform colors from the 
Outline and Fill tool flyouts, the on-screen color palette, or the Shape Properties dialog box.



Weld
The joining of overlapping objects' paths at points where they intersect. Welding also removes sections of the 
path between those intersect points. The resulting object assumes the fill and outline attributes of the topmost 
selected object.



YIQ
A color model used in television broadcast systems (North American video standard - NTSC). Colors are split into 
a luminance value (Y) and two chromaticity values (I and Q). On a color monitor, all three components are 
visible; on a monochrome monitor, only the Y component is visible. The square, two-dimensional visual selector 
defines the I and Q values, and the vertical visual selector defines the Y value. All values are scaled from 0 to 
255.



Zoom
To expand or reduce the image of a document or graphic on the screen. Zooming does not change the actual 
size of the text or graphics.



Aligning objects
Having objects line up is an important requirement for any professional layout. To help you achieve this 
professional look, Corel Print Space provides tools that make object alignment simple. Using these tools, you can 
align objects with one another, with the grid, and with the center of the drawing page.

{button ,AL(`distribute_overview;;;;;',0,"Defaultoverview",)} Related Topics



To align objects in a column
1. Select the objects you want to align.
2. Click Arrange, Column Align.
Tip

For even quicker column alignment, select the objects, then click the Column Align button on the 
Arrangement toolbar.

{button ,AL(`align_proc;;;;;',0,"Defaultoverview",)} Related Topics



To align objects in a row
1. Select the objects you want to align.
2. Click Arrange, Row Align.
Tip

For even quicker row alignment, select the objects, then click the Row Align button on the Arrangement 
toolbar.

{button ,AL(`align_proc;;;;;',0,"Defaultoverview",)} Related Topics



To align objects horizontally
1. Select the objects you want to align.
2. Click Arrange, Align and Distribute.
3. Click the Align tab.
4. Enable the Top, Center, or Bottom check box (found beside the preview box) to indicate how you want the 

objects to line up.
Tips

By default, Corel Print Space aligns objects with the selection box that surrounds them. To have alignment 
occur at the center of the page, enable the Align to Center of Page check box.

Enable the Align to Grid check box to have objects snap to the grid as they line up.
Watch the preview box to see how your settings will affect the objects.

{button ,AL(`align_proc;;;;;',0,"Defaultoverview",)} Related Topics



To align objects vertically
1. Select the objects you want to align.
2. Click Arrange, Align and Distribute.
3. Click the Align tab.
4. Enable the Left, Center, or Right check box (found above the preview box) to indicate how you want the 

objects to line up.
Tips

By default, Corel Print Space aligns objects with the selection box that surrounds them. To have alignment 
occur at the center of the page, enable the Align to Center of Page check box.

Enable the Align to Grid check box to have the objects snap to the grid as they line up.
Watch the preview box to see how your settings will affect the objects.

{button ,AL(`align_proc;;;;;',0,"Defaultoverview",)} Related Topics



To align objects horizontally and vertically
1. Select the objects you want to align.
2. Click Arrange, Align and Distribute.
3. Click the Align tab.
4. Enable the Left, Center, or Right check box (found above the preview box) to indicate how you want the 

objects to line up vertically.
5. Enable the Top, Right, or Bottom check box (found beside the preview box) to indicate how you want the 

objects to line up horizontally.
Tips

By default, Corel Print Space aligns objects with the selection box that surrounds them. To have alignment 
occur at the center of the page, enable the Align to Center of Page check box.

Enable the Align to Grid check box to have the objects snap to the grid as they line up.
Watch the preview box to see how your settings will affect the objects.

{button ,AL(`align_proc;;;;;',0,"Defaultoverview",)} Related Topics



COLOR MODEL RADIO BUTTON



Click the color model radio button to use a model for color editing. Color models are listed in the Model list box. 
Your choice of model is based on whether you are working with a drawing or an image. If you’re working with an 
image, you choice is further limited by the image mode. When you choose a model, number boxes for the 
model’s digital components are displayed to the left of the Model drop-down list.



PALETTES RADIO BUTTON



Click the palettes radio button to use a color matching palette. Palettes are listed in the Type list box. You may 
want to use the palettes if you are working with spot or process color systems by DIC, DuPont, FOCOLTONE, 
PANTONE, TOYO, or TRUMATCH. By using these palettes along with a color reference book, you can be reasonably
certain of how the colors will look when printed. The Uniform palette is also provided, with colors based on the 
RGB color model.



MIXERS RADIO BUTTON



Click the mixers radio button to use either the Color Blend or the Mixing area to create a custom color. The 
mixing modes are listed in the Mode list box.



LIST BOX



Lists the color models, color matching palettes, and mixing modes depending on the radio button that you 
enable. The label changes to "Model" for color models, "Type" for palettes, and "Mode" for mixers. Click this box 
to display the models, types, and modes that are available.



REFERENCE COLOR



The Reference Color swatch shows the color of the selected object when you open the dialog box, or the last 
color placed in the reference area from the color models, color matching palettes, mixers, or the custom palette. 
The contents of this swatch remains unchanged, regardless of the color editing you undertake, until you update 
it by clicking the Update Reference Color Button.



NEW COLOR



The New Color swatch shows the color of the selected object when you open the dialog box, or the last color 
selected from the color models, color matching palettes, mixers, or the custom palette. If this color is not 
available in the color gamut of the delivery system (which is usually your printer), the Printable Color swatch 
appears below it to show the color you’ll print in place of the New Color. You can update the New Color with the 
Printable Color by clicking Update New Color button.



PRINTABLE COLOR



The Printable Color swatch shows the color that will print if the color in the New Color swatch is not possible in 
the printer’s color space. The gamut mapping used to do this is determined using the Color Manager. Change the
printable color to the new color by clicking the Update New Color button. When the edited color does fall within 
the printer’s color space, this color does not display.



UPDATE REFERENCE COLOR BUTTON



Click the update reference color button to use the New Color as the Reference Color. This is useful when you are 
matching colors and wish to update your reference point. To swap the Reference and New Colors, use the Color 
Options, Swap Color menu selection.



UPDATE NEW COLOR BUTTON



Click the update new color button to use the Printable Color as the New Color, which you can then edit. This 
button appears only if the New Color is not available in the printer’s color space and a Printable Color swatch is 
displayed.



COMPONENT FIELDS



The color component fields show the numeric values of the selected color. These fields are accessible when you 
have edited the New Color through a color model or a mixer. They are inaccessible (grayed out) if the color is 
selected from a color matching palette. Components change for each color model and palette selected. For 
colors in the custom palette, the components correspond to the color model or color matching palette through 
which the color was edited.



NAME FIELD



The color name field shows the name of the selected color, if a name is available. Color names are shown only 
for the color matching palettes, the custom palette, and the color buttons for the Color Blend (which correspond 
to swatches in the custom palette). Use this field to name a new color or to rename the selected color in the 
custom palette. Colors in the color matching palettes cannot be renamed.



CUSTOM PALETTE



Shows the colors in the current user palette. Use the scroll bar on the right to display other areas of the palette. 
You can create new custom palettes and save them to create a library of palettes.



COLOR OPTIONS BUTTON



Click this button to open the Color Options menu. Use this menu to add the selected color to the custom palette, 
to swap the Reference Color with the Selected Color, and to use the features of the color model, palettes, and 
mixers.



PALETTE OPTIONS BUTTON



Click this button to open the Palette Options menu. Use this menu to rename or delete the selected color on the 
custom palette, to open and save the custom palette, and to start a new custom palette.



CMY



Cyan, Magenta, Yellow. Use this color model if the drawing or image will be produced on a CMY device, such as a 
3-ink printer. C, M, and Y values range between 0 and 255. The three-dimensional visual selector defines the C, 
M, and Y values; the vertical visual selector scales all current C, M, and Y values geometrically.



CMYK



Cyan, Magenta, Yellow, Black ("K" is used to indicate black). Use this color model to use CMYK values on a 
percentage scale (0 to 100). Color values correspond to CMYK swatches. The three-dimensional visual selector 
defines the level of cyan, magenta, and yellow; the vertical visual selector defines the level of black. This model 
is based on the printer primary colors.



CMYK 255



Cyan, Magenta, Yellow, Black ("K" is used to indicate black). Use this color model to use CMYK values on a 
computer-based scale (0 to 255). The three-dimensional visual selector defines the level of cyan, magenta, and 
yellow; the vertical visual selector defines the level of black. This model is based on the printer primary colors.



RGB



Red, Green, Blue. Use this color model if the drawing or image will be produced on a radiant device, such as a 
computer monitor or a television screen, or on a transparent media such as slides. R, G, and B values range 
between 0 and 255. The three-dimensional visual selector defines the R, G, and B values; the vertical Visual 
adjusts color brightness by scaling all current R, G, and B values geometrically. This model is based on the light 
primary colors.



HSB



Hue, Saturation, Brightness. An alternative to RGB. Hue determines color, saturation determines color depth, and
brightness determines the percentage of white used to make the color lighter or darker. This model is the closest
approximation to how we perceive color. There are two visual selectors. The circular selector is for hue (0 to 
360), and the triangular selector is used to simultaneously adjust saturation (0 to 100) and brightness. Also 
known as HSV (hue, saturation, value). The HLS color model is a variant.



HLS



Hue, Lightness, Saturation. A variation on HSB and an alternative to RGB. Hue determines color (yellow, orange, 
red, etc.), lightness determines perceived intensity (lighter or darker color), and saturation determines color 
depth (from dull to intense). The circular visual selector defines the H value (0 to 360) and the S value (0 to 100);
the vertical visual selector defines the L value (0 to 100).



LAB



The color model developed by Commission Internationale de l’Eclairage (CIE) based on three parameters: 
lightness (L*), green to red chromaticity (a*), and blue to yellow chromaticity (b*). The square two-dimensional 
visual selector defines the a* and b* coordinates from -60 to 60; the vertical visual selector defines the L* value 
from 0 to 100. This model is device-independent, and encompasses the color gamuts of both the CMYK and the 
RGB color models.



YIQ



YIQ is the color model used in television broadcast systems (North American video standard - NTSC). Colors are 
split into a luminance value (Y) and two chromaticity values (I and Q). On a color monitor, all three components 
are visible; on a monochrome monitor, only the Y component is visible. The square two-dimensional visual 
selector defines the I and Q values, and the vertical visual selector defines the Y value. All values are scaled from
0 to 255. In Corel PHOTO-PAINT, the Y component of the splitting process produces a grayscale image that is 
often superior to results obtained with a grayscale conversion using the Convert To command from the Image 
menu.



GRAYSCALE COLOR MODEL



Use grayscale to choose from 256 shades of gray. Each colors is defined as a single value between 0 and 255, 
where 0 is darkest (black) and 255 is lightest (white). A single visual selector is used. A grayscale value can also 
be thought of in terms of the other color models: in RGB, a grayscale value corresponds to equal amounts of all 
RGB colors; in CMYK, a grayscale value corresponds to zero C, M, and Y values with a positive K value; in HSB, a 
grayscale value corresponds to zero H and S values with a positive B value.



UNIFORM PALETTE



The uniform palette offers 255 standard RGB colors for quick selection. Colors are expressed as RGB values to 
the right of the Type box. Use the scroll bar on the right to display other areas of the palette. Colors can be 
displayed by name through the Color Options menu (the color names correspond to the R, G, and B values).



DIC PALETTES



Offers colors that are available through the DIC Color Guide, DIC Color Guide Part II, and DIC Traditional Colors of 
Japan. Colors in these palettes are created by mixing DIC brand inks. Reproduction through Corel applications is 
achieved through the CMYK color space. Colors can be displayed by name or swatch through the Color Options 
menu. Swatches are identified by palette and color ID code: 

DIC id# for DIC Color Guide
DIC Part II id# for DIC Color Guide Part II
DIC Traditional id# for DIC Traditional Colors of Japan



DUPONT PALETTE



Offers colors that are available through the DuPont Spectramaster solid color library. This library was developed 
to provide a paint color selection and matching tool for industrial coatings and colorants. Colors are based on 
L*a*b* and are converted to RGB for display and CMYK for printing. Colors can be displayed by name or swatch 
through the Color Options menu.



FOCOLTONE PALETTE



Offers colors that are available through the FOCOLTONE color system. Colors are based on CMYK, and therefore 
do not add additional color separation plates. Use the scroll bar on the right to display other areas of the palette.
Colors can be displayed by name or swatch through the Color Options menu.



PANTONE SPOT COLORS PALETTE



Offers colors that are available through the PANTONE Spot Colors (also known as PANTONE Matching System). 
You define tint through the Tint Number Box, ranging from 0 (lightest) to 100 (darkest) to control saturation. You 
can also define PostScript options. Since spot colors correspond to solid inks and are not CMYK-based, each 
unique color applied to an object results in an additional color separation plate. In Corel DRAW, you can use spot 
colors freely. In PHOTO-PAINT, you can use spot colors only in CMYK images to affect duotones. Colors can be 
displayed by name or swatch through the Color Options menu. See also PANTONE Process Color system.



PANTONE PROCESS COLOR PALETTE



Offers colors that are available through the PANTONE Process Color system, which is based on the CMYK color 
model. The first 2,000 colors are two-color combinations; the remainder are three- and four-color combinations. 
Colors are based on CMYK, and therefore do not add additional color separation plates. Use the scroll bar on the 
right to display other areas of the palette. Colors can be displayed by name or swatch through the Color Options 
menu. See also PANTONE Spot Colors.



TOYO PALETTE



Offers colors that are available through the TOYO 88 Color Finder system. The range of colors offered here 
includes those created using TOYO process inks and those that are reproduced using TOYO standard inks. Colors 
can be displayed by name or swatch through the Color Options menu.



TRUMATCH PALETTE



Offers colors that are available through the TRUMATCH color system. This system is based on the CMYK color 
model and therefore colors do not add additional color separation plates. Colors are organized by hue (red to 
violet), saturation (deep to pastel), and brightness (adding or removing black). Use the scroll bar on the right to 
display other areas of the palette. Colors can be displayed by name or swatch through the Color Options menu.



COLOR SEARCH FIELD



Click the Search field to find a color in the palette using the color name. You can search on a full or partial name. 
Color names consist of two parts: the first is the palette name, and the second is the color name or code. A 
search can be done using only the color name or code.



TINT FIELD



Used the Tint field to control the saturation of the selected PANTONE Spot Color. This color parameter is available
only for the PANTONE Spot Color palette.



COLOR BLEND



Use the color blend to create a four-way blend of color and choose from the range of color variations. Grids are 
square, ranging in size from 3x3 to 25x25 (smaller grids produce more distinct colors while larger grids produce 
more subtle color variations). Colors are selected from the custom palette and can be mapped to the CMYK, RGB,
and HSB color models.



COLOR BUTTON



The color button displays the color chosen for this corner of the grid. Click the color button in each corner to 
display the custom palette from which you can choose a new color.



AUTOBLEND BUTTON



Click this button to enable or disable automatic blending. When enabled, colors are automatically blended in the 
grid when a new color is selected in the color boxes. When disabled, colors are not automatically blended in the 
grid.



MIXING AREA



Use the mixing area to mix any number of colors from the color models, palettes, or color blend. The color in the 
New Color swatch is the active color in the mixing area.



PAINT BRUSH



Use the paint brush to apply color to the mixing area (the cursor changes to a paintbrush). Adjust the blend 
value through the Blend number box (this is a means of controlling color saturation). Brush size can be adjusted 
to small, medium, or large, and hard, medium, and soft through the Color Options button.



EYEDROPPER



Used to pick up color from the mixing area (the cursor changes to an eye dropper).



BLEND FIELD



Click the Blend number box to increase or decrease the amount of color blending when you apply color to the 
mixing area. A large value increases the blending effect (the color is more transparent); a low value decreases 
the blending effect (the color is more opaque).







These controls let you specify the number of rows and columns of labels you want to appear on each sheet.



The available corner styles.



The available line cap styles.



These controls let you change the nib shape and angle to create calligraphic effects.



These controls specify the size of each label on the sheet.



These controls change the margins of a sheet of labels.    



These controls change the distance between labels in a sheet.



The number of pages on each sheet of paper. Some layout styles have more than one page per sheet.



The width of the text on each page.



The width of the text on each page.



The type of fold or cut used in the specified layout style.



The height of the text on each page.



The height of the text on each page.



The label type.



Displays controls for choosing and editing fountain fills.



Displays controls for choosing and editing two-color bitmap pattern fills.



Displays controls for choosing full-color bitmap pattern fills.



Displays controls for choosing texture fills.



Displays controls for choosing vector pattern fills.



Displays controls for choosing PostScript texture fills.



Displays controls for choosing uniform color fills.



Displays a pair of boxes inside the selected object for scaling and offsetting tiles.
Drag the left box to offset the first tile.
Drag the node along the bottom edge of the boxes to scale the tiles. Hold down the CTRL key as you drag 

to maintain the pattern's aspect.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.



Prompts you to choose an existing object, and displays that object's fill attributes in the Fill Roll-up. You can then 
easily apply the same fill to other objects.



Opens a dialog box where you can further refine your fill properties. 



Applies your fill to the selected objects. If no objects are selected, you can define the default fill for new objects.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new background color.



Changes the foreground color to one you select from a palette.



Changes the background color to one you select from a palette.



Displays a linear fountain in the Preview box. 
To change the angle of the linear fountain, click in the preview box. Hold down the CTRL key to constrain the 
angle to multiples of 15 degrees.



Displays a radial fountain in the Preview box. 
To move the center of a radial fountain, click in the preview box. Hold down the CTRL key to constrain your 
movements to 10-percent increments.



Displays a conical fountain in the Preview box. 
To move the center of a conical fountain, left-click in the preview box. Hold down the CTRL key to constrain

your movements to 10-percent increments. 
To change the angle of a conical fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Displays a square fountain in the Preview box. 
To move the center of a square fountain, left-click in the preview box. Hold down the CTRL key to constrain 

your movements to 10-percent increments. 
To change the angle of a square fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Shows the name of the current texture. Click in this field to get a drop-down list of the textures in this library.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Previews the current fill.



Lists the available textures by name. Click on a name, or use the scroll bars to see the entire list.
Each name represents a special type of pattern fill which will only print on a PostScript printer. In the Drawing 
Window, PostScript textures are represented by the letters PS instead of the actual pattern.



Changes the current color. Click the color you want, or use the scroll bars to see more of the palette.



Displays the current color.



Opens a box with a selection of arrowheads you can apply to the start of an open path. 
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Opens a box with a selection of arrowheads you can apply to the end of an open path. 
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a palette of outline colors. Use the scroll bars to see other colors in the list. Click the one you want.



Opens the Outline Pen dialog box where you can access all of the available Outline Pen controls.



Applies your choices to the selected objects. If no objects are selected, you can define the default outline for new
objects.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Specifies whether the outline is placed behind or in front of the object's fill. When placed behind, only half the 
outline's thickness will be visible. This option is particularly useful for outlined text.



Specifies whether the outline thickness and nib orientation remain the same or change in proportion to the 
object.
If enabled, the outline thickness increases when the object is enlarged (by scaling or stretching) and decreases 
when the object is made smaller. If the object is rotated, the nib shape also changes accordingly.



Toggles the current outline on and off. If the button is depressed, the object will have no outline.



Displays controls for choosing and editing fountain fills.



Displays controls for choosing and editing two-color bitmap pattern fills.



Displays controls for choosing full-color bitmap pattern fills.



Displays controls for choosing texture fills.



Displays controls for choosing vector pattern fills.



Displays a pair of boxes inside the selected object for scaling and offsetting tiles.
Drag the left box to offset the first tile.
Drag the node along the bottom edge of the boxes to scale the tiles. Hold down the CTRL key as you drag 

to maintain the pattern's aspect.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.



Prompts you to choose an existing object, and displays that object's fill attributes in the Fill Roll-up. You can then 
easily apply the same fill to other objects.



Opens a dialog box where you can further refine your fill properties. 



Applies your fill to the selected objects. If no objects are selected, you can define the default fill for new objects.



Previews the current fill.



Opens a flyout from which you can choose a new starting color.



Opens a flyout from which you can choose a new ending color.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new background color.



Displays a linear fountain in the Preview box. 
To change the angle of the linear fountain, click in the preview box. Hold down the CTRL key to constrain the 
angle to multiples of 15 degrees.



Displays a radial fountain in the Preview box. 
To move the center of a radial fountain, click in the preview box. Hold down the CTRL key to constrain your 
movements to 10-percent increments.



Displays a conical fountain in the Preview box. 
To move the center of a conical fountain, left-click in the preview box. Hold down the CTRL key to constrain

your movements to 10-percent increments. 
To change the angle of a conical fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Displays a square fountain in the Preview box. 
To move the center of a square fountain, left-click in the preview box. Hold down the CTRL key to constrain 

your movements to 10-percent increments. 
To change the angle of a square fountain, right-click in the preview box. Hold down the CTRL key to 

constrain the angle to multiples of 15 degrees.



Previews the current pattern. Click the preview box to display a list of available patterns.



Opens the Load dialog box, where you can load a new vector pattern file.



These controls let you choose the foreground and background colors of your pattern.



Opens a flyout from which you can choose a new background color.



Opens a flyout from which you can choose a new background color.



Opens a flyout from which you can choose a new foreground color.



Opens a flyout from which you can choose a new foreground color.



Opens the PostScript Options Dialog Box, where you can adjust the halftone screen settings for spot colors. This 
button is only active when there is a spot color selected for both the background and foreground.



Opens the Two-Color Pattern Editor, where you can create your own two-color patterns.



Opens the Import dialog box, where you can import a graphic to use as your pattern.



Permanently removes the current pattern from the pattern list.



Reveals controls for editing the pattern's tiling properties.



Sets the size of your pattern tiles. You can choose one of the pre-set sizes, or enter custom dimensions.



Sets the tile size to 0.25 x 0.25 inches, or to 25% if Scale pattern with object is enabled.



Sets the tile size to 0.50 x 0.50 inches, or to 50% if Scale pattern with object is enabled.



Sets the tile size to 1.00 x 1.00 inches, or to 100% if Scale pattern with object is enabled.



The width of each tile. You can specify new tile widths from 0.1 to 15 inches.



The width of each tile.



Displays the units you are using to measure the tile width. Click in this field to display a list of available units. 
The Width value is automatically converted when you change units.



The height    of each tile. You can specify new tile heights from 0.1 to 15 inches.



The height    of each tile.



Displays the units you are using to measure the tile height. Click in this field to display a list of available units. 
The Height value is automatically converted when you change units.



Sets the offset of the first tile (and therefor, the rest of the pattern) relative to the top right-hand corner of the 
object. If you want the pattern to start flush with the corner, set these two values to zero.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the horizontal position of the first pattern tile relative to the left side of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Sets the vertical position of the first pattern tile relative to the top of the object.



Shifts rows or columns of tiles so that the pattern is staggered, rather than continuous.



Shifts alternating rows of tiles by the amount specified.



Shifts alternating columns of tiles by the amount specified.



Shifts alternating rows or columns by the amount specified.



Shifts alternating rows or columns by the amount specified.



Shifts alternating rows or columns by the amount specified.



Alters the pattern tiles so that they seem to be continuous.



Toggles between absolute and proportional tile sizes. When the option is enabled, the tiles will grow and shrink 
with the object.



The width of each tile. You can specify widths from 5 to 500% of the object width.



The width of each tile. You can specify widths from 5 to 500% of the object width.



The height of each tile. You can specify heights from 5 to 500% of the object height.



The height of each tile. You can specify heights from 5 to 500% of the object height.



Displays a magnified, editable image of your pattern as you draw it. Left-click to add a colored area to the grid, 
right-click to erase.



Changes the resolution of the Edit Grid to 16 x 16 squares. You lose all pattern edits when you change 
resolutions.



Changes the resolution of the Edit Grid to 32 x 32 squares. You lose all pattern edits when you change 
resolutions.



Changes the resolution of the Edit Grid to 64 x 64 squares. You lose all pattern edits when you change 
resolutions.



Changes the pen size to 1 grid square.



Changes the pen size to a 2 x 2 square.



Changes the pen size to a 4 x 4 square.



Changes the pen size to an 8 x 8 square.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Shows the name of the current texture. Click in this field to get a drop-down list of the textures in this library.



Displays the current fountain fill type. Click in this field to choose one of the four fountain fill types.
A Linear fountain fill changes color in one direction. A Radial fountain fill changes color in concentric circles from 
the center of the object outwards. A Conical fountain fill radiates from the center of the object like rays of light. A
Square fountain fill changes color in concentric squares from the center of the object outwards.



Repositions the center of a radial, conical, or square fountain fill so that it no longer coincides with the center of 
the object. Negative values shift to the left, positive values shift to the right.



Repositions the center of a radial, conical, or square fountain fill so that it no longer coincides with the center of 
the object. Negative values shift the center down, positive values shift it up.



Changes the angle of linear, conical, and square fountain fills. Positive values rotate the fill counter-clockwise, 
negative values rotate it clockwise.



Changes the number of bands used to display and print the fountain fill. For a smoother gradation, increase the 
number of steps. 



Toggles the lock on the Steps box.



Increases the amount of From and To color in your fountain fill. The ends of a fountain fill will often be obscured 
by the edges of circular and irregular objects. Padding the edges will allow more of the end colors to show.
The Edge Pad option is not available for conical fills.



Previews the selected fountain fill.
You can change the fill's orientation by dragging the pointer in the preview box. Left-click to move the center of 
radial, conical and square fills. Right-click to change the angle of linear, conical, and square fills. Holding down 
the CTRL key while dragging constrains your adjustments to regular increments.



These controls let you modify the intermediate colors of your fill.



Determines the intermediate fill colors from a straight line beginning at the From color and continuing across the 
color wheel to the To color.
This option produces a color series composed of blends of your From and To colors.



Opens a flyout from which you can choose a starting color for your fill.



Opens a flyout from which you can choose an ending color for your fill.



Displays controls to set the starting and ending colors of your fill, and the color wheel path that the 
intermediated colors follow. You can create a direct blend containing only two colors, or a multi-colored rainbow 
blend.



Determines the intermediate colors from a counter-clockwise path around the color wheel.



Determines the intermediate colors from a clockwise path around the color wheel.



Shows the color path that determines your intermediate fill colors.



Adjusts the midpoint of the color blend.



Displays controls that let you manually determine the intermediate colors of your fountain fill. You can add up to 
99 color markers to control your blend.



Shows the position of the current color marker. You can change a marker's position by editing its position value.



Opens a flyout from which you can change the current color.



Changes the current color. Click the color you want, or use the scroll bars to see more of the palette.



Previews your custom fountain fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Previews your custom fountain fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Shows the positions of your color markers. Each triangle marks a peak of color in your fountain fill. Once you 
have selected a color marker by clicking it, you can change its color with the on-screen palette.
You reposition a peak by dragging it along the marker bar, and you delete it by double-clicking. You can add a 
new peak by double-clicking a blank spot on the bar.



Displays a list of pregenerated fountain fills. You can save a modified fill by typing a name in this field and 
clicking on the add button.



Saves the current fountain fill. If you have created the fill from scratch, you must first type a name in the Presets 
field.



Deletes the selected fill from the Presets list.



Opens the PostScript Options Dialog Box, where you can adjust the halftone screen settings for spot colors.



Shows the current texture library. Click in this field to get a drop-down list of available texture libraries.



Opens the Save Texture As dialog box, where you can add a new texture to one of your libraries, or overwrite an 
existing texture with the current one.
You cannot overwrite textures in the Style Library, but you can modify them and then save the modified textures 
in other libraries.



Deletes the selected texture. You can delete textures from any Library except the Styles library.



Shows a list of the textures in the current texture library. Click on the texture you want, or use the scrollbars to 
see the entire list.



Displays a preview of the texture with the current parameters. Click the Preview button to update the preview 
after making changes to the texture parameters.



Updates the texture preview to reflect any changes to the texture parameters.
If you have not made any changes, the Preview button varies the selected texture by randomly changing all 
unlocked parameters. Click a parameter's Lock icon to lock or unlock it.



Opens the Texture Options dialog box where you can set the resolution and maximum tile width of your texture 
fill.



Lists parameters for the current texture. Changing one or more of these parameters alters the appearance of the
texture. 
To see the effect of your changes to the texture parameters, click the Preview button. If you have not made any 
changes since the last time you updated the preview, clicking the Preview button randomizes all unlocked 
parameters. Click a parameter's Lock icon to lock or unlock it.



Lists parameters for the current texture. Changing one or more of these parameters alters the appearance of the
texture. 
To see the effect of your changes to the texture parameters, click the Preview button. If you have not made any 
changes since the last time you updated the preview, clicking the Preview button randomizes all unlocked 
parameters. Click a parameter's Lock icon to lock or unlock it.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven numeric parameters that control different aspects of the texture generation. 
To change a numeric parameter, enter a value in the text box.



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Each texture can have up to eleven color    parameters that control the different shades used to create the 
texture. To change a color, click on the color button and select a new one from the pop-up palette. Click the More
button to create a color or to choose it by name. 



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



Locks and unlocks the texture parameters. 
If you have not made changes to any parameters, clicking the Preview button varies the selected texture by 
randomly changing all unlocked parameters. Locked parameters are not randomized when you click the Preview 
button.



The name of your texture. It can be up to 32 characters long, including spaces.
You cannot save new textures or overwrite existing textures in the Style Library.



The name of the library where you want to store your texture. It can be up to 32 characters long, including 
spaces. 
You cannot save new textures or overwrite existing textures in the Style Library.



Sets the resolution at which your pattern will print.



Sets the maximum width of your pattern at full resolution. Larger tile widths take more memory to draw.



The amount of memory your bitmap will use at its maximum tile width. Reduce the Maximum Tile Width value to 
conserve memory.



Returns the texture options to their default settings.



Opens a flyout from which you can choose a new color.



These controls let you add arrowheads and other line-ending shapes to the ends of lines (open paths). 



Opens a flyout containing a list of arrowheads and symbols you can apply to the beginning of a line. Use the 
scroll bars to see other arrowheads in the list. Click the one you want. To close the flyout without making a 
selection, press the ESC key.
To find out which terminus of a line is the beginning, select the line with the Shape Tool and press the HOME key.



Opens a flyout containing a list of arrowheads and symbols you can apply to the end of a line. Use the scroll bars
to see other arrowheads in the list. Click the one you want. To close the box without making a selection, press 
the ESC key.
To find out which terminus of a line is the end, select the line with the Shape Tool and press the END key.



Opens a menu of options that you can apply to the start of the line. 
The None option removes the current arrowhead from your line.
The Swap option moves the arrowhead to the other end of the line.
The Edit option opens the Arrowhead Editor, where you can change the size, Placement , and general 

shape of the arrowhead.
The Delete option deletes the current arrowhead.



Opens a menu of options that you can apply to the end of the line. 
The None option removes the current arrowhead from your line.
The Swap option moves the arrowhead to the other end of the line.
The Edit option opens the Arrowhead Editor, where you can change the size, Placement , and general 

shape of the arrowhead.
The Delete option deletes the current arrowhead.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Displays the current thickness of the outline. To change the width, enter a new value, or click the arrow buttons.



Displays the units you are using to measure the line width. Click in this field to display a list of units. The width 
value is automatically converted when you change units.



Opens a flyout containing a list of dashed styles that you can apply to your line. Use the scroll bars to see other 
line styles in the list. Click the one you want. To close the flyout without making a selection, press the ESC key
You can create dotted lines by applying round Line Caps to a line style with short, widely-spaced dashes.



Draws mitered (pointed) corners for polygons, and selects a square nib shape.



Draws rounded corners for polygons, and selects a round nib shape.



Draws blunted corners for polygons, and selects a square nib shape.



Truncates the line at each endpoint.



Draws round caps extending beyond the ends of the line.



Draws square caps extending beyond the ends of the line.



Previews the shape and orientation of the nib, showing the effects of varying Angle and Stretch. You can also 
change the shape of the nib by dragging in the preview box. 



Previews the shape and orientation of the nib, showing the effects of varying Angle and Stretch. You can also 
change the shape of the nib by dragging in the preview box. 



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Changes the width of the nib. A square nib has a stretch value of 100%; smaller values will make the nib 
narrower, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Varies the angle of the nib, creating a calligraphy effect.



Resets the Angle value to 0.0 degrees and the Stretch value to 100%.



Specifies whether the outline is placed behind or in front of the object's fill. When placed behind, only half the 
outline's thickness will be visible. This option is particularly useful for outlined text.



Specifies whether the outline thickness and nib orientation remain the same or change in proportion to the 
object. 
If enabled, the outline thickness increases when the object is enlarged (by scaling or stretching) and decreases 
when the object is made smaller. If the object is rotated, the nib shape also changes accordingly.



Displays a magnified, editable image of your arrowhead. You can stretch the arrowhead with the solid markers, 
and move it with the hollow markers.



Displays a magnified, editable image of your arrowhead. You can stretch the arrowhead with the solid markers, 
and move it with the hollow markers.



Flips the arrowhead horizontally.



Flips the arrowhead vertically.



Centers the arrowhead horizontally with respect to the X marker.



Centers the arrowhead vertically with respect to the X marker.



Magnifies the arrowhead by a factor of four. Helpful when positioning the arrowhead.



Selects a line thickness. Each click on the scroll arrows changes the thickness by .01 inches. Scroll down 
repeatedly for the Hairline or No Outline options.



Selects a line thickness from .001 to 0.5 inches. Each click on the scroll arrows changes the thickness by .01 
inches. Scroll down repeatedly for the Hairline or No Outline options.



Opens a box with a selection of arrowheads you can apply to the ends of open paths. The left and right selectors 
let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Opens a box with a selection of arrowheads you can apply to the ends of open paths. The left and right selectors 
let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. Click the one you want. To close the box without making a 
selection, press the ESC key.



Displays a palette of outline colors. Use the scroll bars to see other colors in the list. Click the one you want.



Prompts you to choose an existing object, and displays that object's outline attributes in the roll-up. You can then
easily apply the same outline to other objects.



Opens the Outline Pen dialog box where you can access all of the available Outline Pen controls.



Applies your choices to the selected objects. If no objects are selected, you can define the default outline for new
objects.



Swaps the height and width values so that the vertical dimension of the page is greater than the horizontal 
dimension. This switch is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



Swaps the height and width values so that the horizontal dimension of the page is greater than the vertical 
dimension. This switch is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



The current paper style. Click in this field to get a list of available paper styles. When you select a style, the 
height and width values will adjust to reflect the paper you are using.
Use the Custom style to manually determine the size of your page. Use the Labels style to create your own 
labels.



The width of the page. When you modify this value, the paper style is automatically set to Custom.



The height of the page. When you modify this value, the paper style is automatically set to Custom.



Displays the units you are using to measure the page size. Click in this field to display a list of available units. 
The Height and Width values are automatically converted when you change units.



Queries the current printer for the page size and orientation, and displays those dimensions in the Width and 
Height fields.



Previews the page dimensions and orientation, and shows examples of the page layout you have selected.



Previews the page dimensions and orientation, and shows examples of the page layout you have selected.



Toggles the working page border in the Drawing Window. When you disable this option, the shadowed page 
outline is no longer displayed in the Drawing Window.
Note that any part of your drawing that falls outside the border will not be printed, so it's a good idea to make 
sure this option is enabled before printing.



Displays two facing pages at the same time in the Drawing Window. 
When this option is enabled, and your document has multiple pages, individual objects can lie across two facing 
pages. Such objects will not print in the page gutter.
This option is not available for top-fold and tent cards.



Indicates whether you want to begin a document with facing pages on the left or right page. This option is only 
available when using the Book layout style or the Facing Pages option.



Puts a printable background frame the same size as the page on the screen. The frame will have the default fill 
and outline, and you can change it the same way as you would any other object.



Opens a flyout that lets you color the Preview screen to approximate the paper you plan to print on. 
The color you choose is for viewing and information only; it does not print. If you want a color background that 
does print, choose Add Page Frame.



Displays the current page layout style. Click in this field to get a list of available styles. When you choose a style 
from the list, an example of it appears in the preview box above.
Once you've chosen a page layout style, you still need to insert the required number of pages for the particular 
style. For example, Side-Fold Card prints four pages per sheet, however, when you start a new drawing and 
choose this style, you still need to insert the three remaining pages.
Note that the layout styles in the Print Options Dialog Box will not work properly unless the Full Page Layout is 
selected here. Any other combination will have unpredictable results.



Opens the Customize Label dialog box, where you can modify an existing label style, or create your own labels 
from scratch.



Shows the available label styles, grouped by manufacturer.



Saves the current custom label setting under a name you specify.



Automatically adjusts the margins to evenly space the labels on the page.



Automatically equalizes the space between labels. If possible, auto spacing will keep the labels within the 
defined margins.



Adjusts the bottom page margin.



Adjusts the number of label columns.



Removes the current label style from the Label Style list.



Automatically sets the right margin to mirror the left, and the bottom margin to mirror the top.



Adjusts the height of each label.



Adjusts the horizontal space between labels.



Sets the Gutter units. When you choose a new unit, the values are automatically recalculated.



Adjusts the left page margin.



Sets the Margin units. When you choose a new unit, the values are automatically recalculated.



Previews the current label settings.



Adjusts the right page margin.



Toggles the label corners from square to rounded.



Adjusts the number of label rows.



Shows the name of the current label style.



Adjusts the top page margin.



Adjusts the vertical space between labels.



Adjusts the width of each label.



Sets the Label Size units. When you choose a new unit, the values are automatically recalculated.



The name of the new custom label style.



Three unique PHOTO-PAINT controls in the Full-Color Bmp Pattern DB



Enable to use the original (default) tile size of the currently selected bitmap pattern.



Enable to scale the tile pattern to fit entirely within the tile Preview window.



Enable to maintain identical tile width and height values. When enabled, any value entered in one number box 
will cause the other box to change automatically.





Opens a Windows dialog box which allows you to set printing options not controlled by Corel.



Opens the Print Options dialog box which allows you to set advanced printing parameters such as sizing and 
positioning, halftone screening, color separations, etc.



Indicates which device driver is selected. Click the arrow to access a list of other available printer and 
imagesetter drivers.
If the driver you need is not listed, install it by using the usual Windows procedure.



Ensures that colors will print as expected.
The printer color profile shown here matches the printer that was chosen in the System Profile (Color Manager).
If you want your print job to be filtered through a different profile, you must go back to the Color Manager, select
the appropriate printer, and generate a new System Profile.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Saves the current print settings as a new style.



Deletes the selected style.



Creates a .PRN file from your print job (instead of actually printing).



Prepares the .PRN file for printing from a Macintosh computer.



Identifies the number of copies that will be printed.
Note

When printing to file, request one copy only, with no collation.



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Prints one full set of the selected pages before printing the second full set (e.g., a first set of pages 1 to 10 will 
print, before the second set of pages 1 to 10 will print, and so on).
If you do not enable Collate, the requested number of copies of each selected page will print before the next 
page will print (e.g., five copies of page 1 will print before five copies of page 2 will print, and so on).



Print all pages in your document.



Prints only the objects that are currently selected.



Prints only the page currently displayed.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Specifies the pages, or the range of pages, to print.
A dash (-) between numbers defines a range of sequential pages (e.g., 1-5 will print pages 1 to 5).
A comma (,) between numbers defines a series of non-sequential pages (e.g., 1,5 will print pages 1 and 5 

only).
Any combination of dashes and commas is supported (e.g., 1-3, 5, 7, 10-12 will print pages 1, 2, 3, 5, 7, 

10, 11 and 12).
Inserting a tilde (~) between two numbers will cause those two pages plus every second page in between 

to print. For example, 1~6 will print pages 1, 3, 5 and 6. If you enter 2~6, pages 2, 4 and 6 will print.
The option works in conjunction with the Print Odd/Even Pages option.



Allows you to specify whether odd, even, or both odd and even pages will be printed.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Displays your file as it will print and allows you to size and reposition your image. Right click on the preview 
window to choose one of four options: Preview Image, Preview in Color, Full Image Drag, and Print This Sheet 
Now.
Note

For your image to appear, you must enable Preview image. Otherwise your image will be represented by a 
bounding box.



Allows you to move back in a multi-page document.



Allows you to move forward in a multi-page document.



Changes to a full screen preview. Click it again to return to a normal preview.



Displays your file in the Preview box as it will print.



Allows you to choose whether the Preview box will display a composite view of your print job or only a specific 
color separation.
Note

This feature is only available when Print Separations is enabled.



Prints the filename, current date, and time (and tile number, if applicable) at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top
of the sheet.
Note

To see the file information, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work. If not, you can request that the file information be 
printed within the page.



Places page numbers on the printed sheets.
Note

To see the page numbers, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Causes the file information to print within the page.
Tip

If the working page size is identical to the paper or film size, enable File Info Within Page. Make sure the 
artwork is positioned so that the file information does not overlap it.



Prints crop marks. These marks are used as alignment aids when trimming the printed output down to its final 
size.
Note

To see the crop marks, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints crop marks only along the outer edge of the sheet.
Tip

This option is often preferable when you are printing multiple layouts per sheet.



Prints registration marks on each sheet. These marks serve as guides for aligning color separations.
Note

To see the registration marks, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work.



Prints a bar of the six basic colors (red, green, blue; cyan, magenta, yellow) beside your artwork. These color 
patches are used to verify the quality of the printed output.
Note

To see the calibration bar, you must define a working page size that is smaller than the dimensions of the 
actual sheet of paper or film that is used to image the work.



Prints a Densitometer Scale, a bar of varying shades of gray, on each separation sheet. This is an advanced 
feature that allows you to check the accuracy, quality, and consistency of the output with an instrument called a 
densitometer.
Note

To see the densitometer scale, you must define a working page size that is smaller than the dimensions of 
the actual sheet of paper or film that is used to image the work



Prints a negative image when enabled.



Specifies that the film emulsion faces down when enabled.
Emulsion is the coating of light-sensitive material on a piece of film.



These options allow you to resize and reposition your artwork.
Note

These options do not affect the artwork itself, only the way it is printed.



Applies positioning and sizing to all pages.



Identifies the unit of measurement that is used when you specify the layout of your artwork.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Top value indicates the distance from the top edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the width specified.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the width of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Scales the height of your printed artwork (not the original document) by the specified percentage.



Resizes your printed artwork (not the original document) according to the height specified.



Resizes your printed artwork (not the original document) according to the height specified.



Automatically centers your artwork on the page.



Automatically scales your artwork so that it fits the printable page.
Note

Unless Maintain aspect ratio is enabled, Fit to Page will distort your image.



Constrains resizing and scaling so that the height and width ratio of the artwork is maintained.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Enables a limit for bleeds. The bleed limit determines how far beyond the crop marks a graphic can extend when
printed.
The corresponding value identifies how far beyond the crop marks the bleed can extend.



Allows you to print large artwork on multiple sheets, or tiles, that can later be assembled to form the whole 
picture.



Indicates the level of flatness that will be applied to curves when you print.
Tip

Increasing the flatness reduces printing time and therefore is useful when you need to produce quick 
proofs. Be careful however as a flatness level set too high will produce distorted curves.



Causes Corel to automatically increase the flatness in increments of 2, as needed. Attempts to print an object 
will stop when the flatness value exceeds the value set in the Set Flatness To box by 10. At this point, the printer 
skips the problematic object and goes on to the next object.



Specifies the maximum allowable number of control points per curve. Reducing this number helps alleviate 
printing problems caused by objects that are too complex.



Allows one or more warnings to be issued if objects that are too complex and could cause printing problems are 
detected.



This value reflects the number of steps that will be used to render any fountain fills in your artwork. A low value 
(less than 20) will print faster but the transition between shades may be coarse, which causes what is known as 
banding. A higher value (over 40) will result in a smoother blend but longer printing times. 
Note

Fountain steps that are set in the Options dialog box only affect the way fountain fills display on your 
monitor. To control how the fountain fills actually print, you must set the value for fountain steps here or in the 
Fountain Fill dialog box.



Warns you of potential banding (the appearance of discreet strips in a fill) which is caused by to few steps in a 
fountain fill, when it is enabled.
Note

This warning only applies to linear fountain fills.



Prints a job information sheet with your print job. This report contains information about the application that 
produced the job, the driver that was used, the print settings, the font information, and the file links.



Opens the Job Information Sheet dialog box, which allows you to specify which categories of information you 
want included in the report.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Identifies the basic halftone screen frequency that your job will print at.
Screen frequency is expressed as a number of lines per inch (lpi). This value refers to the number of lines of dots 
(or other shapes) that make up a halftone screen. A halftone screen is a pattern of shapes of various sizes that is
used to simulate a continuous tone image.
Note

Check with your service bureau for the optimum setting for your print job.



Enables the use of PostScript level 2 features.
Note
This option is only available to level 2 PostScript devices. If you are not certain whether you will be printing on a 
level 2 postscript device, DO NOT enable this option.



Enables an analysis of your file and the various print settings you have specified, and, if necessary, automatically
increases the number of steps used to render fountain fills to avoid banding. 
Note

This option may increase print time, but it will ensure the best possible rendering of fountain fills.



Enables an analysis of your file and the various print settings you have specified. If the number of steps in a 
fountain fill is greater than the number that your output device can render, the number of steps used to render 
the fountain fill is decreased automatically. 



Downloads Type 1 fonts to the output device. Generally, this option is enabled because it is particularly beneficial
when you want to print large tracts of text that use only a few fonts. Printing is faster as each font is first 
downloaded, and then only referenced by text that uses it.
If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful if the file 
contains a large number of fonts that would take longer to download, or not download at all, because of sheer 
size.



Converts True Type fonts to Type 1 fonts. If you enabled the Download Type 1 Fonts option, by default the 
Convert True Type to Type 1 is also enabled. This ensures that True Type fonts are converted to Type 1 fonts so 
that they can be downloaded. 
Only disable this option if your output device has difficulty interpreting the Type 1 fonts.



Tells the service bureau's OPI server to substitute the corresponding high-resolution images for the low-resolution
ones in your file. This substitution is done before your print file is rasterized and imaged to film.



Defines bitmaps in RGB values instead of the usual CMYK values that are found in PostScript files.
Tip

Use this option when you are outputting to RGB devices (e.g., slidemakers).
Also use this option when you are printing to CMY devices. It is easier for these devices to translate from 

RGB to CMY than from CMYK to CMY.



Separates color artwork into its component colors, causing each component color to print out on a single sheet.
If you used a process color model (which uses four colors to simulate any color), you'll get up to four sheets per 
page.
If you used spot colors, one sheet per color is printed.



Allows you to print the separations in color (i.e., on a color printer). Separations are usually printed in black, with 
a screen to represent shading. This option allows you to print the separations in color instead.



Converts any spot colors present in your artwork to process colors.
Note

This does not affect the artwork itself, only the way it is printed.



Prints all plates, including those that contain no image.
Note

Printing empty plates wastes film and adds to the cost of your job. Generally, you'll want to leave this 
option disabled.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Allows you to adjust the advanced settings of your color separations, which includes setting halftone screens and
creating color trapping.
Note

Do not adjust these settings without first talking to your service bureau or printing shop.



Opens the Advanced Separations Setting dialog box that allows you to set advanced screening parameters such 
as screening technology, screen frequency and angle per color plate, overprinting per plate, halftone dot type, 
etc.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the imagesetter and screening technology that will be used to image your job.
Proprietary screening technologies supported by Corel include AGFA Balanced screening, Linotronic RT and, HQS 
screening.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the resolution (in dots per inch, or "dpi") the job will be printed at.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the basic screen frequency (in lines per inch, or "lpi") the job will be printed at.
Note

The higher the screen frequency setting, the more intense the colors and the sharper the image. The lower
the screen frequency, the lighter the colors and the less sharp the image. 

A high frequency gives you fewer levels of gray; a low frequency gives you more levels of gray.
The upper limit of your screen frequency is define by the type of printing press to be used and the type of 

paper stock.



Identifies the screen frequency the selected color separation will be printed at. The default values are based on 
the imagesetter, screening technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Shows the screen angle for the selected color separation. Screen angles are used to offset the different films in 
process color separations to avoid moiré patterns. The default values are based on the imagesetter, screening 
technology, and basic screen frequency chosen; it is best not to change these values.
Note

Check with your service bureau before modifying these values.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to select a color to print over any underlying color (instead of the underlying color being knocked 
out), thereby making white gaps impossible. This option is best used when the top color is much darker than the 
underlying color, otherwise an undesirable third color might result (e.g., red over yellow would result in an 
orange object).
When you enable Overprint color both text and graphics are selected by default. If you do not want one of these 
options to overprint, disable it.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Allows you to specify a halftone screen for your drawing if you are printing to a PostScript device. A halftone 
screen is a pattern of shapes that is used to simulate shades of colors (i.e. darker to lighter) while using the 
same ink. Dot, line, diamond, elliptical, and Euclidean are only a few of the available halftone types.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Creates color trapping by assigning an outline to an object that is the same color as the object's fill, and by then 
having the outline overprint underlying objects.
To be able to apply Auto-spreading to an object, it must

not already have an outline
be filled with a uniform fill
not already be designated to overprint

The maximum trap value defines the amount of spread that autotrapping assigns to an object, along with the 
object's color. The lighter the color, the greater the percentage of the maximum trap value. The darker the color,
the smaller the percentage of the maximum trap value.
The value for Text Above determines the minimum font size to which auto-spreading is applied. Applying auto-
spreading to small font sizes can make the text illegible.



Causes any object that contains 95% black or more to overprint underlying objects.
Note

This is a useful option for artwork containing a lot of black text, but it should be used with caution on 
artwork with a high graphics content.



Provides preset page layouts and allows you to store custom styles.



Provides preset page layouts and allows you to store custom styles.



Opens the Edit Layout dialog box.



Specifies the number of working pages to place on a single printable page.



Specifies the number of working pages to place on a single printable page.



Places the current layout in each frame of the printable page.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Allows you to set the amount the images on each tile overlap with the images on adjacent tiles based on a 
percentage of the page width.



Specifies the placement of your artwork on the page. The Left value indicates the distance from the left edge of 
the printable page.



Resizes your printed artwork (not the original document) according to the width specified.



Resizes your printed artwork (not the original document) according to the height specified.



Stores the page positioning settings specified in the Positioning dialog box.



Opens the Positioning dialog box. This dialog box allows you to specify positioning settings that can be save in 
Positioning styles.



Stores the page positioning settings specified in the Positioning dialog box.



Prints only vector graphics unless combined with Print bitmaps or Print text.



Prints only bitmaps unless combined with Print vectors or Print text.



Prints only text unless combined with Print vectors or Print bitmaps.



Prints all text in black.



Prints using the full color capabilities of the selected printing device.



Prints all colors in black.



Prints all colors in grayscale.



Opens the Postscript Preferences dialog box.



Scales everything that will be printed so that it fits within the printable page of the current printer. Use this 
setting to proof a large layout on your desktop printer.
This option is only intended for proofing, and should be disabled for the final output. If you wish to scale your 
artwork to fill the printable page, you should use the fit to page option. Position and size measurements reflect 
the size of the final output, not the size of the proof.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Displays a list of documents that you can print.



Allows you to choose what to print.



Stores a configuration of print settings that can be used again.



Stores a configuration of print settings that can be used again.



Displays a list of the current device's mode settings.



Displays information about the current printing device.



Displays a list of the current device's capabilities.



Displays information about the current printing device.



Specifies which color separation(s) to print.
The list of colors shows all separations used in your artwork. You can choose to print all separations, one 
separation only, or any combination of separations.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Shows all separations used in your artwork. Click each one to change frequency, angle, and to enable 
overprinting.



Displays the present print style, or a name you have typed for a new style.



Provides a list of the present print options and allows you to change them.



Allows you to save this dialog box's settings.



Makes the right margin equal to the left margin, and the bottom margin equal to the top margin.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Automatically sets the gutters.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Displays a model of the printable page based on the positioning settings.



Automatically sets the margins.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Stores the page positioning settings specified in this dialog box.



Saves the present positioning settings.



Deletes the selected positioning style.



Specifies the number of rows of positioning frames to be placed on the printable page.



Specifies the number of columns of positioning frames to be placed on the printable page.



Stores the page positioning settings specified in this dialog box.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position across the printable page.



Specifies the number of working pages to position down the printable page.



Specifies the number of working pages to position down the printable page.



Places the current working page in each frame of the printable page.



Keeps the frame size equal to the working page size.



Displays a model of how the pages will be arranged on the printed sheet.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the other side of a double sided layout.



Allows you to print on both sides of the page.
Note

When you enable this option, and you print to a non-double sided printer, Corel automatically runs a wizard
that ensures all of the pages are ordered and oriented correctly.



Provides preset page layouts and allows you to store custom styles.



Saves the present layout settings.



Deletes the selected layout style.



Selects a page to be placed on the layout sheet.



Selects a page to be placed on the layout sheet.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify whether the top of the selected page points up or down.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Shows the contents of the Print Job Information Sheet.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to specify what information the Print Job Information Sheet will contain.



Sends the Print Job Information Sheet to a .TXT file.



Allows you to specify the .TXT file the Print Job Information Sheet is sent to.



Sends the Print Job Information Sheet to a printer.



Allows you to specify the printer the Print Job Information Sheet is sent to.



Places the current working page in each frame of the printable page.



BOO



Allows you to choose proofing options.



Allows you to choose an option and assign a new setting to it.
Note

The Special Settings options allow you to change settings that were previously edited in the CORELPRN.INI 
file.



Provides information about the current printing device.



Provides information about the current printing device.



Provides information about the current printing device's location.



Provides information about the current printing device.



Provides information about the current printing device, and allows you to change devices.



Allows you to specify the number of copies and whether to collate them.



Allows you to specify color trapping settings.



Allows you to change screening options for the selected color separation.



Provides a list of the present print options and allows you to change them.



Allows you to specify the distance between each layout frame that is placed on the printable page. You can also 
change the units.



Allows you to set the page margins. You can also change the units.



Allows you to specify the distance between each working page that is placed on the printable page. You can also 
change the units.



Sets PostScript font handling.



Sets PostScript bitmap handling.



Allows you to enable PostScript warnings.



Allows you to specify what information the Print Job Information Sheet will contain.



Allows you to choose the output format and destination of the Print Job Information Sheet.



Opens the Print Preview dialog box, where you can view your document before it prints.







When checked, enables you to change the default Artistic Text.



When checked, enables you to change the default Paragraph Text.



Displays the names of the available fonts you can choose from. If necessary, use the scroll bar to the right to 
scroll through the list.



Displays the names of the available fonts you can choose from. If necessary, use the scroll bar to the right to 
scroll through the list.



Converts selected text to subscript or superscript.



Converts selected text to SmallCaps or AllCaps.



Sets the size of the current font (available sizes are 0.72 to 4,000 points).



Sets the size of the current font (available sizes are 0.72 to 4,000 points).



Lists the available units of measure. Choose another if required. 



Lists the type styles available for the chosen font. 



Lists the type styles available for the chosen font. 



Underlines selected text. The options are: Single Thin, Single Thin Word, Single Thick, Single Thick Word, Double 
Thin or Double Thin Word.
If you want to underline each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, Double Thin or Double Thin Word.



Opens the Edit Underline dialog box, where you can change default line thicknesses or baseline shift.



Applies overlines to selected text. The options are: Single Thin, Single Thin Word, Single Thick, Single Thick Word,
Double Thin or Double Thin Word.
If you want to overline each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, Double Thin or Double Thin Word.



Opens the Edit Overline dialog box, where you can change default line thicknesses or baseline shift.



Applies strikeout to (draws a line through) selected text. The options are: Single Thin, Single Thin Word, Single 
Thick, Single Thick Word, Double Thin, and Double Thin Word.
If you want to strike out each word in the selected text but not space between words, choose Single Thin Word, 
Single Thick Word, or Double Thin Word.



Opens the Edit Strikeout Line dialog box, where you can change default line thicknesses or baseline shift.



Adjusts the amount of space, or range kerning, between selected characters.



Displays sample characters in the selected font and text style. The type of font you have selected, for example 
TrueType or PostScript Type 1, is indicated below the Preview area.



Applies Single Thin, Single Thin Word, Single Thick, Single Thick Word, Double Thin, or Double Thin Word 
underlining, overlining, or strikeout formatting.
If you want to apply formatting each word in the selected text but not space between words, choose Single Thin 
Word, Single Thick Word, Double Thin or Double Thin Word.



Provides choice of unit of measure.



You can use the list boxes below to the default text line thicknesses.



You can use the list boxes below to set default baseline shift for the current type of line attribute you are editing.



Sets thickness for Single Thin lines.



Sets thickness for Single Thick lines.



Sets thickness for Double Thin lines.



Sets thickness for Double Thin lines.



Sets the amount of Baseline Shift applied for line effect.



Sets Inter-character, Inter-line    and Inter-word spacing options.



Sets spacing between Artistic Text and Paragraph Text characters as a percentage of the SPACE character in the 
selected font.



Sets spacing between words as a percentage of the SPACE character in the selected font.



Sets spacing between lines of text in points or percentages of character height or point size.



Provides choice of unit of measure.



Moves selected text along the baseline. Increments are measured in percent of point size.



Moves selected text above the baseline. Increments are measured in percent of point size.



Rotates selected text from the baseline. Increments are measured in degrees.



Use the character alignment controls to set text alignment, or justification options Left, Center, Right, Full Justify, 
Force Justifiy or None. Choose None if you want to use the Shape tool to change the position of individual 
characters, adjust kerning or rotate a character without automatically repositioning remaining text.



Sets Paragraph Text spacing between characters as a percentage of the SPACE character in the selected font.



Sets spacing between words as a percentage of the SPACE character in the selected font.



Sets spacing between lines of text in points or percentages of character height or point size.



Sets spacing before paragraphs in percentages of character height; uses the same measurement type set for 
Line spacing.



Sets spacing after paragraphs in percentages of character height; uses the same measurement type set for Line 
spacing.



Provides choices for the unit of measure for spacing before and after paragraphs. Choose % of Char. height, 
points, or % of Pt. size.



Turns off Alignment, enabling you to use the Shape tool to change the position of individual characters, adjust 
kerning or rotate a character without automatically repositioning remaining text.



Aligns text to both the left and right margins of the Paragraph Text frame.



Stretches the last line of a paragraph to the right frame margin.



Aligns text to the left margin, resulting in a "ragged" or uneven right margin.



Aligns text to the center of the Paragraph Text frame.



Aligns text to the right margin, resulting in a ragged left margin.



If you choose Full Justify or Force Justify you can edit the settings for Maximum Word Spacing (0-999 %).



If you choose Full Justify or Force Justify you can edit the settings for Minimum Word Spacing (0-999 %).



If you choose Full Justify or Force Justify you can edit the default settings for how far apart you can set characters
the Maximum Character Spacing (0-999 %).



Enables the International Hyphenator. You can choose between various language databases for hyphenation in 
the International Proofreader's Advanced Options dialog box.



Enables hyphenation of capitalized words if required.



Sets how far the end of a line must be from the right margin before hyphenation of the first word of the next line 
occurs. 
A smaller hot zone results in more hyphens and better word spacing along the margin. 



Choose alternate units of measure from the list as required.



Sets the minimum length of words to be included for automatic hyphenation.



Sets the minimum number of characters (including spaces) that must appear in the Hot Zone before a hyphen.



Sets the minimum number of characters (including spaces) that must appear in the Hot Zone after a hyphen.



Displays the current tab settings and unit of measure selected. Drag tabs along the ruler if you want to move 
them. If you prefer another unit of measure, choose one from the Units list box.



Displays the current tab settings and unit of measure selected. Drag tabs along the ruler if you want to move 
them. If you prefer another unit of measure, choose one from the Units list box.



Displays the current tab settings and unit of measure selected. Drag tabs along the ruler if you want to move 
them. If you prefer another unit of measure, choose one from the Units list box.



Change the number if you want to change the distance between evenly spaced tabs along the ruler.



Inserts tab stops at evenly spaced intervals as specified in the number box at right. 



Lists available units of measure. Choose another from the list box if required.



Click a tab to select it or type in a tab stop above.



Click to place a new tab on the ruler at the tab stop location selected in the tabs list. The new tab assumes 
current alignment options.



Clears a tab stop selected from the list or ruler.



Clears all tab stops.



Sets leadered tab stops.



Sets the character used for leadered tab stops.



Sets the spacing for leadered tab stops. You can also enter a value from 0 (tight) to 10 (loose) to set leader 
spacing numerically.



Enables you to choose leader characters for leadered tab stops by their symbol numbers.



Drag the slider left or right to make leader tab spacing tighter or looser. 
You can also enter a value from 0 (tight) to 10 (loose) to set leader spacing numerically.



Sets leadered tab stops close together.



Spreads leadered tab stops apart.



Text flows from the tab stop to the right



Centers text at the tab stop.



Text flows from the tab stop to the left.



Aligns decimal points in the text to the tab stop. Text without decimal points extends to the left of the tab stop.



Use the Indents group box to set Paragraph Text indents.



Displays the current indent settings and unit of measure selected. You can drag the markers along the ruler to 
change indents as required or use the Indents area below to make precise changes. If you prefer another unit of 
measure, choose one from the Units list box.



Sets the distance the first line of a paragraph is set from the left side of the text frame. 
Drag the top marker along the ruler if you want to change your first-line indent visually.



Sets the distance of lines coming after the first line from the left side of the text frame. 
Drag the bottom marker along the ruler if you want to change your indent visually.



Sets the distance of lines coming from the right side of the text frame. Drag the right-side bottom marker along 
the ruler if you want to change your right margin indents visually.



Choose another unit of measure from the list box if required.



Disables bullet effects.



Enables bullet effects. You can choose from all of the symbol sets included with your software.



Sets the size of the current bullet, from 0 to 360 points. 



List units of measure for bullet indents.



Sets how far the bullet is set from the left margin of the text frame. 



Sets the distance of the bullet from the baseline. 



Lists all of the available bullet categories (symbol sets). Choose a bullet type from the preview area.



Displays all of the bullet symbols available in the selected symbol set.



Applies bullets using the bullet index numbers listed in the Symbol and Clipart Catalog supplied with your 
software.



Enter a number to divide the selected text frame into columns The maximum number of columns for one frame 
is eight. If you want to add more columns you can drag out more text frames. 
The preview area at right displays how your changes will look as you make them.



Displays the number of the column currently shown in the Width and Gutter boxes at right. 
You can scroll through the Column number list to show other columns when you want to edit column and gutter 
widths. Column width editing is disabled if the Equal column width option is selected.



Displays a preview of your changes as you make them.



Sets the size of the column. Width also controls the overall frame width if you choose Automatically adjust frame 
width. Column width is adjustable from 0.25 to 1,000.00 inches.
The preview area at right displays how your changes will look as you make them.



Sets the spacing between columns. The maximum spacing is 200.00 inches.
The preview area at right displays how your changes will look as you make them.



Specifies the unit of measurement. If you prefer another unit of measure, choose one from the Units list box.



Sets the same column and gutter widths for all columns. Disable this option to set individual column and gutter 
widths.



Ensures frame width remains unchanged and adjusts column and gutter widths automatically, preventing 
settings that exceed the frame or page size.
The preview area at right displays how your changes will look as you make them.



Adjusts frame, column, and gutter widths automatically.
The preview area at right displays how your changes will look as you make them.



Displays Help about the current dialog box.



Enables on-screen text editing. When disabled, the Edit Text dialog box opens whenever you select a text object 
with a text tool or click in the drawing window or pasteboard area with a text tool. 



Enables display of a font for drop-down list boxes. Disable this command if you want to turn the sample off.



Sets the minimum number of characters permitted in lines of Paragraph Text shaped to fit into odd-shaped 
envelopes. When set to the default value of three, lines must have at least three characters to appear.



Simplifies the appearance of text below a certain size to increase screen redraw speed. This option does not 
affect the appearance of printed text. You can make greeked text readable again by choosing a higher Greeking 
level or using Zoom.



Sets the threshold determining when CorelDRAW shows the outlines of characters kerned using the mouse. If the
number of characters selected is less than or equal to the value specified here, CorelDRAW displays their 
outlines as they are being kerned. The default is 25 characters.



Specifies whether calligraphic pen outlines are transferred to the Clipboard or exported using any of the vector 
graphics export filters. If your file contains many calligraphic outlines, excluding them during cut and paste 
operations reduces the size of the exported file and time required to transfer the file through the Clipboard. 
Some export filters retain calligraphic outlines regardless of the setting chosen.



Specifies whether text cut or copied to the Clipboard should be pasted as text or curves. When enabled, text is 
pasted as text; when disabled, text is pasted as curve objects. When text is pasted as text, font, point size and 
other text attributes are copied along with the text string.



Enables PANOSE font matching. Font matching occurs when (a) you open a Corel file from another user or 
computer system, or (b) import text or graphics files that supports text and your current system does not have 
the same fonts.



Applies the same text formatting to all connected Paragraph Text frames.



Applies the same text formatting only to selected Paragraph Text frames.



Applies the same text formatting only to selected and succeeding linked Paragraph Text frames.



Toggles display of non-printing characters you want to appear in your document while in text editing mode. 
To display, the Text menu's Show non-printing characters command must be enabled.



Determines the orientation of the letters on the path.
Rotate 
Letters

rotates individual characters to follow the contours of the 
path.

 Vertical 
Skew

vertically skews each character, creating the impression that 
the text is standing upright on the path. The amount of 
skewing varies with the slope of the path.

Horizontal 
Skew

similar to Vertical Skew, but with an added effect that makes 
letters appear to turn into the screen as they wrap around 
the path. The amount of skewing varies with the slope of the 
path.

Center Base centers the base of each letter on the path.
Determines the vertical placement of text with respect to the path.

Baseline aligns the text baseline with the path.
Top aligns the text ascender line with the path.
Bottom aligns the descender line of the text with the path.
Center Centers the text on the path.

    Variable allows you to move the text off the path by dragging with the
mouse. 

Flips the text to the opposite side of the path and reverses the path's start and end nodes.



Displays a dialog box you can use to specify text placement on the path.



Specifies how far along the path you want to position the text.



Specifies how far above or below the path you want to position the text.



Describes what text objects in the document have been counted. If objects are selected, they are listed. 
If no objects are selected, all text in the document is counted, including tab and space characters.



Lists all text object types counted and displays totals for each.



Enables you to choose between checking the current text object or the full document if necessary.



Highlights unrecognized words. Click the word and make your changes as you would in the document window.



Describes errors when found. The type of rule shown depends on the proofreading level you choose.



Opens a dialog box you can use to add words to your personal dictionary.



Displays a menu you can use to undo changes you make to errors highlighted in the Sentence box, explain 
errors, set advanced options or formality levels, open the Rule Manager, or create or apply personal dictionaries.



Lists all alternative spelling words found in the International Proofreader's databases.



Moves the International Proofreader to the next sentence.



Leaves the current word unchanged and continues checking. 



Ignores all subsequent words or phrases during the current proofreading session.



Replaces the currently flagged error with the word or phrase in the Change To box. 



Replaces all instances of the currently flagged error and continues the proofreading session.



Stops the checking session and closes the International Proofreader.



Gives a detailed explanation of the grammatical conventions used by the International Proofreader to identify the
current error.



Lists all installed International Proofreader checking languages.



Lists all available International Proofreader Rule languages.



Lists all available International Proofreader Error languages.



Causes the International Proofreader to search the current language database for alternative spellings when an 
error is encountered.



Enables the creation of personal dictionaries.



Enables you to turn off your personal dictionary or the International Proofreader's dictionary.



Opens the New Personal Dictionary dialog box, where you can save Advanced Option settings in a file for reuse.



You can set the maximum number of sentence elements for each language that you initialize. Sentence 
elements are words or punctuation that International Proofreader treats as units. The default setting for each 
language should be acceptable for most text; you should not change the default unless you need to reduce the 
memory overhead required by the buffer-processing function.



Opens the Rule Manager, where you can customize the International Proofreader's rules.



Opens a dialog box where you can enter a name for a new user profile, a file containing personal rule settings.



Lists all personal user profiles created.



Enables you to choose between Spelling, Quick Proofreading, and Full Proofreading modes for your user profile 
changes.



Enables you to choose between Formal, Standard, and Informal modes for your user profile changes.



Restores the default settings for the Check Mode selected.



Describes the error type highlighted in the Rules Types box.



The following topic was rolled into one because there is only one ID for the two dialog boxes. A new id should be 
provided for Rev. B



Displays the currently selected word. You can also type in any word you want to look up. Click the down arrow to 
display previously looked up words.



Displays a list of found definitions of the word shown in the Looked up box.



Displays all of the text in the definition of the word in the Looked up box.



Displays the first synonym for the word you looked up.



Lists all synonyms for the word you looked up. Double-click any word in the list to look up its definition.



Click to look up a word.



Click to replace the word you looked up with the word in the Replace with box.



Click to see the previous word.



Capitalizes the first letter following a sentence end. A sentence end is defined by a period (.), an exclamation 
mark (!), or a question mark (?). In Spanish, the marks ¿ and ¡ are also supported.



Changes the standard quotation marks (") included in most font sets to curly, typographical quotes typically 
used in newspapers and books.



Changes the second capital to lowercase if by mistake you hold down the SHIFT key too long and start a word 
with two capitals. No change is made if the capitals are followed by a space or period or the word contains other 
capital letters.



Automatically capitalizes the names of days.



Enables the Replacement Text option, shown below. Text replacement occurs when you press the Spacebar or 
press ENTER.



Type the code you want Type Assist to use to replace longer text strings automatically .



Type the full word, phrase or text string you want to replace the abbreviation.



Click to add Replacement text to the list.



Deletes replacement options, including the defaults provided in Type Assist if you choose.



Lists the preset strings included with your software and any new ones you've created.



Finds and selects each occurrence of the specified text. You can type as many as 100 characters. The text scrolls 
horizontally as you type.



Select this option if you want to find only text that matches the combination of upper and lowercase letters you 
type in the Find What box. 



Closes the dialog box.



Type the text you want to find. You can type as many as 100 characters. The text scrolls horizontally as you type.



Type the replacement text. You can type as many as 100 characters. The text scrolls horizontally as you type.
If you want to delete the text in the Find What box from the document, leave the Replace With box empty.



Finds and selects each occurrence of the specified text.



Choose this button if you want to confirm the replacement of each occurrence of the text you are searching for. 
For long documents, it is recommended that you use Replace for a few occurrences of the text you want to 
replace. When you are sure that no similar text strings you do not want to include will be replaced, you can click 
Replace All.



Choose this button if you want to replace all instances of the text you are searching for.
You can press ESC to cancel replacing. To reverse changes made before you pressed ESC, choose the Undo 
command from the Edit menu.
For long documents, it is recommended that you use Replace for a few occurrences of the text you want to 
replace. When you are sure that no similar text strings you do not want to include will be replaced, you can click 
Replace All.



Select this option to find only text that matches the combination of upper and lowercase letters you type in the 
Find What box.



Capitalizes the first word of each sentence.



Changes all capitals in the selection to lower case.



Changes all capitals in the selection to UPPER case.



Capitalizes the first letter of all words in the selection.



Toggles the case of all letters in the selection.



Opens the Character Attributes dialog box, where you can apply special font and alignment effects to Artistic 
Text or Paragraph Text.



Opens the Paragraph dialog box, which controls Paragraph Text spacing, tabs, indents, and bullet effects.



Provides an editing window you can use to enter text without waiting for screen redraws.



 Scrolls the text window up and down.



Applies boldface text style. If no text is selected, boldfacing begins at the insertion point.



Applies boldface text style. If no text is selected, boldfacing begins at the insertion point.



 Applies italic text style to selected text. If no text is selected, italics begin at the insertion point.



Applies italic text style to selected text. If no text is selected, italics begin at the insertion point.



Applies underline text style to selected text. If no text is selected, underlining begins at the insertion point.



Applies underline text style to selected text. If no text is selected, underlining begins at the insertion point.



Aligns lines of text down an imaginary center line down the middle of the current page or frame.



Aligns lines of text down an imaginary center line down the middle of the current page or frame.



Stretches the last line of a paragraph to the right margin.



Stretches the last line of a paragraph to the right margin.



Automatically adjusts inter-word spacing to align text to both right and left margins



Automatically adjusts inter-word spacing to align text to both right and left margins



Aligns text to the left text frame margin, removing any shift effects you may have applied.



Aligns text to the left text frame margin, removing any shift effects you may have applied.



Like left justification, No justification causes text to align along a straight left margin, with "ragged right" 
margins. With this option, however, shifted or kerned characters are unaffected.



Like left justification, No justification causes text to align along a straight left margin, with "ragged right" 
margins. With this option, however, shifted or kerned characters are unaffected.



Causes text to align along a straight right margin, with uneven left margins.



Causes text to align along a straight right margin, with uneven left margins.



Applies bullets to the selected text.





Locks current changes.



Makes your changes without closing the dialog box.



Opens the Columns dialog box.



Provides options for which frames your changes apply to.





Enables you to enter Artistic Text directly on the screen.



Enables you to enter Paragraph Text directly on the screen.



Changes the selected text to capital letters.



Changes the style of the selected text to superscript.



Changes the style of the selected text to subscript.



Sets/resets the bullet for the text object.



Changes the line spacing of the text to 1.



Changes the line spacing of the text to 1.5.



Changes the line spacing of the text to 2.



Increases the text indent.



Decrease the text indent.



The current font size of your text. Enter a new font size, or use the arrows to scroll through available sizes.







Toggles guideline visibility. When Show Guidelines is disabled, guidelines will not appear on the screen.



Toggles the guideline snap on and off. When Snap To Guidelines is enabled, objects dragged close to a guideline 
will fall into alignment with it.



Removes all existing horizontal, vertical, and slanted guidelines.



Click here to display an overview of this dialog box.
For Help on an item, click the question mark at the top of the dialog box, and then click the item.



IDH_GUIDELINES_SETUP_GUIDE_ADD (0x5400003A)



IDH_GUIDELINES_SETUP_GUIDE_DELETE (0x5400003B)



IDH_GUIDELINES_SETUP_GUIDE_DELETE_ALL (0x5400003C)



IDH_GUIDELINES_SETUP_GUIDE_HORZ (0x5400003D)



IDH_GUIDELINES_SETUP_GUIDE_MOVE (0x5400003E)



IDH_GUIDELINES_SETUP_GUIDE_POS (0x5400003F)



IDH_GUIDELINES_SETUP_GUIDE_SHOW_GUIDELINES (0x54000040)



IDH_GUIDELINES_SETUP_GUIDE_SNAP_GUIDELINES (0x54000041)



IDH_GUIDELINES_SETUP_GUIDE_UNITS (0x54000042)



IDH_GUIDELINES_SETUP_GUIDE_VERT (0x54000043)



IDH_CDRUI_THREADLIST_CDRUI_ABORTPROCESS (0x5400001A)



IDH_CDRUI_THREADLIST_CDRUI_HIGHERPRIORITY (0x5400001B)



IDH_CDRUI_THREADLIST_CDRUI_LOWERPRIORITY (0x5400001C)



IDH_CDRUI_THREADLIST_CDRUI_SUSPENDPROCESS (0x5400001D)



IDH_CDRUI_THREADLIST_CDRUI_THREADHELP (0x5400001E)



IDH_CDRUI_THREADLIST_CDRUI_THREADTITLE (0x5400001F)



IDH_ROLLUPPAGE_LEFTMOVEDOWN (0x54000064)



IDH_ROLLUPPAGE_LEFTMOVEUP (0x54000065)



IDH_ROLLUPPAGE_RIGHTMOVEDOWN (0x5400006E)



IDH_ROLLUPPAGE_RIGHTMOVEUP (0x5400006F)



IDH_CDRUI_TOOLPAGE_CDRUI_TB_NOITEMS



IDH_SETUP_GRID_CDRUI_SNAPTOFRAMES



IDH_SETUP_GRID_CDRUI_SNAPTOMARGINS



IDH_SETUP_GRID_SHOWMARGINS2



IDH_SETUP_GRID_SNAPTOFRAMES2



The units in which the current value is expressed.



The minimum increment. This is the amount by which the value will increase or decrease when you click one of 
the spin box arrows.



The units in which the increment value is expressed.



The highest value you can use.



The units in which the maximum value is expressed.



The lowest value you can use.



The units in which the minimum value is expressed.



Displays the roll-ups and roll-up groups that arrange to the left side of the screen.



Displays the roll-ups and roll-up groups that arrange to the right side of the screen.



Moves the current roll-up or roll-up group from the right list to the left list.



Moves the current roll-up or roll-up group from the left list to the right list.



Adds a new, empty roll-up group to the left list.



Adds a new, empty roll-up group to the right list.



The roll-up configuration that will appear on start up.



Resets the roll-up arrangements to their original configuration.



Removes the current roll-up group from the left list.



Moves the current group down.



Moves the current group up.



Removes the current roll-up group from the right list.



Moves the current group down.



Moves the current group up.



Opens the Customize dialog box, where you can change the configuration of your toolbar buttons.



Deletes a custom toolbar, or resets a built-in toolbar.



Displays the available toolbars. Enable the checkbox next to a toolbar to activate it. Click the toolbar's name tag 
to rename it.



Creates a new toolbar. Click Customize to add buttons to the new toolbar.



Enables large toolbar buttons.



Enables medium toolbar buttons.



Enables small toolbar buttons.



Displays the available commands. Double-click a command category to open it.



Displays the available commands. Double-click a command category to open it.



Gives a short description of    the selected command.



Resets the keyboard assignments to their original configuration.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Shows the new keyboard combination that you want to assign to the command. If you need to make a correction,
press the Backspace key.
You can have up to four layers of keystrokes. For example, the key combination CTRL+ALT+1,2,3,4 is 
accomplished by holding down the CTRL and ALT keys, then pressing the 1,2,3, and 4 keys in succession.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Displays any commands assigned to the keyboard combination you typed. You cannot have the same 
combination for more than one command.



Automatically resolves conflicts by erasing the old keyboard assignment, and prompting you to assign a new 
combination to the old command.



Displays any existing shortcut keys for the current command.



Displays any existing shortcut keys for the current command.



The name of the current keyboard assignment set.



The name of the current keyboard assignment set.



Assigns the new keyboard combination to the current command.



Deletes the selected shortcut keys.



Loads a new keyboard assignment table.



Saves the current keyboard assignment table.



Gives a short description of    the selected command



Displays the available commands. Double-click a command category to open it.



Adds the selected command to the menu.



Removes the selected command from the menu.



Adds a separating line to a menu below the current selection.



Adds a new menu.



Moves the current menu or menu entry up.



Moves the current menu or menu entry down.



Displays the current menu structure. Double-click a menu or sub-menu to open it.



Resets the menu assignments to their original configuration.



Gives a short description of    the selected command



Gives a short description of any toolbar button you click.



Displays the available command categories. Click a category to display its command buttons.



Displays the command buttons for the current command category. Click a button to see its description, or drag it 
to add it to any toolbar on the screen.



A command button. Click it to see its description, or drag it to add it to any toolbar on the screen.



Resets the toolbar assignments to their original configuration.



You can also open the color palette menu by right-clicking the palette border.



These controls let you change the appearance of the on-screen color palette.



The colors in the current palette. Right-click the palette border to open the Color Palette menu.



Shows and hides the color swatch borders.



Toggles between large and small color swatches.



Shows and hides the No Color swatch.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



Specifies the number of rows of colors to be displayed while the color palette is docked.



These controls let you change the effect of right-clicking the color palette.



Changes the effect of right-clicking a color swatch on the palette.



Changes the effect of right-clicking a color swatch on the palette.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of horizontal grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the number of vertical grid lines per unit of measure.
To space the grid lines more than one whole unit of measure apart, enter fractional values from the keyboard. 
For example, to space the grid lines two inches apart, enter 0.5. The maximum number of grid lines is 200 per 
inch, 33.3 per pica, 1.01 per point, 7.87 per millimeter, 1.01 per didot, and 35.52 per cicero.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the horizontal position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the horizontal ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



Determines the vertical position of the zero point for the rulers relative to the lower left corner of the working 
page. Useful as a reference point when sizing and placing objects. You can also use the ruler crosshairs to set the
Grid Origin.



You can choose another unit of measure for the vertical ruler from the units box. When you change units, you 
must specify the Grid Frequency you want to use with that unit.



Displays markers showing where the grid lines are.
The frequency of the grid marks is determined by the current view. When you use the Zoom tool to magnify the 
view, the frequency of the grid marks increases.



Forces objects drawn or moved close to a grid line into alignment with the grid. You can also toggle Snap To Grid 
using the Snap To Grid command in the Layout menu.



Opens the Drawing Scale dialog box where you can set a scale to your drawing other than one to one.



Represents the distance in your drawing that is equivalent to the World Distance value.



Displays the current Page Distance units. Click in this field to display a list of available units. The Page Distance 
value is automatically converted when you change units.



Displays the current World Distance units. Click in this field to display a list of available units. The World Distance
value is automatically converted when you change units.



Selects one of several pre-defined drawing scales. The Page Distance and World Distance values are updated to 
reflect your choice.



Represents the real distance, in inches, that is equivalent to the Page Distance in your drawing. 



Creates a slanted guideline at the position and angle you have specified.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The guideline definition method. You can define a slanted guideline using two points, or a single point and an 
angle. A guideline defined by the points (1,1) and (5,5) would follow the same path as a guideline starting at 
(1,1) with a 45-degree angle.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's origin point.



The horizontal position of the guideline's first origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's origin point.



The vertical position of the guideline's first origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle, or the horizontal position of the second origin point.



The guideline's angle.



The horizontal position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The vertical position of the guideline's second origin point.



The current guideline definition.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing slanted guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal, vertical, and slanted guidelines.



Moves the current guideline to the position and angle you have specified.



Creates a vertical guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing vertical guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing vertical guidelines.



Moves the current guideline to the position you have specified.



Creates a horizontal guideline at the position you have specified.



The guideline position. Click Add to make a new guideline at this point, or Move to change the selected 
guideline's position.



Displays the current guideline units. Click to display a list of available units. The guideline position value is 
automatically converted when you change units.
Changing the guideline units has no effect on the Ruler units. To change the ruler display units, use the Grid & 
Ruler Setup command in the Layout menu.



Displays a list of existing horizontal guidelines. Click a guideline to edit it.



Removes the selected guideline.



Removes all existing horizontal guidelines.



Moves the current guideline to the position you have specified.



Changes the current value.



Displays the roll-ups in this group. Click a roll-up to activate it, or drag it to another part of the screen to split it 
from the group.





Opens the System Info dialog box where you can get information about your system, display,    printing, Corel 
EXEs & DLLs and system DLLs.



Displays the disk space available on the drive where the program is installed. 



Displays the name of the registered user and the serial number.



Displays copyright information.



Displays the version of the product currently installed. 



 Displays the name of the product.



 Double-click to open the credits window. To exit the credits and return to your program, click the ESC button.



Provides a list of system information categories. Click one of the following:

System Displays information about your computer For example, Windows version or 
processor.

Display Displays information about your monitor. For example, driver,or driver version.
Printing Displays information about installed printers.
Corel EXEs 
and DLLs

Displays information all of the Corel EXEs and DLLs.

System 
DLLs:

Displays all of the system DLLs.

Displays the system information for the chosen category.



Saves all system information as SYSINFO.TXT. Once it's saved, a message box appears informing you of the 
location of the saved file.



Double-click to open the credits window. To exit the credits and return to your program, click the ESC button.



Displays information about the contents of the file.



Determines the number of pixels per unit of measure for the horizontal ruler.



Determines the number of pixels per unit of measure for the vertical ruler.



Displays text just as you entered it. Numbers display without leading or trailing zeroes, and with no thousands 
separators.
You can use the & placeholder symbol to add a common string to another string. For example, the format string 
"Hello," & ",you may have already won $5,000,000.00" would format the string "John Doe" as: Hello, John Doe, 
you may have already won $5,000,000.00.
Note the use of the quotation marks around the strings before and after the &. You must include these when 
creating your own General format.



Creates date/time formats.
The default date and time formats are based upon the current International settings which you can modify using 
the Windows Control Panel.



Creates numeric formats to display non-linear values, including currency.



Creates Linear formats to display measurements in the Imperial or Metric system, or in picas and points. Each 
format can have one or two entries with the first used for the major (or larger unit) and the second the minor (or 
smaller unit). If the first unit contains digits after the decimal, or a fraction, then you cannot enter a minor unit.
When entering values for formats with major and minor units, enter them in the minor units. A format with miles 
as the major and feet as the minor unit, for example, would be entered in feet.



Provides a space for you to edit the built-in format or type a new format.



Removes the selected format.



Lists available formats.





No help topic is available for this item.



Enable this check box to have Corel Print Space automatically scroll the drawing window when you drag outside 
its borders.



Enable this check box to have Corel Print Space notify you each time you adjust the performance of a drawing or 
editing tool.



Enable this check box to have Corel Print Space automatically open your last working directory when you open or
save your work.



Enable this check box to set Corel Print Space's default folder as the default folder for saving new layouts.



Lets you set the number of consecutive operations that can be reversed using the Undo command. As the 
number of levels increases, so does the memory Corel Print Space requires to operate.



Lets you set the action that is to occur each time you start Corel Print Space. Click inside the box to display a list 
of start-up options, then click the option you want.



Enable this check box to have Corel Print Space display a pop-up identification label when you position the 
mouse pointer over any toolbar or toolbox button.



Enable this check box to have Corel Print Space display a pop-up identification label when you position the 
mouse pointer over any object in any Smart Library.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.









No help topic is available for this item.



When enabled, aligns the selected objects' left edges vertically.



When enabled, aligns the selected objects' center points horizontally.



When enabled, aligns the selected objects' right edges vertically.



When enabled, aligns the selected objects' top edges horizontally.



When enabled, aligns the selected objects' center points vertically.



When enabled, aligns the selected objects' bottom edges horizontally.



When enabled, aligns the selected objects with the grid.



No help topic is available for this item.



Displays the effects of your current alignment settings.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.









No help topic is available for this item.



Lets you set the horizontal distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Lets you set the horizontal distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Lets you set the horizontal distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Lets you set the vertical distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Lets you set the vertical distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Lets you set the vertical distance the duplicate is offset from the original object when you copy it using the 
Duplicate command.



Controls how far a selected object moves when you press the direction keys on the numeric keypad. You can set 
an increment of up to 2 inches or an equivalent amount in another unit of measurement.



Controls how far a selected object moves when you press the direction keys on the numeric keypad. You can set 
an increment of up to 2 inches or an equivalent amount in another unit of measurement.



Controls how far a selected object moves when you press the direction keys on the numeric keypad. You can set 
an increment of up to 2 inches or an equivalent amount in another unit of measurement.



Controls the angle of motion when you rotate an object or draw a line while holding down the constraint key 
(CTRL by default).



Controls the angle of motion when you rotate an object or draw a line while holding down the constraint key 
(CTRL by default).



Controls the angle of motion when you rotate an object or draw a line while holding down the constraint key 
(CTRL by default).



Click this to have Corel Print Space display objects as bounding boxes while you edit them using the mouse.



Click this to have Corel Print Space display objects as outlines while you edit them using the mouse.



Click this button to have Corel Print Space display objects with all fill and outline attributes while you edit them 
using the mouse.



These controls let you change the key used to constrain object rotations.



When selected, lets you hold down SHIFT to constrain the rotation of an object that you're rotating using the 
mouse. The rotation is constrained to the angle set using the Rotation Constraint number box above.



When selected, lets you hold down CTRL to constrain the rotation of an object that you're rotating using the 
mouse. The rotation is constrained to the angle set using the Rotation Constraint number box above.











No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Displays the names and basic attributes of all layers in the current layout. The grid and guides layers contain the
grid and guidelines and can't be removed or renamed. Layer 1 is the default name assigned to the initial drawing
layer for each new layout.



Opens a color palette that you can use to select a color to identify the highlighted layer. If you enable the Color 
Override check box, Corel Print Space displays the layer using outlines of this color.



Toggles display of the bottom part of the Roll-Up to save screen space.



When enabled, displays the objects on the highlighted layer using outlines of the color displayed on Layer Color 
picker. Enabling color override allows for easy identification of objects on different layers and has no effect on 
printed page.



Displays or hides all objects on highlighted layer.



Enables or disables printing of objects on the highlighted layer. Printing selected layers lets you proof parts of 
your drawing more quickly.



Allows or prevents selection and editing of objects on highlighted layer.



No help topic is available for this item.



Adds a new layer to the bottom of the layers list. Drag the layer name to place it in the desired position.



Removes the highlighted layer and all the objects it contains.



Copies the selected object to the highlighted layer.



Moves the selected object to the highlighted layer.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



Enable this button if you want to create a Hyperlink to a new Corel Print Space diagram.



Enable this button to create a Hyperlink to an existing Corel Print Space diagram. You can select the diagram by 
clicking its file name in the Contents of list or by clicking the Browse button.



Enable this button to create a Hyperlink to another program or to a file created using another program. You can 
select the program or file by clicking its file name in the Contents of list or by clicking the Browse button.



Displays the names of files in the current directory. Click the name of the file to which you want to create a 
Hyperlink. If the file you want doesn't appear in this list, click Browse.



Displays the names of files in the current directory. Click the name of the file to which you want to create a 
Hyperlink. If the file you want doesn't appear in this list, click Browse.



Displays the Opens Hyperlink dialog box, which lets you browse drives and folders to find the file to which you 
want to create a Hyperlink.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Lists the styles available for the font displayed above. Click the downward arrow to see the list.



Lets you set the size of the selected font. Use the list box to the right to set the unit of measurement.



Enable this button to add field text to the selected shape or text frame, then select the information you want 
from the list box below.



Enable this button if you want to type text in the selected shape or text frame. This button is enabled by default.



Click this button to prevent changes to the selected text entry.



Lists the styles available for the font displayed above. Click the downward arrow to see the list.



Lists the available units of font measurement. Click the downward arrow to see the list.



Opens the Character Attributes dialog box, which provides controls for specifying more complex font and 
alignment options.



Opens the Paragraph dialog box, which provides controls for setting paragraph attributes like spacing, tabs, 
indents, and effects.



No help topic is available for this item.



Opens a color palette that you can use to change the color of selected text.



When enabled, selecting text inside a symbol also selects the symbol.



Enable this check box if you want Corel Print Space to scale the selected text when you scale the object that 
contains it. This check box is only available when the selected text is contained within a symbol.



No help topic is available for this item.



No help topic is available for this item.



Click this button to apply no fill to (or remove the fill from) the selected object.



Click this button if you want to apply a uniform fill to the selected object.



Click this button if you want to apply a pattern fill to the selected object.



Click this button if you want to apply a fountain fill to the selected object. You can apply linear, conical, radial, or 
square fountain fills.



Use this palette to choose a color for the uniform fill.



Use this palette to choose a color for the uniform fill.



Click this button if you want to apply a linear fountain fill to the selected object.



Click this button if you want to apply a radial fountain fill to the selected object.



Click this button if you want to apply a conical fountain fill to the selected object.



Click this button if you want to apply a square fountain fill to the selected object.



Opens a palette that you can use to select the start color in the fountain fill.



Opens a palette that you can use to select the end color in the fountain fill.



Opens the Fountain Fill dialog box, which contains controls that let you edit and customize the linear fountain fill.



Opens a palette that you can use to choose the foreground color of the selected pattern fill.



Opens a palette that you can use to choose the background color of the selected pattern fill.



Opens a catalog of fill patterns. Click the pattern you want to use to fill the selected object.



These controls let you set the height and width of each of the pattern tiles used to fill the selected object.



Lets you set the width of each of the pattern tiles used to fill the selected object. Specify lower values to increase
the horizontal density of the pattern.



Lets you set the width of each of the pattern tiles used to fill the selected object. Specify lower values to increase
the horizontal density of the pattern.



Lets you set the width of each of the pattern tiles used to fill the selected object. Specify lower values to increase
the horizontal density of the pattern.



Lets you set the height of each of the pattern tiles used to fill the selected object. Specify lower values to 
increase the vertical density of the pattern.



Lets you set the height of each of the pattern tiles used to fill the selected object. Specify lower values to 
increase the vertical density of the pattern.



Lets you set the height of each of the pattern tiles used to fill the selected object. Specify lower values to 
increase the vertical density of the pattern.



Displays the effect the current settings would have on the selected object.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



The current backup directory. To change it, click the Select Directory button below.



Lets you specify the directory where you want Corel Print Space to store backup copies of your work. The current 
directory is displayed above this button.



Enable this check box to create a backup file each time you save a Corel Print Space file. You can specify the 
backup directory by clicking the Select Directory button.



Lets you have Corel Print Space automatically create a backup file at set intervals while you work. When you 
enable this check box, the number box beside it becomes available. Use this box to specify the time between 
backups. You can specify the backup directory by clicking the Select Directory button.



Lets you specify the time between backups if you have enabled the Auto-Backup check box. You can specify any 
value from 1 and 120 minutes.



Controls the AutoJoin radius for lines drawn using the Line, Curve, Freehand, and Autorouted Line tools. If you set
a low number, the cursor must be drawn or dragged closer to the end node of an existing line segment before it 
joins automatically.



Controls the display properties and redrawing speed of complex objects. Set low values to simplify the display of 
complex objects and increase on-screen redrawing speed. The value you set affects only the on-screen display, 
not the quality of the printed layout.



Controls the display properties and redrawing speed of complex objects. Set low values to simplify the display of 
complex objects and increase on-screen redrawing speed. The value you set affects only the on-screen display, 
not the quality of the printed layout.



Enable this check box to preserve copies of the selected objects when you weld, trim, or intersect.



Enable this check box to preserve copies of the selected objects when you weld, trim, or intersect.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



Lets you set the number of shadows you want to apply to the object. The shadows are positioned according to 
the Direction and Offset controls.



Lets you specify the shadow's offset. Shadows are positioned according to the Direction and Number controls.



Opens a color palette that you can use to select the color of the shadow's outline.



These controls let you change the direction of your object’s shadow.



These controls let you change the appearance of your shadow. Enable the Use shadow check box to activate the 
Shadow Fill controls.



When enabled, applies a shadow with the settings specified using the Fill, Direction, Number, Offset, and Outline 
controls.



Applies a shadow that above and to the left of the object. The offset depends on the value set using the Offset 
number box.



Applies a shadow below and to the left of the object. The offset depends on the value set using the Offset 
number box.



Applies a shadow above and to the right of the object. The offset depends on the value set using the Offset 
number box.



Applies a shadow below and to the right of the object. The offset depends on the value set using the Offset 
number box.



Click this button if you want to remove the current shadow from the object.



Click this button if you want to apply a uniform fill to the shadow.



Click this button if you want to apply a fountain fill to the shadow. You can apply a linear, conical, radial, or 
square fountain fill.



Click this button if you want to apply a pattern fill to the shadow.



Click this button if you want to apply a linear fountain fill to the shadow.



Click this button if you want to apply a radial fountain fill to the shadow.



Click this button if you want to apply a conical fountain fill to the shadow.



Click this button if you want to apply a square fountain fill to the shadow.



Opens a palette that you can use to select a solid color for a uniform fill, or a start color for a fountain fill.



Opens a palette that you can use to select the end color of your fountain fill.



Opens the Fountain Fill dialog box, which contains controls that let you edit and customize the linear fountain fill.



Lets you set the number of shadows you want to apply to the object. The shadows are positioned according to 
the Direction and Offset controls.



Lets you specify the shadow's offset. Shadows are positioned according to the Direction and Number controls.



Lets you specify the shadow's offset. Shadows are positioned according to the Direction and Number controls.



Opens a color palette that you can use to select the color of the shadow's outline.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Opens a catalog of fill patterns. Click the pattern you want to use to fill the shadow.



Displays the effect the current settings would have on the selected object.



Opens a palette that you can use to choose the foreground color of the selected pattern fill.



Opens a palette that you can use to choose the background color of the selected pattern fill.







No help topic is available for this item.



Lets you change the shape of the current polygon or star by increasing or decreasing the number of points.



Changes a star to a polygon with the number of points shown above.



Changes a polygon to a star with the number of points shown above.



Displays effects of the current settings.







No help topic is available for this item.



Enable this button to add a new layout.



Enable this button to add an existing Corel Print Space layout. You can select the layout by clicking its file name 
in the Contents of list or by clicking the Browse button.



Enable this button to add a program or a file created using another program. You can select the file or program 
by clicking its file name in the Contents of list box or by clicking the Browse button.



Lets you choose the folder to which you want to add the selected file. To create a blank folder, click OK without 
having specified a file using the Contents of or Browse controls.



Lets you choose the folder to which you want to add the selected file. To create a blank folder, click OK without 
having specified a file using the Contents of or Browse controls.



No help topic is available for this item.



No help topic is available for this item.



Displays the names of files in the current directory. Click the name of the file you want to add to the current. If 
the file you want doesn't appear in this list, click Browse.



When enabled, adds the selected file as well as all files connected to it using Hyperlinks.



Displays the New File dialog box, which lets you browse drives and folders to find the file you want to add to the 
current.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 









No help topic is available for this item.



Displays the current paper style. Click this field to see a list of available paper styles. When you select a style, 
the height and width values automatically adjust to reflect the paper you are using. Select Custom to set the 
page size manually.



Displays the width of the selected paper style. When you modify this value, the paper style is automatically set 
to Custom.



Displays the height of the selected paper style. When you modify this value, the paper is automatically set to 
Custom.



Swaps the height and width values so that the vertical dimension of the page is greater than the horizontal 
dimension. This button is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



Swaps the height and width values so that the horizontal dimension of the page is greater than the vertical 
dimension. This button is not available with paper styles that have fixed orientations, such as labels and 
envelopes.



Lets you set the location of the top page margin relative to the top edge of the page.



Lets you set the location of the left page margin relative to the left edge of the page.



Lets you set the location of the bottom page margin relative to the bottom edge of the page.



Lets you set the location of the right page margin relative to the right edge of the page.



Displays the width of the selected paper style. When you modify this value, the paper style is automatically set 
to Custom.



Displays the height of the selected paper style. When you modify this value, the paper is automatically set to 
Custom.



No help topic is available for this item.



Enable this check box to have all margins automatically incorporate changes to any margin. For example, if you 
set the Right margin at 2 inches, FLOW automatically sets the Left, Top, and Bottom at 2 inches.



Lets you set the location of the left page margin relative to the left edge of the page.



Lets you set the location of the top page margin relative to the top edge of the page.



Lets you set the location of the bottom page margin relative to the bottom edge of the page.



Lets you set the location of the right page margin relative to the right edge of the page.



Lets you set the location of the right page margin relative to the right edge of the page.



Lets you set the location of the top page margin relative to the top edge of the page.



Lets you set the location of the bottom page margin relative to the bottom edge of the page.



Displays the current paper style. Click this field to see a list of available paper styles. When you select a style, 
the height and width values automatically adjust to reflect the paper you are using. Select Custom to set the 
page size manually.



Opens a color palette that lets you simulate the effect of printing on colored paper. The color you choose has no 
effect on the printed layout; it is for viewing and information only.



Opens a color palette that lets you simulate the effect of printing on colored paper. The color you choose has no 
effect on the printed layout; it is for viewing and information only.



Lets you set the location of the left page margin relative to the left edge of the page.



Displays the width of the selected paper style. When you modify this value, the paper style is automatically set 
to Custom.







No help topic is available for this item.



Enable this check box to display objects on hidden layers.



Enable this check box to have Corel Print Space highlight an object's outline when you position the mouse 
pointer over it.



When enabled, allows you to edit and manipulate locked objects or objects on layers for which editing is 
disabled.



No help topic is available for this item.







No help topic is available for this item.



Sets the minimum horizontal distance allowed between lines and symbols when Autorouting is enabled. This 
number box is only available when the Enable Autorouting check box is enabled.



Sets the minimum horizontal distance allowed between lines and symbols when Autorouting is enabled. This 
number box is only available when the Enable Autorouting check box is enabled.



Sets the minimum vertical distance allowed between lines and symbols when Autorouting is enabled. This 
number box is only available when the Enable Autorouting check box is enabled.



Sets the minimum vertical distance allowed between lines and symbols when Autorouting is enabled. This 
number box is only available when the Enable Autorouting check box is enabled.



Lets you choose whether you want Autorouting to reroute connecting lines quickly or to reroute using the best 
and most effective route.



When enabled, applies automatic line routing for all connecting lines in the current layout.



Click this to select a solid crossover style for lines in the current layout. This button is only available when the 
Enable Autorouting check box is enabled.



Click this to select a broken crossover style for lines in the current layout. This button is only available when the 
Enable Autorouting check box is enabled.



Click this to select a bridged crossover style for lines in the current layout. This button is only available when the 
Enable Autorouting check box is enabled.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Lets you choose whether you want Autorouting to reroute connecting lines quickly or to reroute using the best 
and most effective route.







No help topic is available for this item.



Lets you position the selected object at a precise horizontal coordinate based on Corel Print Space's ruler 
system. If the Relative Position check box is enabled, this number box lets you move the object by a specific 
horizontal distance.



Lets you position the selected object at a precise horizontal coordinate based on Corel Print Space's ruler 
system. If the Relative Position check box is enabled, this number box lets you move the object by a specific 
horizontal distance.



Lets you position the selected object at a precise horizontal coordinate based on Corel Print Space's ruler 
system. If the Relative Position check box is enabled, this number box lets you move the object by a specific 
horizontal distance.



Lets you position the selected object at a precise vertical coordinate based on Corel Print Space's ruler system. If
the Relative Position check box is enabled, this number box lets you move the object by a specific vertical 
distance.



Lets you position the selected object at a precise vertical coordinate based on Corel Print Space's ruler system. If
the Relative Position check box is enabled, this number box lets you move the object by a specific vertical 
distance.



Lets you position the selected object at a precise vertical coordinate based on Corel Print Space's ruler system. If
the Relative Position check box is enabled, this number box lets you move the object by a specific vertical 
distance.



When enabled, allows you to move the selected object a specific horizontal or vertical distance relative to its 
current position.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



Lets you specify which point of the selected object is to be moved or positioned based on the Horizontal and 
Vertical settings. The nine controls correspond to the object's eight selection handles and center point.



No help topic is available for this item.







No help topic is available for this item.



Sets the angle by which you want to rotate the object. Positive values rotate counterclockwise, negative values 
rotate clockwise.



Sets the angle by which you want to rotate the object. Positive values rotate counterclockwise, negative values 
rotate clockwise.



Sets the angle by which you want to rotate the object. Positive values rotate counterclockwise, negative values 
rotate clockwise.



Lets you specify a horizontal coordinate for the selected object's center of rotation. If the Relative Center check 
box is enabled, this number box lets you move the center of rotation by a specific horizontal distance.



Lets you specify a horizontal coordinate for the selected object's center of rotation. If the Relative Center check 
box is enabled, this number box lets you move the center of rotation by a specific horizontal distance.



Lets you specify a vertical coordinate for the selected object's center of rotation. If the Relative Center check box
is enabled, this number box lets you move the center of rotation by a specific vertical distance.



Lets you specify a vertical coordinate for the selected object's center of rotation. If the Relative Center check box
is enabled, this number box lets you move the center of rotation by a specific vertical distance.



Lets you specify a vertical coordinate for the selected object's center of rotation. If the Relative Center check box
is enabled, this number box lets you move the center of rotation by a specific vertical distance.



When enabled, allows you to move the center of rotation a specific horizontal or vertical distance relative to its 
current position.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



Lets you use one of the selected object's selection handles as its center of rotation. The nine controls correspond
to the object's eight selection handles and center point.



No help topic is available for this item.







No help topic is available for this item.



Lets you change the selected object's width using a precise measurement.



Lets you change the selected object's width using a precise measurement.



Lets you change the selected object's height using a precise measurement.



Lets you change the selected object's height using a precise measurement.



Lets you change the selected object's height using a precise measurement.



Lets you set the percentage by which you want to scale the selected object's height.



Lets you set the percentage by which you want to scale the selected object's height.



Lets you set the percentage by which you want to scale the selected object's height.



Lets you set the percentage by which you want to scale the selected object's width.



Lets you set the percentage by which you want to scale the selected object's width.



Lets you set the percentage by which you want to scale the selected object's width.



Mirrors the object vertically using the specified scale factors and anchor point.



Mirrors the object horizontally using the specified scale factors and anchor point.



When enabled, automatically maintains current width and height proportions.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



Lets you to specify which point of the selected object remains stationary during scaling or mirroring. The nine 
controls correspond to the object's eight selection handles and center point.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



Distributes the selected objects horizontally by spacing their left edges evenly.



Distributes the selected objects vertically by spacing their center points evenly.



Distributes the selected objects vertically by placing equal spaces between them.



Distributes the selected objects horizontally by spacing their right edges evenly.



Distributes the selected objects vertically by spacing their top edges evenly.



Distributes the selected objects horizontally by spacing their center points evenly.



Distributes the selected objects vertically by placing equal spaces between them.



Distributes the selected objects vertically by spacing their bottom edges evenly.



Lets you choose the scope of the distribution. You can distribute objects to the extent of the page, to the extent 
of the selection box that surrounds them, or at a specific interval.



No help topic is available for this item.



Displays the effects of your current distribution settings.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



Opens a catalog of arrows that you can apply to the start of the selected line.



When enabled, reverses the direction of the selected start arrow.



Opens a catalog of arrows that you can apply to the center of the selected line.



When enabled, reverses the direction of the selected center arrow.



Opens a catalog of arrows that you can apply to the end of the selected line.



When enabled, reverses the direction of the selected end arrow.



Opens a catalog of arrows that you can apply to every node on the selected line.



When enabled, reverses the direction of the selected repeating arrow.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



Applies straight corners to the selected line or object outline. If the On check box is enabled, this setting applies 
to the FlowLine's outline.



Lets you apply a custom corner radius to the selected line or object outline. Increase the value to increase corner
roundness.



Lets you set the width of the selected line or object outline. If the On check box is enabled, this box sets the 
width of the FlowLine's outline.



Lets you set the width of the selected line or object outline. If the On check box is enabled, this box sets the 
width of the FlowLine's outline.



Lets you apply a custom corner radius to the selected line or object outline. Increase the value to increase corner
roundness.



Click this button if you want to apply a plain, dotted, or dashed line or outline style.



Click this button if you want to apply a patterned line or outline style.



Opens a catalog of FlowLine patterns. Click the pattern you want to apply to the selected line or object outline.



Applies rounded corners to the selected line or object outline. If the On check box is enabled, this setting applies 
to the FlowLine's outline.



No help topic is available for this item.



Opens a color palette that you can use to change the color of the selected line or object outline. If the On check 
box is enabled, the color applies to the FlowLine's outline.



No help topic is available for this item.



Opens a color palette that you can use to select the pattern's background color.



No help topic is available for this item.



Lets you choose a style for the selected line or object outline. If the On check box is enabled, this box specifies 
the FlowLine's outline style.



No help topic is available for this item.



Lets you choose a line type for the selected line or object outline. If the On check box is enabled, this list box 
specifies the FlowLine's outline type.



Opens a color palette that you can use to change the color of the selected line or object outline. If the On check 
box is enabled, the color applies to the FlowLine's outline.



Opens a color palette that you can use to select the fountain fill's start color.



Opens a color palette that you can use to select the fountain fill's end color.



Lets you set the percentage by which you want to scale the pattern horizontally. To use the pattern's original 
width, for example, you would type 100. To double the pattern's width, you would type 200.



Lets you set the percentage by which you want to scale the pattern horizontally. To use the pattern's original 
width, for example, you would type 100. To double the pattern's width, you would type 200.



Click this button to apply an unfilled FlowLine or to remove the fill from the selected FlowLine.



Opens a color palette that you can use to select the pattern's foreground color.



Opens a color palette that you can use to select the pattern's background color.



Opens a color palette that you can use to select the fountain fill's end color.



Opens a color palette that you can use to select the fountain fill's start color.



Opens the Fountain Fill dialog box, which provides controls that let you adjust and customize fountain fills.



Use this palette to choose a uniform color for the FlowLine.



Opens the Color Selector dialog box. You can use the controls on this dialog box to create or select custom 
colors.



Opens the Color Selector dialog box. You can use the controls on this dialog box to create or select custom 
colors.



Displays the selected uniform color.



Displays the selected uniform color.



Displays the selected uniform color.



Displays the selected uniform color.



Enable the On check box to apply    a FlowLine to the selected line or object outline using the controls below.



No help topic is available for this item.



Lets you choose a style for the selected line or object outline. If the On check box is enabled, this box specifies 
the FlowLine's outline style.



Opens a color palette that you can use to select the pattern's foreground color.



Opens a color palette that you can use to select the pattern's background color.



When enabled, lets you apply a FlowLine to the selected line or object outline using the controls below.



Lets you set the total width of the FlowLine (excluding its outline).



Lets you set the total width of the FlowLine (excluding its outline).



Lets you set the total width of the FlowLine (excluding its outline).



Click this button to apply a FlowLine with a uniform fill.



Click this button to apply a FlowLine with a pattern fill.



Click this button to apply a FlowLine with a fountain fill.



Click this button to apply a FlowLine with a linear fountain fill.



Click this button to apply a FlowLine with a radial fountain fill.



Click this button to apply a FlowLine with a conical fountain fill.



Click this button to apply a FlowLine with a square fountain fill.



Opens a catalog of line styles that you can apply to the selected line or object outline.



Lets you set the width of the selected line or object outline. If the On check box is enabled, this box sets the 
width of the FlowLine's outline.



Applies slightly rounded corners to the selected line or object outline. If the On check box is enabled, this setting 
applies to the FlowLine's outline.



No help topic is available for this item.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.







No help topic is available for this item.



Displays the number of objects in the current selection.



No help topic is available for this item.



Provides a place for you to specify a name for the selected object.



Enable this check box to have all lines automatically route around the selected object.



Enable this check box to have only those lines on the selected object's layer route around it.



Enable this check box to make the selected object visible. Disable it to hide the object.



Enable this check box to make the selected object editable. Disable it to prevent accidental changes to the 
object.



Enable this check box to include the selected object in printed copies of the current layout.



Enable this check box to turn on the selected object's connection points.



Enable this check box to allow deletion of the selected object. Disable it to prevent accidental deletion.



Enable this check box to have the selected object's center point remain stationary when you stretch or scale it 
using the mouse.



Enable this check box to have the selected object's opposite edge or corner remain stationary when you stretch 
or scale it using the mouse.







No help topic is available for this item.







No help topic is available for this item.



Enable this check box to search for objects that have the same name as the currently selected object.



Enable this check box to search for objects that have the same fill color as the selected object.



Enable this check box to search for objects that have the same outline color as the selected object.



Enable this check box to search for objects that have the same outline width as the selected object.



Enable this check box to search for objects that have the same outline style as the selected object.



Enable this check box to search for objects that have the same shadow color as the selected object.



Enable this check box to search for objects that have the same number of outline shadows as the selected 
object.



Enable this check box to search for objects that have the same name as the currently selected object.



Enable this check box to search for objects that have the same number of outline shadows as the selected 
object.



You can use this preview to help decide what attributes you want to use to conduct your search.







No help topic is available for this item.
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No help topic is available for this item.



No help topic is available for this item.



Properties command
Opens the Document Information dialog box, which allows you to specify summary information and view 
statistics about the active layout.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.
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No help topic is available for this item.



No help topic is available for this item.



New Layout command
Creates and opens a new layout using Corel Print Space's default all-purpose template.



New From Template command
Creates and opens a new layout that uses the template of your choice as its base.



New Template command
Creates and opens a new template.



New Smart Library button
Creates and opens a new, empty Smart Library. You can begin adding objects at any time.



New Smart Library command
Creates and opens a new, empty Smart Library. You can begin adding objects at any time.



Save All command
Saves all open files. If you haven't saved a certain layout or template before, the Save As dialog box appears and
prompts you to enter a name. If you're altering an existing file but want to keep the original version, use the 
Save As command.



Import command
Opens the Import dialog box, which allows you to add to the active layout using information from other programs
or other layouts.



Export command
Opens the Export dialog box, which allows you to save the current layout in a format that other programs can 
use.



Page Setup command
Opens the Page Setup dialog box, which allows you to set the page layout and miscellaneous object attributes.



Print Preview command
Opens the Print Preview dialog box so you can see how your layout will look on the printed page.



Select All command
Selects all objects in the current layout. Once selected, all operations you perform apply to all objects.



Select By Properties command
Opens the Select by Properties dialog box, which searches for and selects objects based on criteria you specify.



Delete command
Removes selected objects or text. Unlike the Cut command, the Delete command removes the selected objects 
or text without placing a copy on the Windows clipboard.



Duplicate command
Adds a copy of the selected objects or text to the current layout. The duplicate appears on top of and slightly 
offset from the original.



Insert Memo command
Opens the CorelMEMO dialog box, which allows you to insert notes and bitmapped images into any program that 
supports Object Linking and Embedding (OLE). Use a CorelMEMO when you want to leave yourself a reminder, 
note a change in a document, or place a comment into a program. Add one of the bitmapped images provided 
with CorelMEMO or include your own bitmapped image to customize your CorelMEMO.



Toolbars command
Opens the Toolbars dialog box, which allows you to specify which toolbars are displayed as well as their size. This
dialog box also lets you create new Toolbars to which you can add the buttons you want.



Status Bar command
Displays and hides the Status Bar. When the Status Bar is displayed, this command has a check box to its left.



Rulers command
Displays or hides the on-screen rulers. When the rulers are displayed, this command has a check mark to its left.



None Command
Hides the color palette so that no palette is visible on the Corel Print Space window.



Custom Colors command
Displays the current custom palette. You can create new custom palettes that have the colors and color 
arrangement you want.



Uniform Colors command
Displays the Uniform color palette. When the Uniform color palette is displayed, this command has a check mark 
to its left.



Grid command
Displays or hides the grid. When the grid is displayed, this command has a check mark to its left.



Hyperlink Browser command
Opens the Hyperlink Browser, which displays all the Hyperlinks in the current layout. You can use the controls on 
the Hyperlink Browser to view or remove Hyperlinked files.



Symbol command
Opens the Shape Properties dialog box, which provides controls for setting symbol attributes including fill, 
outline, shadows.



Line command
Opens the Outline tab on the Shape Properties dialog box. This tab provides controls for changing the 
appearance and behavior of lines and object outlines.



Text command
Opens the Text tab on the Shape Properties dialog box. This tab provides controls for changing text appearance 
and characteristics.



Polygon Settings command
Opens the Polygon Settings dialog box, which provides controls for changing the polygon and star attributes.



Grid and Ruler Setup command
Opens the Grid and Ruler Setup dialog box, which provides controls for changing the properties of the grid, ruler, 
and drawing scale.



Guidelines Setup command
Opens the Guidelines Setup dialog box, which provides controls for adding, deleting, and moving horizontal and 
vertical guidelines.



Snap To Grid command
Enables and disables the snapping of objects to the grid. Enabling Snap To Grid forces the cursor to stay on grid 
points, giving you precision as you draw or manipulate objects in your layouts. When enabled, a check mark 
appears to the left of this command.



Snap To Guidelines command
Enables and disables the snapping of objects to horizontal and vertical guidelines. Enabling Snap to Guidelines 
forces objects to snap to a guideline when drawn or moved near it, giving you added precision as you align or 
position objects in your layouts.



Position command
Opens the Position tab on the Transform dialog box. This tab provides controls for moving or positioning selected 
objects with precision.



Size command
Opens the Size tab on the Transform dialog box. This tab provides controls for stretching, scaling, and mirroring 
selected objects with precision.



Rotate command
Opens the Rotate tab on the Transform dialog box. This tab provides controls for rotating selected objects with 
precision. You'll also find controls for changing the object's center of rotation.



Fragment command



Intersect command
Intersects the selected objects. The new object takes on the outline, fill, and shadow attributes of the topmost 
selected object.



Trim command
Trims the topmost selected object. The new object maintains its outline, fill, and shadow attributes.



Weld command
Welds the selected objects. The new object takes on the outline, fill, and shadow attributes of the topmost 
selected object.



Options command
Opens the Options dialog box, which allows you to set your preferences regarding how Corel Print Space 
performs certain operations and displays objects on the screen. This dialog box also lets have FLOW 
automatically back up your work in the directory of your choice.



Customize command
Opens the Customize dialog box, which allows you to customize Corel Print Space's appearance and the way it 
performs your commands. Use this command to customize the keyboard, menus, toolbars, and color palette.



Spelling command
Opens the Spelling dialog box, which lets you check spelling in the active layout. This dialog box also provides 
controls for substituting corrections for spelling and typographical errors.



Thesaurus command
Opens the Thesaurus dialog box, which allows you to replace the selected word with a synonym or antonym. This
dialog box also provides definitions to help ensure accuracy and precision in layout text.



Type Assist command
Opens the Type Assist dialog box, which allows you to customize settings for correcting and formatting text 
automatically as you type.



Align and Distribute command
Opens the Align and Distribute dialog box, which lets you align or distribute objects horizontally and/or vertically. 
This command is available only when you have two or more objects selected.



Column Align command
Aligns selected objects' vertical center points with the vertical center of the selection box that surrounds them. 
This command is available only when you have two or more objects selected.



Row Align command
Aligns selected objects' horizontal center points vertical the horizontal center of the selection box that surrounds 
them. This command is available only when you have two or more objects selected.



To Front command
Places the selected object on top of all objects on its layer. This command is available only when you have one or
more objects selected.



To Back command
Places the selected object beneath all objects on its layer. This command is available only when you have one or 
more objects selected.



In Front Of command
Lets you place the selected object in front of any object on the same layer. When activated, this command 
changes the mouse pointer to a horizontal arrow that you can use to choose the object in front of which you 
want to place the selected object.



Behind command
Lets you place the selected object behind any object on the same layer. When activated, this command changes 
the mouse pointer to a horizontal arrow that you can use to choose the object behind which you want to place 
the selected object.



No help topic is available for this item.



Group command
Combines the selected objects so that you can manipulate and format them as a single unit.



Ungroup command
Separates the selected group so that you can manipulate its components as individual objects.



Layers command
Opens the Layers dialog box, which provides controls for adding, deleting, and arranging layers as well as setting
layer attributes.



Refresh Window command
Clears the active window of any "debris" left over from editing and manipulating symbols, lines, and text.



Technical Support command
Opens Technical Support Help, which provides details on product support for Corel applications; including 
available support services, Import and Export filters information, error messages, and troubleshooting tips.



No help topic is available for this item.
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No help topic is available for this item.



New Layout button
Creates and opens a new layout using Corel Print Space's default all-purpose template.



Print Preview button
Opens the Print Preview dialog box so you can see how your layout will look on the printed page.



Check Spelling button
Opens the Spelling dialog box, which lets you check spelling in the active layout. This dialog box also provides 
controls for substituting corrections for spelling and typographical errors.



Align button
Opens the Align tab on the Align and Distribute dialog box. This tab provides controls that let you align objects 
horizontally and/or vertically. This button is available only when you have two or more objects selected.



Distribute button
Opens the Distribute tab on the Align and Distribute dialog box. This tab provides controls that let you distribute 
objects horizontally and/or vertically. This button is available only when you have two or more objects selected.



Group button
Combines the selected objects so that you can manipulate and format them as a single unit. If you select a 
group, you can click this button to ungroup it.



Move To Front button
Places the selected object on top of all objects on its layer. This command is available only when you have one or
more objects selected.



Move To Back button
Places the selected object beneath all objects on its layer. This command is available only when you have one or 
more objects selected.



Snap To Grid button
Enables and disables the snapping of objects to the grid. Enabling Snap To Grid forces the cursor to stay on grid 
points, giving you precision as you draw or manipulate objects in your layouts.



Smart Library button
Opens any Smart Library you select.







No help topic is available for this item.



Outline Tool
Opens the Outline Flyout, which provides a series of preset outlines that you can apply to objects in your layouts.



Fill Tool
Opens the Fill Flyout, which allows you to apply uniform, pattern, and fountain fills to objects in your layouts. This
flyout also provides a no fill option and a series of preset fills.



Zoom Flyout
Displays controls that let you change your vantage point on the active layout. These controls allow you to 
magnify or reduce your viewpoint, see your layout at actual size, see all or selected objects, or see just what fits 
on the drawing page.



Shadow Tool
Opens the Shadow Flyout, which provides a series of preset shadows that you can apply to objects in your 
layouts.



Pick Tool
Lets you select symbols, text, and lines. After you select an object, you can use menu or toolbar commands to 
edit, manipulate, or format it. You can also use the Pick Tool to move, stretch, scale, and rotate objects.



Frame Tool
Lets you create a frame on the working page of your layout in which you can associate a CorelCAD file.



Rotate Tool
When selected lets you rotate the selected object and/or change its center of rotation using the mouse. 



Zoom In
Lets you magnify a portion of the screen.



Zoom Out
Zooms out by a factor of two or returns you to your previous viewpoint.



Zoom Actual Size
Shows your layout at its actual size.



Zoom to Selected
Magnifies or reduces your viewpoint so that the selected objects fit in the drawing window.



Zoom to All
Magnifies or reduces your viewpoint so that all objects in the layout fit in the drawing window.



Zoom to Page
Magnifies or reduces your viewpoint so that the entire drawing page fits in the drawing window.



Panning Tool
Lets you change your viewpoint on a layout by dragging it within the drawing window.



Line Tool
Lets you draw straight lines and connected straight lines by clicking and dragging the mouse. Double-click to end
the line.
Holding the mouse button on the Line Tool in the toolbox opens a flyout menu from which you can select the 
Curve Tool or Freehand Tool.



Curve Tool
Lets you draw curves by clicking and dragging the mouse. The points at which you click become the curves 
vertexes. Double-click to end the curve.
Holding the mouse button on the Curve Tool in the toolbox opens a flyout menu from which you can select the 
Line Tool or Freehand Tool.



Freehand Tool
Lets you draw freehand lines and curves by dragging the mouse. Release the mouse button to end the line or 
curve.
Holding the mouse button on the Freehand Tool in the toolbox opens a flyout menu from which you can select 
the Line Tool or Curve Tool.



Rectangle Tool
Lets you draw rectangles and squares by clicking and dragging the mouse.



Ellipse Tool
Lets you draw ellipses and circles by clicking and dragging the mouse.



Polygon Tool
Lets you draw polygons and stars by clicking and dragging the mouse. Click Format, Polygon Settings to adjust 
the tool's performance.



Text Tool
Lets you type framed or unframed text directly into your layouts.



Hairline Outline
Sets the outline thickness to 0.2 points for the selected object.
Choose this tool with no objects selected to make the default line and outline thickness 0.2 points.



1 Point Outline
Sets the outline thickness to 1 point for the selected object.
Choose this tool with no objects selected to make the default line and outline thickness 1 point.



2 Point Outline
Sets the outline thickness to 2 points for the selected object.
Choose this tool with no objects selected to make the default line and outline thickness 2 points.



4 Point Outline
Sets the outline thickness to 4 points for the selected object.
Choose this tool with no objects selected to make the default line and outline thickness 4 points.



6 Point Outline
Sets the outline thickness to 6 points for the selected object.
Choose this tool with no objects selected to make the default line and outline thickness 6 points.



No help topic is available for this item.



Remove Outline
Removes outlines from the selected object.



No help topic is available for this item.



No help topic is available for this item.



Dotted Outline button
Applies a dotted outline to all selected lines and shape outlines. Click this button with no objects selected to 
make this the default line and outline style.



Dot-Dashed Outline button
Applies a dot-dashed pattern to all selected lines and shape outlines. Click this button with no objects selected to
make this the default line and outline style.



Dot-Dash-Dashed Outline button
Applies a dot-dash-dashed pattern to all selected lines and shape outlines. Click this button with no objects 
selected to make this the default line and outline style.



No Fill
Removes the fill from the object, allowing objects to show through from behind it.



Solid Outline button
Applies a solid outline to all selected lines and shape outlines. Click this button with no objects selected to make 
this the default line and object outline style.



Pattern Fill
Opens the Shape Properties dialog box with controls visible for specifying pattern fills.



Fountain Fill
Opens the Shape Properties dialog box with controls visible for specifying fountain fills.



White Fill
Selects white for the fill color.
Choose this tool with no objects selected to make white the default fill color.



Black Fill
Selects black for the fill color.
Choose this tool with no objects selected to make black the default fill color.



Transparent Shadow button
Applies a transparent shadow to all selected objects. Click this button with no objects selected to apply a 
transparent shadow to all new objects by default.



Light Shadow button
Applies a gray shadow to all selected objects. Click this button with no objects selected to apply a light shadow 
to all new objects by default.



Black Shadow button
Applies a black shadow to all selected objects. Click this button with no objects selected to apply a black shadow 
to all new objects by default.



Fountain Filled Shadow button
Applies a fountain filled shadow to all selected objects. Click this button with no objects selected to apply a 
fountain filled shadow to all new objects by default.



No help topic is available for this item.



Decrease Text Size button
Makes selected text one font size smaller. The increment is based on sizes available for the current font.



Increase Text Size button
Makes selected text one font size larger. The increment is based on sizes available for the current font.



Bold button
Applies bold style to the selected text. If no text is selected, bold becomes the default text style.



Italic button
Applies italic style to the selected text. If no text is selected, italic becomes the default style.



Underline button
Applies an underline to the selected text. If no text is selected, underline becomes the default text style.



Left Justification button
Aligns text to the left text frame margin. You can apply left justification to framed text only.



Centered button
Aligns lines of text down an imaginary center line down the middle of the selected text frame. You can apply 
centering to framed text only.



Right Justification button
Aligns text to the right frame margin. You can apply right justification to framed text only.



Full Justification button
Aligns text so that it reaches both the right and left frame margins. You can apply full justification to framed text 
only.



Rotate Left button
Rotates the selected object 90 degrees counterclockwise.



Rotate Right button
Rotates the selected object 90 degrees clockwise.



Toolbox button
Displays and hides the Toolbox.



Rulers button
Displays and hides the horizontal and vertical rulers.



Color Palette button
Displays and hides the on-screen color palette.



Status Bar button
Displays and hides the Status Bar.



Standard Toolbar button
Displays and hides the Standard toolbar.



Text Toolbar button
Displays and hides the Text toolbar.



Zoom Toolbar button
Displays and hides the Zoom toolbar.



Arrangement Toolbar button
Displays and hides the Arrangement toolbar.



Save All button
Saves all open files. If you haven't saved a certain layout or template before, the Save As dialog box appears and
prompts you to enter a name. If you're altering an existing file but want to keep the original version, use the 
Save As command.



Properties button
Opens the Document Information dialog box, which allows you to specify summary information and view 
statistics about the active layout.



Page Setup button
Opens the Page Setup dialog box, which allows you to set the page layout and miscellaneous object attributes.



Import button
Opens the Import dialog box, which allows you to add to the active layout using information from other programs
or other FLOW layouts.



Export button
Opens the Export dialog box, which allows you to save the current layout in a format that other programs can 
use.



Options button
Opens the Options dialog box, which allows you to set your preferences regarding how Corel Print Space 
performs certain operations and displays objects on the screen. This dialog box also lets have FLOW 
automatically back up your work in the directory of your choice.



Toolbars button
Opens the Toolbars dialog box, which allows you to specify which toolbars are displayed as well as their size. This
dialog box also lets you create new Toolbars to which you can add the buttons you want.



Select All button
Selects all objects in the current layout. Once selected, all operations you perform apply to all objects.



Delete button
Removes selected objects or text. Unlike the Cut command, the Delete command removes the selected objects 
or text without placing a copy on the Windows clipboard.



Duplicate button
Adds a copy of the selected objects or text to the current layout. The duplicate appears on top of and slightly 
offset from the original.



Hyperlink Browser button
Opens the Hyperlink Browser, which displays all the Hyperlinks in the current layout. You can use the controls on 
the Hyperlink Browser to view or remove Hyperlinked files.



Grid button
Displays or hides the grid. When the grid is displayed, this command has a check mark to its left.



Symbol button
Opens the Shape Properties dialog box, which provides controls for setting symbol attributes including fill, 
outline, shadows.



Line button
Opens the Outline tab on the Shape Properties dialog box. This tab provides controls for changing the 
appearance and behavior of lines and object outlines.



Text button
Opens the Text tab on the Shape Properties dialog box. This tab provides controls for changing text appearance 
and characteristics.



Polygon Settings button
Opens the Polygon Settings dialog box, which provides controls for changing the polygon and star attributes.



Grid and Ruler Setup button
Opens the Grid and Ruler Setup dialog box, which provides controls for changing the properties of the grid, ruler, 
and drawing scale.



Guidelines Setup button
Opens the Guidelines Setup dialog box, which provides controls for adding, deleting, and moving horizontal and 
vertical guidelines.



Position Dialog button
Opens the Position tab on the Transform dialog box. This tab provides controls for moving or positioning selected 
objects with precision.



Size Dialog button
Opens the Size tab on the Transform dialog box. This tab provides controls for stretching, scaling, and mirroring 
selected objects with precision.



Rotate Dialog button
Opens the Rotate tab on the Transform dialog box. This tab provides controls for rotating selected objects with 
precision. You'll also find controls for changing the object's center of rotation.



Weld button
Welds the selected objects. The new object takes on the outline, fill, and shadow attributes of the topmost 
selected object.



Intersect button
Intersects the selected objects. The new object takes on the outline, fill, and shadow attributes of the topmost 
selected object.



Trim button
Trims the topmost selected object. The new object maintains its outline, fill, and shadow attributes.



No help topic is available for this item.



Column Align button
Aligns selected objects' vertical center points with the vertical center of the selection box that surrounds them. 
This command is available only when you have two or more objects selected.



Row Align button
Aligns selected objects' horizontal center points vertical the horizontal center of the selection box that surrounds 
them. This command is available only when you have two or more objects selected.



In Front Of button
Lets you place the selected object in front of any object on the same layer. When activated, this command 
changes the mouse pointer to a horizontal arrow that you can use to choose the object in front of which you 
want to place the selected object.



Behind button
Lets you place the selected object behind any object on the same layer. When activated, this command changes 
the mouse pointer to a horizontal arrow that you can use to choose the object behind which you want to place 
the selected object.



Layers button
Opens the Layers dialog box, which provides controls for adding, deleting, and arranging layers as well as setting
layer attributes.



Customize button
Opens the Customize dialog box, which allows you to customize Corel Print Space's appearance and the way it 
performs your commands. Use this command to customize the keyboard, menus, toolbars, and color palette.



Thesaurus button
Opens the Thesaurus dialog box, which allows you to replace the selected word with a synonym or antonym. This
dialog box also provides definitions to help ensure accuracy and precision in layout text.



Type Assist button
Opens the Type Assist dialog box, which allows you to customize settings for correcting and formatting text 
automatically as you type.



Start Recording button
Use the Start Recording command to start recording your actions. You can record most keystrokes, mouse, 
toolbar, and menu actions. When you have finished performing the actions you want to record, choose Stop 
Recording. You can then use the Playback Recording command to replay your actions.
When you click Start Recording, the command is grayed until you click Stop Recording.



Playback Recording button
Use the Playback Recording command to replay the actions you recorded with the Start and Stop Recording 
commands. If no actions have been recorded during the current Corel Print Space session, the command is 
grayed.



Save Recording button
Opens the Save Recording dialog box that saves the current recording as a Corel SCRIPT. Once you save a 
recording as a script, you can edit it with the Corel SCRIPT Editor. When your recorded actions are saved as a 
script, they are translated into Corel SCRIPT application commands.
If you intend on using your recorded script often, you can assign it to the FLOW menu, toolbar or a keystroke.
If no actions have been recorded during the current Corel Print Space session, the command is grayed.



Stop Recording button
When you have finished performing the actions you want to record, click Stop Recording. You can then use the 
Playback Recording command to replay your actions.
The Stop Recording command is grayed until you click Start Recording.



Run Wizard / Script button
Opens the Run Script dialog box. Click the saved Corel SCRIPT script or wizard you want to execute. The default 
folder and drive are shown but you can execute a script or wizard from any drive or folder. 
The script or wizard is executed from the active layout window.
Tip

Remember that you can also assign a keystroke, add a menu item, or add a button to the toolbar to run a 
script or a wizard.



Corel SCRIPT Editor button
Opens the Corel SCRIPT Editor. The Corel Script Editor is a tool you use to create and edit Corel SCRIPT script files
(or saved recordings).
Since script files are Windows text files, the Corel Script Editor works like a standard text editor, but also includes
features to test, debug, and run script files. Corel SCRIPT script files do not contain a compiled binary 
component. Before a script is executed, it is compiled internally into a program file.
Note

You can edit a recording until it has been first saved.
The Corel SCRIPT Editor does not change the recording in memory when you edit a saved recording. You 

can still playback the original recording with the Playback Recording command.
You can run a Corel SCRIPT script in your application using the Run Script command.



Refresh Window button
Clears the active window of any "debris" left over from editing and manipulating symbols, lines, and text.



Technical Support button
Opens Technical Support Help, which provides details on product support for Corel applications; including 
available support services, Import and Export filters information, error messages, and troubleshooting tips.



Color Setup command
Opens the color selector dialog box, where you can select and modify your color palettes.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.



Saves all the changes you have made without closing this dialog box.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.



Saves all the changes you have made without closing this dialog box.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.



Saves all the changes you have made without closing this dialog box.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.



Saves all the changes you have made without closing this dialog box.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



No help topic is available for this item.



Saves all the changes you have made without closing this dialog box.



Enable this check box to apply the current settings on all tabs to all new symbols, lines, and text.



Open command
Loads the layout template you select.



Close command
Closes the active layout or template. If you've made any changes since you last saved the file, Corel Print Space 
prompts you to save before closing.



Save command
Saves the active layout template using the file name displayed in the title bar. If you haven't saved the active 
work before, the Save As dialog box appears and prompts you to enter a file name. If you're altering an existing 
file but want to keep the original version, use the Save As command and specify a new file name.



Save As command
Opens the Save As dialog box, which allows you to save new work, a new version of an existing file, or an 
existing file using a new file name or location.



Print command
Opens the Print dialog box, which allows you to choose and set up a printer, change printing options, and print 
the current layout.



Palette Setup command
Opens the Palette Setup dialog box, which provides controls for creating colors and managing custom color 
palettes.



Queries the current printer for the page size and orientation and displays those dimensions in the Width and 
Height fields.



Tile Horizontally button
Displays all open windows and arranges them in horizontal rows.



Tile Vertically button
Displays all open windows and arranges them in vertical columns.



Color Setup command
Opens the color selector dialog box, where you can select and modify your color palettes.



No help topic is available for this item.



Enable this check box to have lines and other objects' connector pins snap to selected object's connector pin 
when drawn or dragged nearby.



Enable this button to have the selected object's connector pin act as a pivot point when the object is attached to 
another object.



Convert to Symbol command
Reverses the conversion of an object to a series of line or curve segments. Once you've made changes to the 
individual segments, you can use this command to reunite the segments as a single object.



Replace command
Opens the Replace dialog box, which searches for and replaces occurrences of the text you specify. You can 
search the entire layout or any number of individual text entries.



Tutorial command
Opens the Corel Print Space Tutorial.



Lets you specify the interval at which you want to distribute the objects.



No help topic is available for this item.



Corel Print Space Help Topics command

Displays the contents of the Corel Print Space help system, which provides easy access to descriptions and 
procedures that will help you learn how to use Corel Print Space to create high-quality layouts. The help system 
also provides a glossary of terms and a reference section with information on using CorelMEMO.



No help topic is available for this item.



Combine command
Joins the selected objects to create a single object.



Using Help command
Opens the Windows Help contents, which provides easy access to descriptions and procedures that will help you 
learn to use the Windows help system.



Paste button
Places a copy of the contents of the Windows clipboard at the center of the drawing page.



Links command
Lists all the links in the current file. This list includes internal links to other Corel Print Space files and external 
links to other Windows applications.



No help topic is available for this item.



Lets you specify a horizontal coordinate for the selected object's center of rotation. If the Relative Center check 
box is enabled, this number box lets you move the center of rotation by a specific horizontal distance.



Paste Special command
Places a copy of the contents of the Windows clipboard at the center of the drawing page. Unlike the Paste 
command, you can specify what format the information uses and even create a link to its source file,



About Corel Print Space command
Opens the About Corel Print Space window, which displays information about your copy of Corel Print Space and 
provides quick access to information about the current state of your computer system.



New From Template button
Creates and opens a new layout that uses the template of your choice as its base.



No help topic is available for this item.



No help topic is available for this item.



Insert New Object command
Opens the Insert New object dialog box, which lets you insert a linked or embedded object created using another
program. You can also insert the contents of another file as an embedded or linked object.



No help topic is available for this item.



Cascade command
Arranges all open windows so that you can see each window's title bar. Minimized windows are arranged at the 
bottom of the Corel Print Space window.



Arrange Icons button
Arranges all currently minimized windows in the bottom left corner of the Corel Print Space window.



Lets you specify the interval at which you want to distribute the objects.



No help topic is available for this item.



Connect command
Draws connecting lines between the selected objects. If you select more than two objects, connections are made
based on the drawing order the order in which you added the objects to the layout.



Lets you set the percentage by which you want to scale the pattern horizontally. To use the pattern's original 
width, for example, you would type 100. To double the pattern's width, you would type 200.



New Window command
Opens a new window with the same contents as the active window. You can use this command to view layouts 
from different vantage points.



About Corel Print Space button
Opens the About Corel Print Space window, which displays information about your copy of Corel Print Space and 
provides quick access to information about the current state of your computer system.



Exit command
Ends the current Corel Print Space session. If you've made any changes since you last saved your work, Corel 
Print Space prompts you to save before exiting.



Corel Print Space Help Topics button
Displays the contents of the Corel Print Space help system, which provides easy access to descriptions and 
procedures that will help you learn how to use Corel Print Space to create high-quality layouts. The help system 
also provides a glossary of terms and a reference section with information on using CorelMEMO.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Lets you set the percentage by which you want to scale the pattern vertically. To use the pattern's original 
height, for example, you would type 100. To double the pattern's height, you would type 200.



Send command
Lets you send drawings to other users by way of the Microsoft Exchange. The Inbox Setup Wizard will help you 
set up your mailbox so you can send and receive images through e-mail.



Font list box
Displays the names of the selected font. Click the downward arrow to see the list of available fonts.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Tutorial button
Opens the Corel Print Space Tutorial.



No help topic is available for this item.



Save As button
Opens the Save As dialog box, which allows you to save new work, a new version of an existing file, or an 
existing file using a new file name or location.



No help topic is available for this item.



Aligns the selected objects to the center of the drawing page.



Convert to Curves command
Converts the selected object to a series of line or curve segments. You can manipulate, edit, and format each of 
these segments as a separate line.



Lets you set the percentage by which you want to scale the pattern vertically. To use the pattern's original 
height, for example, you would type 100. To double the pattern's height, you would type 200.



No help topic is available for this item.



No help topic is available for this item.



Insert New Object button
Opens the Insert New object dialog box, which lets you insert a linked or embedded object created using another
program. You can also insert the contents of another file as an embedded or linked object.



Open button
Loads the layout or template you select.



Save button
Saves the active layout or template using the file name displayed in the title bar. If you haven't saved the active 
work before, the Save As dialog box appears and prompts you to enter a file name. If you're altering an existing 
file but want to keep the original version, use the Save As command and specify a new file name.



No help topic is available for this item.



No help topic is available for this item.



Cut command
Removes the selected object or text from the layout and places it on the Windows Clipboard. This command is 
only available when objects or text are selected.



Cascade button
Arranges all open windows so that you can see each window's title bar. Minimized windows are arranged at the 
bottom of the Corel Print Space window.



No help topic is available for this item.



Replace button
Opens the Replace dialog box, which searches for and replaces occurrences of the text you specify. You can 
search the entire layout or any number of individual text entries.



Paste Special button
Places a copy of the contents of the Windows clipboard at the center of the drawing page. Unlike the Paste 
command, you can specify what format the information uses and even create a link to its source file,



No help topic is available for this item.



Paste command
Places a copy of the contents of the Windows clipboard at the center of the drawing page.



Font Size list box
Displays the size of the selected font. Click the downward arrow to see the list of available sizes



Enable this button to remove the selected object's connector pin.



Displays the height of the selected paper style. When you modify this value, the paper style is automatically set 
to Custom.



Copy command
Places a copy of the selected object or text on the Windows Clipboard. This command is only available when 
objects or text are selected.



Find command
Opens the Find dialog box, which lets you search for occurrences of the text you specify. You can search the 
entire layout or any number of individual text entries.



Redo command
Restores the action just undone. The Redo command only becomes available immediately after you have used 
the Undo command. The name of the Redo command changes depending on the last action for example, Redo 
Fill or Redo Rotate.



Undo command
Reverses the action you just performed. The name of the command depends on the action you performed most 
recently for example, Undo Fill or Undo Rotate. If you can't undo an action, the Undo command appears as Can't 
Undo.



No help topic is available for this item.



No help topic is available for this item.



Print button
Prints the active layout using the default printer.



Break Apart command
Separates the selected combined object. This command is only available when a combined object is selected.



Send button
Lets you send drawings to other users by way of the Microsoft Exchange. The Inbox Setup Wizard will help you 
set up your mailbox so you can send and receive images through e-mail.



Help button
Opens a help topic for any toolbar button or menu command you click.



No help topic is available for this item.



New Template button
Creates and opens a new template.



Break Apart button
Separates the selected combined object. This command is only available when a combined object is selected.



New Window button
Opens a new window with the same contents as the active window. You can use this command to view layouts 
from different vantage points.



No help topic is available for this item.



Combine button
Joins the selected objects to create a single object.



Cut button
Removes the selected object or text from the layout and places it on the Windows Clipboard. This button is only 
available when objects or text are selected.



Copy button
Places a copy of the selected object or text on the Windows Clipboard. This button is only available when objects 
or text are selected.



Find button
Opens the Find dialog box, which lets you search for occurrences of the text you specify. You can search the 
entire layout or any number of individual text entries.



Redo button
Restores the action just undone. The Redo button only becomes available immediately after you have used the 
Undo button or menu command.



Undo button
Reverses the action you just performed. If you can't undo an action, the Undo button appears grayed out.



No help topic is available for this item.



Arrange Icons command
Arranges all currently minimized windows in the bottom left corner of the Corel Print Space window.



Autorouted Line Tool
Draws an Autorouted connecting line between the start and end points you specify.



Tile Horizontally command
Displays all open windows and arranges them in horizontal rows.



Tile Vertically command
Displays all open windows and arranges them in vertical columns.



Object command
Allows you to edit linked and embedded objects using the source program while remaining within the Corel Print 
Space window.



Connect button
Draws connecting lines between the selected objects. If you select more than two objects, connections are made
based on the drawing order the order in which you added the objects to the layout.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



File list command
Opens the document. Click the number or name that corresponds to the document you want to open.



Select By Properties button
Opens the Select by Properties dialog box, which searches for and selects objects based on criteria you specify.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



When enabled, aligns selected text with the bottom of the text frame or shape that contains it.



When enabled, aligns selected text with the center of the text frame or shape that contains it.



Lets you select the type of information you want to displayed in the selected shape or text frame. This list box is 
only enabled when the Field button is enabled.



When enabled, aligns selected text with the top of the text frame or shape that contains it.



Displays the current arrow Smart Library. This library provides the arrows that appear on arrow pickers in the 
Shape Properties dialog box. To change the arrow library, type a new file name in this box or click Browse and 
search for the library you want.



Displays the Open dialog box. You can use this dialog box to choose a new arrow Smart Library.



Displays the Open dialog box. You can use this dialog box to choose a new fill pattern Smart Library.



Displays the Open dialog box. You can use this dialog box to choose a new line pattern Smart Library.



Lets you specify the default unit of measurement.



Displays the current fill pattern Smart Library. This library provides the patterns that appear on fill pattern pickers
in the Shape Properties dialog box. To change the pattern library, type a new file name in this box or click Browse
to search for the library you want.



Displays the current line pattern Smart Library. This library provides the patterns that appear on line pattern 
pickers in the Shape Properties dialog box. To change the pattern library, type a new file name in this box or click
Browse to search for the library you want.



When enabled, applies grid only to drawing page, not to the entire drawing window.



When enabled, places the pattern on top of the FlowLine outline.



Displays the date and time that the file was last opened.



When enabled, the file is an archived file. To change this characteristic, use the Windows Explorer to find the file,
click the file's icon using the right mouse button, then click Properties.



Displays the date and time that the file was first saved.



When enabled, the file is a hidden file. To change this characteristic, use the Windows Explorer to find the file, 
click the file's icon using the right mouse button, then click Properties.



Displays the location of the file.



Displays the date and time that the file was last saved after being modified.



Displays the file name in a format that MS-DOS programs can use.



When enabled, the file is a Read Only file. To change this characteristic, use the Windows Explorer to find the file,
click the file's icon using the right mouse button, then click Properties.



Displays the size of the file.



When enabled, the file is a system file. To change this characteristic, use the Windows Explorer to find the file, 
click the file's icon using the right mouse button, then click Properties.



Displays the file type.



Displays the file name in a format that MS-DOS programs can use.



No help topic is available for this item.



Deletes the custom property selected in the Properties box.



When enabled, links the selected custom property to a specific object in the current document. This check box is 
available only if you've defined specific contents in your file.



No help topic is available for this item.



If you want to assign a custom property to the current document, type the name of the property in this box.



Lists any custom properties you’ve created for the current file.



Lets you select the type of custom property assigned to the name displayed in the Name box.



Adds the current custom property to the document.



Lets you enter a value for the custom property. You must type a value that is compatible with the selection in the
Type box. For example, if you've chosen text in the Type box, you must type text in this box.
When the Link To Content check box is enabled, the name of this box changes to Source. You can link the custom
property to specific contents in the file by choosing a definition from this box.



No help topic is available for this item.



No help topic is available for this item.



Provides a space for you to enter the name of the author of the document. You can use this information to help 
you identify the document.



Provides a space for you to enter comments that identify the document. These comments appear in the Save As 
and Open dialog boxes.



Provides a space for you to enter a company name to help identify the document.



Provides a space for you to enter a category to help identify the document.



Provides a space for you to enter keywords that identify the document. These keywords appear in the Save As 
and Open dialog boxes.



Provides a space for you to enter a manager name to help identify the document.



Provides a space for you to enter a title for the document. This title can be different from the document's file 
name. You can use this information to help you identify the document.



When enabled, saves a picture of the first page of the file for previewing in the Open dialog box.



Provides a space for you to enter the subject of the document. You can use this information to help you identify 
the document.



Displays the template used to created the document.



Displays the date and time that the file was first saved.



Displays the date and time that the file was last opened.



Displays the date and time that the file was last saved after being modified.



Displays the date and time that the document was last printed.



Displays the number of times the document has been saved.



Displays the name of the person who last saved the document.



Displays statistics for the current document.



Displays the total minutes a document has been open for editing since it was created.



Lists the parts of the current document for example, the names of objects in technical layout.



Rounded Corners button
Applies rounded corners to the selected line or object outline.







No help topic is available for this item.



Displays the contents of the project. Double-click a folder to display its contents or a file icon to open a file.



Opens the highlighted file.



Adds a new file to the current project.



Add command
Adds a new file to the current project.



Removes the highlighted file from the current project.



Remove command
Removes the highlighted file from the current project.







No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



No help topic is available for this item.



Conical Fountain Fill button
Applies a preset conical fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Linear Fountain Fill
Applies a preset linear fountain fill to all selected objects. Click this button with no objects selected to make this 
the default fill.



Radial Fountain Fill button
Applies a preset radial fountain fill to all selected objects. Click this button with no objects selected to make this 
the default fill.



Square Fountain Fill button
Applies a preset square fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Radial Fountain Fill button
Applies a preset radial fountain fill to all selected objects. Click this button with no objects selected to make this 
the default fill.



Conical Fountain Fill button
Applies a preset conical fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Square Fountain Fill button
Applies a preset square fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Current Default Fill button
Applies the current default fill to all selected objects. You can create a default fill by clicking a color well on the 
color palette when no objects are selected or by using the controls on the Shape Properties dialog box.



Linear Fountain Fill
Applies a preset linear fountain fill to all selected objects. Click this button with no objects selected to make this 
the default fill.



Autorouted Line Tool
Draws an Autorouted connecting line between the start and end points you specify.



Autorouted Line Tool
Draws an Autorouted connecting line between the start and end points you specify.



Current Default Fill button
Applies the current default fill to all selected objects. You can create a default fill by clicking a color well on the 
color palette when no objects are selected or by using the controls on the Shape Properties dialog box.



Dashed Outline button
Applies a dashed pattern to all selected lines and shape outlines. Click this button with no objects selected to 
make this the default line and outline style.



Dot-Dot-Dashed Outline button
Applies a dot-dot-dashed pattern to all selected lines and shape outlines. Click this button with no objects 
selected to make this the default line and outline style.



Dashed Outline button
Applies a dashed pattern to all selected lines and shape outlines. Click this button with no objects selected to 
make this the default line and outline style.



Dot-Dot-Dashed Outline button
Applies a dot-dot-dashed pattern to all selected lines and shape outlines. Click this button with no objects 
selected to make this the default line and outline style.





Drawing Window
You can draw anywhere in the Drawing Window, but if your Working page size is the same as the size of the page
you're printing on, only portions of the drawing on the Printable page will appear when you print your drawing.



Title Bar
The title bar displays the name of the current window or toolbar. You can move toolbars or windows by dragging 
their title bars. 
The icons found at the right end of a window title bar can be used to reduce the window to its smallest size, 
maximize it to full screen size, or close the window. 
The icon on a toolbar can be used to close the toolbar. To re-open a toolbar you have closed, click View, Toolbars.



Desktop
The Corel Print Space desktop. Use the commands in the File menu to start a new layout, or open an existing 
one. 



Color Palette
This is an on-screen color palette used for choosing outline and fill colors. You can display the color palette 
anywhere in the CorelDRAW window.

To specify a fill color, click it with the left mouse button.
To specify an outline color, click it with the right mouse button.
Clicking the arrows at the ends of the palette with the left mouse button scrolls the colors one at a time.
Clicking the arrows with the right mouse button scrolls a screen-width of colors.
Clicking the up arrow with the left mouse button enlarges the color palette.
Clicking the No Fill button at the left end of the palette removes the object's fill.



Toolbar
The toolbar contains icons you can click to quickly carry out common operations such as saving, printing, 
importing, exporting, and so on. You can also have Corel Print Space display Tooltips (short pop-up descriptions 
of the toolbar buttons) by enabling the Show Tooltips button in the Options dialog box.
To move a toolbar around the screen, drag it by the edges. To dock a toolbar at the borders of the screen, drag it 
to a border until its outline changes shape.



Toolbar
The toolbar contains icons you can click to quickly carry out common operations such as saving, printing, 
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Flyout menu
Click this menu entry to get a flyout sub-menu.



Right mouse button menu
You can right-click anywhere on the screen and get context-sensitive shortcut menus. These menus contain the 
commands you would most often use in the areas you click.



Window List
A list of open windows. Click one of the entries to switch to a different window.



Radial Fountain Fill button
Applies a preset radial fountain fill to all selected objects. Click this button with no objects selected to make this 
the default fill.



Conical Fountain Fill button
Applies a preset conical fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Square Fountain Fill button
Applies a preset square fountain fill to all selected objects. Click this button with no objects selected to make this
the default fill.



Customizing keyboard shortcuts
Keyboard shortcuts give you quick access to the commands and tools you use most often. For example, pressing 
CTRL+S saves your work, just as clicking File, Save saves your work. By assigning keyboard shortcuts, you 
customize Corel Print Space so that it suits your working style.
In addition to assigning your own shortcuts, you can save and load keyboard shortcut configurations for use with 
particular projects or types of layouts. You can also edit and remove keyboard shortcuts or restore the shortcuts 
to the default configuration.
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To assign a keyboard shortcut to a command
1. Click Tools, Customize.
2. Click the Keyboard tab.
3. In the Commands box, double-click the folder containing the command you want.
4. Click the command.
5. Click the Press New Shortcut Key box.
6. Press the keyboard shortcut you want to assign to the command. Press BACKSPACE if you need to make a 

correction.
Your shortcut can use up to four layers of keystrokes. For example, you activate the key combination 
CTRL+ALT+1,2,3,4 by holding down CTRL and ALT, then pressing the 1,2,3, and 4 keys in succession.

7. Click Assign.
Tip

To resolve accelerator conflicts automatically, enable the Go To Conflict On Assign check box.
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To delete a shortcut
1. Click Tools, Customize.
2. Click the Keyboard tab.
3. In the Commands box, double-click the folder that contains the command you want to delete.
4. Click the command.
5. In the Current shortcut keys box, click the shortcut you want to remove.
6. Click Delete.
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To load a shortcut configuration
1. Click Tools, Customize.
2. Click the Keyboard tab.
3. Click Load.
4. Double-click the Accelerator File you want to load.

{button ,AL(`shortcut_proc;;;;;',0,"Defaultoverview",)} Related Topics



To save a shortcut key configuration
1. Click Tools, Customize.
2. Click the Keyboard tab.
3. Click Save As.
4. Click the Accelerator File in which you want to save your assignments.

To overwrite the default shortcut settings, save your configuration using the filename CDRDEF.ACL. You can 
also use a new name (with the file extension .ACL) for a shortcut key configuration.

5. Click Save.
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To restore the default keyboard shortcut configuration
1. Click Tools, Customize.
2. Click the Keyboard tab.
3. Click Reset All.
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Customizing menus
Corel Print Space’s customization tools let you adjust the menu bar and the menus it contains. For example, you 
can add commands to existing menus or add new menus to the menu bar. You can also remove menu commands
or entire menus. Further, you can change the name or order of menus and the commands they provide to give 
you the easiest access to the functions you use most often.
Note

When you customize menus and menu commands, the online Help topics associated with them do not 
change to reflect your changes.
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To add a command to a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Commands box, double-click the command category folder that contains the command you want to add.
4. Click the command.
5. In the Menu box, double-click the menu to which you want to add the command.
6. Click the command below which you want to add the new command.
7. Click Add.
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To remove a menu command
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, double-click the menu that contains the command you want to remove.
4. Click the command.
5. Click Remove.
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To add a menu command separator
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, double-click the menu to which you want to add a separator.
4. Click the command below which you want to add the separator.
5. Click Separator.
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To remove a menu command separator
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, double-click the menu that contains the separator you want to remove.
4. Click the command separator.
5. Click Remove.
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To add a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, click the menu below which you want to add the new menu.

On the Corel Print Space window, the new menu will appear to the right of this menu.
4. Click Add Menu.
5. Type a name for the menu in the Menu box.
Tip

You can specify a keyboard shortcut for any menu by typing an ampersand (&) before the letter you want 
to use as the shortcut key. Once you've specified a shortcut key, you can then open the menu by pressing ALT+KEY. 
For example, if you want to open the File menu by pressing ALT+E, type Fil&e. The underlined letter in any menu 
name indicates its accelerator key.
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To remove a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, click the menu you want to remove.
4. Click Remove.
Note

You can also use this procedure to remove submenus.
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To move a command towards the top of a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, double-click the menu or submenu that contains the command you want to move.
4. Click the command.
5. Click Move Up until the command occupies the position you want.
Note

You can also use this procedure to move submenus towards the top of a menu.
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To move a command towards the bottom of a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, double-click the menu or submenu that contains the command you want to move.
4. Click the command
5. Click Move Down until the command occupies the position you want.
Note

You can also use this procedure to move submenus towards the bottom of a menu.
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To move a menu left in the menu bar
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, click the menu you want to move.
4. Click Move Up until the menu occupies the position you want.

By moving the menu up in this list, you move it left in the menu bar.
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To move a menu right in the menu bar
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, click the menu you want to move.
4. Click Move Down until the menu occupies the position you want.

By moving the menu down in this list, you move it right in the menu bar.

{button ,AL(`menu_custom_proc;;;;;',0,"Defaultoverview",)} Related Topics



To rename a menu
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, click the menu you want to rename.
4. Click the menu’s name tag.
5. Type the new name.
Tip

You can specify a keyboard shortcut for any menu by typing an ampersand (&) before the letter you want 
to use as the shortcut key. Once you've specified a shortcut key, you can then open the menu by pressing ALT+KEY. 
For example, if you want to open the File menu by pressing ALT+E, type Fil&e. The underlined letter in any menu 
name indicates its accelerator key.
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To rename a menu command
1. Click Tools, Customize.
2. Click the Menu tab.
3. In the Menu box, open the menu that contains the command you want to rename.

To open a menu or submenu, double-click its icon or click once on the plus sign to its left.
4. Click the command.
5. Click the command's name tag.
6. Type the new name.
Tip

As with menus, you can specify a keyboard shortcut for any command by typing an ampersand (&) before 
the letter you want to use as the shortcut key. You can then activate the command by opening the menu and typing
its accelerator key. For example, if you want to activate the Cut command by pressing C, type &Cut. The underlined 
letter in any command name indicates its accelerator key.
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Customizing toolbars
You have complete control over the placement and content of Corel Print Space’s toolbars. With simple mouse 
actions, you can resize or move your toolbars anywhere inside the Corel Print Space main window. You can also 
add, remove, and rearrange toolbar controls (except the toolbox controls and flyouts), or create your own 
toolbars containing the controls you use most often.
You also have some control over Corel Print Space's toolbox and its flyouts. For example, you can move the 
toolbox, copy buttons to other toolbars, or drag copies of the flyouts to create floating or docked toolbars. In 
these ways, the toolbox and its flyouts function like other toolbars. Unlike other toolbars, however, you can't 
remove a button from the toolbox or its flyouts.
Note

When you customize toolbars and toolbar controls, the online Help topics associated with them do not 
change to reflect your changes.
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To add a button to a toolbar
1. Click Tools, Customize.
2. Click the Toolbar tab.
3. In the Command Categories box, click the folder that corresponds to the button you want to add.

Corel Print Space displays the command category's collection of buttons.
4. Drag the button to the desired toolbar.

To cancel the operation, click the right mouse button while you drag.
Note

You can't add a button to the toolbox or to any of its flyouts.
Tips

You can also move a button from one toolbar to another by holding ALT and dragging the button to its new 
position.

You can also copy a button to another toolbar by holding down CTRL+ALT and dragging the button to its 
new position.
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To remove a button from a toolbar
1. Click Tools, Customize.
2. Click the Toolbar tab.
3. Drag the button from its toolbar onto the drawing window.

To cancel the operation, click the right mouse button while you drag.
Note

You can't remove a button from the toolbox or from any of its flyouts.
Tip

You can also remove a button by holding down ALT and dragging the button onto the drawing window.
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To add a new toolbar
1. Click View, Toolbars.
2. Click New.

Corel Print Space adds a new toolbar at the end of the list.
3. Type a name for the new toolbar.

You can now click Customize and begin adding command buttons to your new toolbar.
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To delete a toolbar
1. Click View, Toolbars.
2. Click the name of the toolbar you want to delete.
3. Click Delete.
Note

You can delete only custom toolbars. You can’t delete a built-in toolbar.
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To move a toolbar
1. Point to the border of the toolbar.
2. Drag the toolbar to its new position.

If you drag a toolbar onto the drawing window it becomes a floating toolbar.
Tips

Try this procedure to move the toolbox or any of its flyouts.
Double-click a toolbar’s border to dock and undock it.
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To resize a floating toolbar
1. Move the cursor to the edge of a floating toolbar.
2. Drag the edge until the toolbar is the correct size.

To cancel resizing, click the right mouse button while you drag.
Note

You can't resize a docked toolbar.
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To display an existing toolbar
1. Click View, Toolbars.
2. Enable the check box next to the toolbar you want to display.
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To rename a toolbar
1. Click View, Toolbars.
2. Click the toolbar you want to rename.
3. Click the toolbar's name tag.
4. Type the new name.
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To move a toolbar button
1. Click Tools, Customize.
2. Drag the button to another toolbar, or to another spot on the same toolbar.

To cancel the movement, click the right mouse button while you drag.
Tips

You can also move a button by holding down ALT and dragging the button to its new position.
You can also copy a button to another toolbar by holding down CTRL+ALT and dragging the button to its 

new position.
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To restore the original configuration of a built-in toolbar
1. Click View, Toolbars.
2. Click the toolbar you want to reset.
3. Click Reset.
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Customizing color palettes
As with many of Corel Print Space's other components, manipulating the on-screen color palette couldn't be 
easier. Using simple mouse actions like clicking and dragging, for example, you can display, hide, and move the 
on-screen palette. You can choose to dock the palette at the bottom, top, or side of the Corel Print Space window
or drag it onto the drawing window to create a floating palette.
You can also create custom palettes for which you choose the contents, color, and arrangement. With custom 
palettes, you can also add colors you produce using Corel Print Space's powerful color building tools. Further, you
can have Corel Print Space display color swatches in two- or three-dimensional wells, in small or large swatches, 
and in multiple rows (up to seven). You can also save and load your customizations so you can use them for 
specific projects or types of layouts. In short, you can adjust the palette and its colors to suit any way you want 
to work.
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To move the on-screen palette
1. Point to the palette’s border.
2. Drag the palette to a new position.

If you drag the palette onto the drawing window it becomes a floating palette.
Tip

Double-click a floating palette's title bar to dock it.
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To resize a floating palette
1. Point to one of the palette’s edges.

The cursor changes to a two-directional arrow.
2. Drag until the palette is the size you want.
Tip

Increase the size of a floating palette to see more colors.
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To display color swatches using three-dimensional color wells
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Enable the Use 3D Wells check box.
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To display color swatches using two-dimensional color wells
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Disable the Use 3D Wells check box.
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To display large color swatches
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Enable the Large Swatches check box.
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To display small color swatches
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Disable the Large Swatches check box.
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To display the No Color well
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Enable the Show No Color Well check box.

In the on-screen palette, the No Color well is represented by an "X".
Tip

Display the No Color well to gain quickest access to blank fills and outlines.
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To hide the No Color well
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Disable the Show No Color Well check box.

{button ,AL(`palette_appearance_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display more or fewer colors
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Increase or decrease the value in the Display Rows While Docked box.
Note

You must set a value from one to seven.
Tips

You can also view more colors by clicking the up arrow button at the end of the palette.
You can also resize a floating toolbar to display more colors.
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To delete a color
1. Click File, Color Setup.
2. If the palette you want isn't already displayed, click Palette Options, Open Palette.
3. Double-click the palette you want.
4. Click the color you want to delete.
5. Click Palette Options, Delete Color.

You can also delete a palette color from the Corel Print Space window. Start by clicking the color you want 
to delete. Click the palette's border with the right mouse button, then click Delete Color.
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To rearrange the order of colors on the palette
1. Click File, Color Setup.
2. If the palette you want isn't already displayed, click Palette Options, Open Palette.
3. Double-click the palette you want.
4. Click the color you want to move.
5. Drag and drop it in a new location on the palette.
6. Repeat steps 4 and 5 until you have the palette arrangement you want.
7. Click Palette Options, Save Palette.
Tip

You can also rearrange the palette from the Corel Print Space window. Drag the color you want to move 
and drop it in a new location.
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To change the right mouse button’s palette-related function
1. Click Tools, Customize.
2. Click the Color Palette tab.
3. Enable the Display Pop-Up Menu button to have Corel Print Space display a pop-up menu when you click the 

palette with the right mouse button.
Enable the Set Outline Color button to be able to change outline colors by clicking a color swatch with the right
mouse button.

Tip
If you enable the Set Outline Color button, you can still view the palette's pop-up menu using the right 

mouse button. Try holding the right mouse button on a color swatch or clicking the right mouse button anywhere on
the palette’s border.
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To display a different palette
1. Click View, Color Palette.
2. Click the palette you want to display.
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To save a custom palette
1. In the Color Selector dialog box, click Palette Options, Save.
2. If you haven't saved the custom palette before, type the file name you want. 

You must use the .PAL file name extension.
3. Click Save.
Tips

You can also save changes you make to a custom palette from the Corel Print Space window. Click the 
palette's border with the right mouse button, then click Save.

Click File, Color Setup to open the Color Selector dialog box.
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To save a palette using a new file name
1. In the Color Selector dialog box, click Palette Options, Save As.
2. Type a new file name. You must use the .PAL file name extension.

By default, Corel Print Space saves all palette configurations in the same directory. You can use the controls on
the Save Palette As dialog box to specify a different directory.

3. Click Save.
Tips

You can also save a custom palette to another file from the from the Corel Print Space window. Click the 
palette's border with the right mouse button, then click Save As.

Click File, Color Setup to open the Color Selector dialog box.
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To create a new custom palette
1. Click File, Color Setup.
2. Click Palette Options, New Palette.
3. Type a file name for the new palette. You must use the .PAL file name extension.
4. Click Save.

Corel Print Space automatically displays the new palette. This palette appears blank except for the No Color 
well. Click File, Color Setup to begin adding colors.

Tip
You can also create a new custom palette from the Corel Print Space window. Click the existing palette's 

border with the right mouse button, then click New.
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To open a custom palette
1. Click File, Color Setup.
2. Click Palette Options, Open Palette.
3. Double-click the name of the palette you want to open.
Tip

You can also open a custom palette from the from the Corel Print Space window. Click the palette's border 
with the right mouse button, then click Open.
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Creating and selecting custom colors
Corel Print Space provides powerful controls that let you create custom colors for use in your custom palettes 
and layouts. These controls allow for interactive color creation based on three simple color creation principles
color models, matching palettes, and mixers.

Color model controls let you select colors from eight basic color models RGB, CMY, CMYK, CMYK255, HSB, HLS, YIQ, 
and Grayscale. For each model, you can choose to select colors by dragging visual selector controls or by specifying
exact numerical values.

Matching palettes let you select from a spectrum-wide range of uniform colors. These colors conform to the RGB 
color model. You can select matching palette colors by clicking the mouse or by conducting a color name search.
Mixers provide two ways to create custom colors. Color blending allows you to combine the qualities of four 
colors to produce a range of intermediate colors. You can use the mouse to select any of the intermediate colors 
and adjust them as required by specifying exact numerical values.
Color mixing also allows you to combine the qualities of multiple colors. The Mixing Area resembles an artist’s 
palette on which you apply and mix colors using a brush-like tool. While the Color Blend is limited to four colors 
in the blend, the Mixing Area is unlimited in the number of colors you can use.
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To create a color using a color model
1. Click File, Color Setup.
2. Enable the Color Models button.
3. Choose a color model from the Model list box to display the visual selectors for that model.

You'll find the Visual Selector above the Color Options button.
4. Drag the markers in the Visual Selectors to edit the color. Depending on the color model you use, these 

markers appear as unfilled squares, rectangles, or circles.
You can also set a color precisely using the boxes provided with each color model. These boxes appear to the 
right of the Model list box.

Tips
To add this color to the current palette, click Color Options, Add Color to Palette
The color that you choose is shown in the New Color swatch. In addition to adding this color to the custom 

palette, you can use it directly in both the Mixing Area and in your layout.
To make the New Color the Reference Color, click the Update Reference Color button.
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To create a color using the Color Blend mixer
1. Click File, Color Setup.
2. Enable the Mixers button.
3. Choose Color Blend from the Mode list box.
4. Click a color picker at one of the corners of the blend grid, then click a color on the palette that pops up.
5. Repeat step 4 for each color picker.
6. Click Auto-Blend.
7. Click a color in the blend grid.
Note

You can also define a color by typing values in the color component boxes.
Tips

Click Color Options, Add Color to Palette to add this color to the current palette.
To make the New Color the Reference Color, click the Update Reference Color button.
Click Color Options, Grid Size to change the density of the Color Blend grid.
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To create a color in the Mixing Area
1. Click File, Color Setup.
2. Choose a color from any of the color models, the color blend, the custom palette, or the Mixing Area.
3. Enable the Mixers button.
4. Choose Mixing Area from the Mode list box.
5. Type a percentage value in the Blend box (or adjust the value using the slider).

Use a high value if you want to build up colors gradually. Use a low value if you want to lay down a saturated 
base.

6. Click the Paint Brush button, then click inside the Mixing Area to apply the color.
7. Select another color and repeat steps 5 and 6 (if desired) to create the color you want.
8. Click the Eye Dropper button and click the desired color.

The color you create appears in the New Color swatch.
Note

You can also define a color by typing values in the color component boxes.
Tips

Use the custom palette to collect from the color models or the color matching palettes; you then use those 
colors in the mix. You can also open different custom palettes while you mix colors.

Click Color Options, Add Color to Palette to add this color to the current palette.
To make the New Color the Reference Color, click the Update Reference Color button.
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To select a color from a color matching palette
1. Click File, Color Setup.
2. Enable the Palettes button.
3. Choose the palette you want using the Type list box.
4. Click the scroll bar to display different areas of the palette.
5. Click the color you want to put the color in the New Color swatch.
Note

The color components used to define the color depends on the palette and not the layout.
Tips

Click Color Options, Add Color to Palette to add this color to the current palette.
To make the New Color the Reference Color, click the Update Reference Color button.

{button ,AL(`color_proc;;;;;',0,"Defaultoverview",)} Related Topics



To see the names of palette colors
1. In the Color Selector dialog box, enable the Palettes button.
2. Choose a palette from the Type list box.
3. Click Color Options.
4. Enable the Show Color Names command.

When enabled, a check mark appears to the left of the command.
Tips

To show palette color swatches only, click the Color Options button and disable the Show Color Names 
command.

Click File, Color Setup to open the Color Selector dialog box.
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To search for a palette color by name
1. In the Color Selector dialog box, enable the Palettes button.
2. Choose a palette from the Type list box.
3. Type the name of the color in the Search box.
Tips

Color names consist of two parts: the palette name and the color name or code. You can reduce typing by 
using only the color name or code.

You can search by color name when either the color names or color swatches are displayed.
Click File, Color Setup to open the Color Selector dialog box.
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To change the color model used for blending colors
1. In the Color Selector dialog box, enable the Mixers button.
2. Choose Color Blend from the Mode list box.
3. Click Color Options, Color Model.
4. Click the color model you want.
Note

When you choose a different color model, Corel Print Space maps the colors in all color buttons to their 
corresponding colors. If the Auto-Blend button is depressed, Corel Print Space also automatically blends the colors.

Tip
Click File, Color Setup to open the Color Selector dialog box.

{button ,AL(`color_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the size and type of brush used in the Mixing Area
1. In the Color Selector dialog box, enable the Mixers button.
2. Choose Mixing Area from the Mode list box.
3. Click Color Options, Brush Size.
4. Click the brush size you want.
Note

You can choose a small, medium, or large brush.
Tips

Click Color Options, Clear Bitmap to clear the Mixing Area.
Click File, Color Setup to open the Color Selector dialog box.
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To change the color model used in the Mixing Area
1. In the Color Selector dialog box, enable the Mixers button.
2. Choose Mixing Area from the Mode list box.
3. Click Color Options, Color Model.
4. Click the color model you want.
Tips

If you're creating a library of Mixing Areas, you can organize them according to the color model you use to 
create them.

Click Color Options, Clear Bitmap to clear the Mixing Area.
Click File, Color Setup to open the Color Selector dialog box.
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To save the contents of the color Mixing Area
1. In the Color Selector dialog box, enable the Mixers button.
2. Choose Mixing Area from the Mode list box.
3. Click Color Options, Save Bitmap.
4. Type a filename in the File name field.

If you're saving to an existing file, double-click the file name.
Tips

By using the Save Bitmap and Load Bitmap menu options, you can create Mixing Areas for specific 
applications or projects, and save them to a library of Mixing Areas that you use in the Color dialog box.

Click File, Color Setup to open the Color Selector dialog box.
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To load a color mix
1. Click File, Color Setup.
2. Enable the Mixers button.
3. Choose Mixing Area from the Mode list box.
4. Click Color Options, Load Bitmap.
5. Double-click the file you want.
Note

If you haven't saved the current Mixing Area, you will lose any changes you made when the new Mixing 
Area opens.

Tips
By using the Save Bitmap and Load Bitmap menu options, you can create Mixing Areas for specific 

applications or projects and save them to a library of Mixing Areas.
Click Color Options, Clear Bitmap to clear the Mixing Area.
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To clear the Mixing Area
1. In the Color Selector dialog box, enable the Mixers button.
2. Choose Mixing Area from the Mode list box.
3. Click Color Options, Clear Bitmap.
Note

If you have not saved the current Mixing Area, you will lose any changes you made when the new Mixing 
Area opens.
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To add a color to a custom palette
1. Click File, Color Setup.
2. Use the controls provided to create the color you want.
3. Type a name for the color.
4. Click Color Options, Add Color to Palette.
5. Click Palette Options, Save Palette.
Tip

You do not have to name a color to add it to the custom palette. If you do name a color, however, the 
name must be unique.

Note
When you add a color from one of the color matching palettes, the color name is also used in the custom 

palette.
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To rename a color
1. Click File, Color Setup.
2. Click the color in the custom palette.
3. Type a name for the color in the Name box.
4. Click Palette Options, Save Palette.
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To swap the Reference and New Colors
In the Color Selector dialog box, click Swap Color.
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To display the color palette
1. Click View, Color Palette.
2. Click Custom Colors or Uniform Colors.
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To hide the color palette
1. Click View, Color Palette.
2. Click None.
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To display the status bar
1. Click View.
2. Enable the Status Bar command.

When enabled, the Status Bar command has a check box to its left.
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To hide the status bar
1. Click View.
2. Disable the Status Bar command.

When enabled, the Status Bar command has a check box to its left.
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To enable Tooltips
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Show Tooltips check box.
4. Click Apply.
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To disable Tooltips
1. Click Tools, Options.
2. Click the General tab.
3. Disable the Pop-Up Help check box.
4. Click Apply.
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To enable automatic panning
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Auto-panning check box.
4. Click Apply.
Note

When enabled, Auto-panning forces the Corel Print Space window to scroll as you perform actions in which 
you drag outside the visible portion of the drawing window.
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To disable automatic panning
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Auto-panning check box.
4. Click Apply.
Note

When enabled, Auto-panning forces the Corel Print Space window to scroll as you perform actions in which 
you drag outside the visible portion of the drawing window.
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To set Corel Print Space's start-up mode
1. Click Tools, Options.
2. Click the General tab.
3. Choose a start-up mode from the On start-up list box.
4. Click Apply.
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To have Corel Print Space notify you when you set a tool default
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Notify when setting tool default check box.
4. Click Apply.
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To specify how objects will appear during manipulation
1. Click Tools, Options.
2. Click the Objects tab.
3. Enable the Display as Bounding Box, or Display as Wireframe button.
4. Click Apply.

During manipulation with the mouse, objects appear in the format you selected.
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To set the default unit
1. Click File, Page Setup.
2. Click the Options tab.
3. Choose a unit from the Default Units list box.
4. Click Apply.
Note

The settings you make apply to the current layout only.
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To set the nudge increment
1. Click Tools, Options.
2. Click the Objects tab.
3. Specify the nudge increment in the Nudge box.
4. Click Apply.
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To change the duplicate offset increment
1. Click Tools, Options.
2. Click the Objects tab.
3. Specify values in the Horizontal and Vertical number boxes to indicate how you want Corel Print Space to offset

duplicates.
For example, if you want Corel Print Space to place duplicates 1 unit up and two units to the left, type 1 in the 
Vertical box and -2 in the Horizontal box.

4. Click Apply.
Tip

To see the effect of your settings, select an object and click Edit, Duplicate.
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To set the default working folder
1. Click Tools, Options.
2. Click the General tab.
3. To have Corel Print Space open the last folder used when you save or open a file, enable the Remember Last 

Folder Used button.
To have Corel Print Space open its default folder when you save or open a file, enable the Use default folder all
the time.
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To lock an attribute
1. Using the right mouse button, click the control you used to set the attribute.

If you want to lock a number box control, you must click its text label.
2. Click Toggle Lock.

For example, to prevent changes to the Number of Points setting on the Polygon tab, click the Number of 
Points box with the right mouse button, then click Toggle Lock. 

Notes
You can't change a locked attribute until you unlock it.
The mouse pointer changes to a lock icon when you point to a locked attribute control.
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To unlock an attribute
1. Using the right mouse button, clicked the locked attribute control.

If you want to unlock a number box control, you must click its text label.
2. Click Toggle Lock.
Notes

You can't change this attribute until you unlock it.
The mouse pointer changes to a lock icon when you point to a locked attribute control.
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To change the units displayed with a number box
1. Using the right mouse button, click inside the number box.
2. Click Units, then click the unit you want.

{button ,AL(`lock_proc;;;;;',0,"Defaultoverview",)} Related Topics



Customizing the status bar
The status bar gives you constant, up-to-date information about your layout. You can customize its position, 
appearance, and content so that you have easy access to the information you require to work most efficiently.
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To move the status bar
Click the status bar with the right mouse button, then click Place at Top or Place at Bottom.

Note
You can also drag the status bar to the top or bottom of the window.
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To change the number of status bar display regions
1. Click the status bar with the right mouse button, then click Number of regions.
2. Click the number of regions you want displayed.
Tip

You can have up to six regions displaying different information.
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To change what the status bar displays
1. Point to the status bar display region you want to change.
2. Click the right mouse button, then click Show.
3. Click the type of information you want to display.
Tip

To leave a region blank, click None.
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To resize the status bar
Click the status bar with the right mouse button, then click Large Status Bar or Small Status Bar.
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Distributing objects
Corel Print Space's object distribution controls help meet the need for even spacing. These controls allow you to 
arrange objects so that their left, right, top, or bottom edges are separated by equal intervals. You can also use 
these tools to distribute objects so that they sit an equal distance apart. In all cases, you can specify an exact 
distribution interval or have Corel Print Space distribute the objects automatically.
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To distribute objects horizontally
1. Select the objects.
2. Click Arrange, Align and Distribute.
3. Click the Distribute tab.
4. Enable the Left, Center, Spacing, or Right check box (found over the preview box) to indicate how you want to 

distribute the objects.
For example, if you want to distribute the objects so that their left edges are evenly spaced, enable the Left 
check box. If you enable the Spacing check box, Corel Print Space distributes the objects so that there is equal 
horizontal distance between them.

Note
By default, Corel Print Space distributes the objects within the selection box that surrounds them. To 

distribute objects at a specific interval, enable the Specific Interval check box and specify an interval and unit using 
the Interval boxes.

Tip
Watch the preview box to see how your settings will affect the objects.
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To distribute objects vertically
1. Select the objects.
2. Click Arrange, Align and Distribute.
3. Click the Distribute tab.
4. Enable the Top, Center, Spacing, or Bottom check box (found beside the preview box) to indicate how you want

to distribute the objects.
For example, if you want to distribute the objects so that their bottom edges are evenly spaced, enable the 
Bottom check box. If you enable the Spacing check box, Corel Print Space distributes the objects so that there 
is equal vertical distance between them.

Note
By default, Corel Print Space distributes the objects within the selection box that surrounds them. To 

distribute objects at a specific interval, enable the Specific Interval check box and specify an interval and unit using 
the Interval boxes.

Tip
Watch the preview box to see how your settings will affect the objects.
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To distribute objects horizontally and vertically
1. Select the objects.
2. Click Arrange, Align and Distribute.
3. Click the Distribute tab.
4. Enable the Top, Center, Spacing, or Bottom check box (found beside the preview box) to indicate how you want

to distribute the objects vertically.
5. Enable the Left, Center, Spacing, or Right check box (found over the preview box) to indicate how you want to 

distribute the objects horizontally.
For example, if you want to distribute the objects so that their bottom right corners are evenly spaced, enable 
the Bottom and Right check boxes. If you enable the Spacing check box, Corel Print Space distributes the 
objects so that there is equal distance between them.

Note
By default, Corel Print Space distributes the objects within the selection box that surrounds them. To 

distribute objects at a specific interval, enable the Specific Interval check box and specify an interval and unit using 
the Interval boxes.

Tip
Watch the preview box to see how your settings will affect the objects.
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Drawing shapes and lines
Corel Print Space provides a versatile set of tools that you can use to draw objects of virtually any shape. The 
Freehand, Line, and Curve tools, for example, let you draw anything from lines and curves to your signature. The 
Rectangle, Ellipse, and Polygon tools, on the other hand, let you draw regular shapes. For example, you can 
create a circle with the Ellipse tool or a five-pointed star with the Polygon tool. 
Although Corel Print Space’s drawing tools let you draw a wide variety of objects, you need learn only one set of 
basic skills to use all the tools. In each case, you start by clicking the tool’s button in the toolbox. Once you 
select the tool you want, you position the mouse where you want to start drawing the object. You then use a 
combination of simple mouse actions to draw the shape you want.
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To draw a rectangle
1. Choose the Rectangle tool from the Shape flyout.
2. Position the mouse pointer where you want a corner of the rectangle.
3. Hold down the left mouse button.
4. Drag the mouse diagonally until the rectangle is the size you want.
5. Release the mouse button.
Tips

Hold down SHIFT to draw the rectangle from the center outward.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a square
1. Choose the Rectangle tool from the Shape flyout.
2. Position the mouse pointer where you want a corner of the square.
3. Hold down CTRL and the left mouse button.
4. Drag the mouse diagonally until the square is the size you want.
5. Release the mouse button, then release CTRL.
Note

The CTRL key constrains the movement of the mouse so that you draw a square.
Tips

Hold down CTRL+SHIFT to draw the square from the center outward.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw an ellipse
1. Choose the Ellipse tool from the Shape flyout.
2. Position the mouse pointer where you want a corner of the ellipse's selection box.
3. Hold down the left mouse button.
3. Drag the mouse horizontally until the ellipse has the dimensions you want.
5. Release the mouse button.
Tips

Hold down SHIFT to draw the ellipse from the center outward.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a circle
1. Choose the Ellipse tool from the Shape flyout.
2. Position the mouse pointer where you want a corner of the circle's selection box.
3. Hold down CTRL and the left mouse button.
4. Drag the mouse diagonally until the circle has the dimensions you want.
5. Release the mouse button, then release CTRL.
Note

The CTRL key constrains the movement of the mouse so that you draw a circle.
Tips

Hold down CTRL+SHIFT to draw the circle from the center outward.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a polygon
1. Click the Polygon tool from the Shape flyout.
2. Position the mouse pointer where you want a corner of the polygon's selection box.
3. Hold down the left mouse button.
4. Drag the mouse diagonally until the polygon has the dimensions you want.
5. Release the mouse button.
Tips

Click Format, Polygon to access controls that let you change polygon properties. For example, you can set 
the Polygon tool so that it draws stars.

Hold down SHIFT to draw the polygon from a the center outward.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To change the shape of a polygon
1. Select the polygon you want to edit.
2. Click Format, Polygon.
3. Click the Polygon tab.
4. Enable the Polygon or Star button.
5. Specify the number of points you want.
Tips

Watch the preview box to see how your settings will affect the polygon's appearance.
Enable the Make Default check box to use these settings for each new polygon you draw. You can also 

make default settings by deselecting all objects before you click Format, Polygon.
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To draw a freehand curve
1. Click the Freehand tool from the Line flyout.
2. Position the mouse pointer where you want to start drawing the curve.
3. Hold down the left mouse button.
4. Drag the mouse along the curve you want.
5. Release the mouse button.
Tip

Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a curve
1. Choose the Curve tool from the Line flyout.
2. Click where you want to place the curve's start point.
3. Drag the mouse and click to add additional control points.

Control points act as vertexes that control the shape of the curve.
4. Double-click where you want to end the curve.
Tips

Hold down SHIFT while you drag to constrain the mouse to horizontal and vertical movement only.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a straight line
1. Choose the Line tool from the Line flyout.
2. Click where you want the line to begin.
3. Double-click where you want the line to end.
Tips

Hold down SHIFT while you drag to constrain the mouse to horizontal and vertical movement only.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw connected straight lines
1. Choose the Line tool from the Line flyout.
2. Click where you want the start of the first line segment.
3. Click where you want the segment to end.

This, of course, is the start of the next line segment.
4. Click where you want the next line segment to end.
5. Repeat step 4 to add additional segments.
6. Double-click where you want the line to end.
Tips

Hold down SHIFT while you drag to constrain the mouse to horizontal and vertical movement only.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw connected curves
1. Choose the Freehand or Curve tool from the Line flyout.
2. Position the mouse pointer over the endpoint of the existing curve.
3. Draw the curve you want.
Tips

Hold down SHIFT while you drag to constrain the mouse to horizontal and vertical movement only.
Enable the Snap to Grid command and zoom in to draw more precisely.
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To draw a closed path with the Curve tool
1. Choose the Curve tool from the Line flyout.
2. Draw a series of connected curves.
3. Double-click the start point of the original segment to close the shape.
Tips

You can also draw a closed shape with the Freehand tool.
Enable the Snap to Grid command and zoom in to draw more precisely.
To make joining start and end points easier, increase the AutoJoin sensitivity level using the control on the 

Options dialog box. 
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To draw a closed freehand path
1. Choose the Freehand tool from the Line flyout.
2. Draw a freehand curve.
3. Join the endpoint and start point to close the shape.
Tips

Enable the Snap to Grid command and zoom in to draw more precisely.
To make joining start and end points easier, increase the AutoJoin sensitivity level using the control on the 

Options dialog box. 
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To draw a closed straight-line path
1. Choose the Line tool from the Line flyout.
2. Draw a series of connected straight lines.
3. Double-click the line's start point to close the path.
Tips

Enable the Snap to Grid command and zoom in to draw more precisely.
To make joining start and end points easier, increase the AutoJoin sensitivity level using the control on the 

Options dialog box. 
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To view general file information
1. Click File, Properties.
2. Click the General tab.
Note

To change file attributes, find the file using Windows Explorer, click the file icon with the right mouse 
button, then edit the attributes as required.
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To view file summary information
1. Click File, Properties.
2. Click the Summary tab.
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To view file statistics
1. Click File, Properties.
2. Click the Statistics tab.
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To view custom file properties
1. Click File, Properties.
2. Click the Custom tab.
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To enter file summary information
1. Click File, Properties.
2. Click the Summary tab.
3. Use the boxes provided to specify summary information about the current file.
Note

When you save the file, Corel Print Space also saves the information you specify in this dialog box.
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To enter custom file properties
1. Click File, Properties.
2. Click the Custom tab.
3. In the Name box, type a name for the custom property.
4. In the Type box, choose the type of property you want.
5. In the Value box, type a value for the property.
6. Click Add.
Note

The value you type must correspond to the selection in the Type box. For example, if you chose Text in the 
type box, you must type text in the Value box. If the value doesn't match the selection in the Type box, it is stored 
as text.
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Filling objects
Corel Print Space lets you change the appearance of any shape by using any of several fill types. By filling an 
object, you apply colors or patterns to the area inside its borders. If you leave an object without a fill or remove 
its fill, it appears transparent.
Uniform fills are Corel Print Space's most basic fills. When you apply a uniform fill, you give an object a solid 
color. With pattern fills, on the other hand, you fill an object with a pattern created by tiling a basic item or 
element. The effect is like that you create when you apply wallpaper to a wall. You can use Corel Print Space's 
built-in patterns or create your own custom patterns.
Fountain fills are Corel Print Space's most complex fills, displaying a progression between two colors following a 
linear, radial, conical, or square path. You can customize fountain fills by changing their orientation, intermediate
colors, and center points. You can also adjust the edge pad how much of the fill is taken up by the progression's 
start and end colors.

In all cases, you can apply fills to specific objects or set defaults so that every object you draw has the same fill.
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To apply a uniform fill
1. Select the object you want to fill.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click the Uniform Fill button.
5. Choose a fill color from the color palette provided or click Edit and create a custom color.
Tips

Enable the Set As Default check box to apply this fill to all objects you draw.
Try using the on-screen color palette to apply uniform fills. Select the object, then click a color with the left 

mouse button. To set a default fill color, deselect all objects, then click a color with the left mouse button.
For quick access to preset fills, click the Fill tool.
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To remove an object’s fill
1. Select the object.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click the No Fill button.
Tips

Enable the Set As Default check box apply no fill to all objects you draw.
Click the No Fill well on the on-screen color palette to achieve the same effect. You'll also find a No Fill 

button if you click the Fill Tool. Click either of these controls with no objects selected to use no fill as the default 
setting.
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To apply a fountain fill
1. Select the object you want to fill.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click the Fountain Fill button.
5. Click the button that corresponds to the type of fountain fill you want.

You can choose a Linear, Radial, Conical, or Square fountain fill.
6. Click the topmost color picker, then click a color for the start of the fountain fill's color progression.

Click the Other button to create or select a custom color.
7. Click the bottom color picker, then click a color for the end of the fountain fill's color progression.

Click the Other button to create or select a custom color.
Tips

Watch the preview box to see how your settings will affect the selected objects.
Enable the Set As Default check box to apply this fill to all objects you draw.
Click Edit to customize the fountain fill. You can adjust its orientation, intermediate colors, and center 

points. You can also control how much of the fill is taken up by the progression's start and end colors.
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To apply a pattern fill
1. Select the object you want to fill.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click the Pattern Fill button.
5. Click the pattern picker, then click the pattern you want.
6. Click the topmost color picker, then click a color for the pattern's foreground.

Click the Other button to create or select a custom color.
7. Click the bottom color picker, then click a color for the pattern's background.

Click the Other button to create or select a custom color.
Tips

Watch the preview box to see how your settings will affect the selected objects.
Enable the Set As Default check box to apply this fill to all objects you draw.
Use the Tile Size controls if you want to change the dimensions of the pattern tile used to fill the object. By 

decreasing the size of a pattern tile, you increase the pattern's density.
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To change the density of a pattern fill
1. Select the object with the pattern fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click the Pattern Fill button.
5. Type percentage values in the Horizontal and Vertical boxes to scale the tile's dimensions.
Tip

To increase the pattern's density, type smaller percentage values. This, in turn, decreases the pattern's tile
size.
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To change the orientation of a fountain fill
1. Select the object with the fountain fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click Edit.
5. Adjust the Horizontal Center Offset settings until the fill's center has the horizontal position you want.

A value of -50% places the center at the left edge of your object; a value of 50% places the center at the right 
edge.

6. Adjust the Vertical Center Offset settings until the fill's has the vertical position you want.
A value of -50% places the center at the bottom edge of your object; a value of 50% places the center at the 
top edge.

7. Adjust the Angle setting until the fill has the rotation angle you want. Positive values rotate the fill counter-
clockwise, negative values rotate it clockwise.

Notes
You cannot adjust the center offset for linear fountain fills.
You cannot adjust the angle of a radial fountain fill.

Tip
Enable the Set As Default check box on the Symbol Properties dialog box to apply these settings to all new 

objects you add.
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To adjust the quality of a fountain fill
1. Select the object with the fountain fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
3. Click Edit.
4. Increase or decrease the Steps setting.

Higher values result in higher printing quality, while lower values result in higher printing speed.
Notes

The Steps controls are available only if you are printing to a PostScript printer.
You can lock your Steps settings by clicking the Lock icon that appears to the right of the Steps number 

box. Depress the button to unlock the settings.
Tip

Enable the Set As Default check box on the Symbol Properties dialog box to apply these settings to all new 
objects you add.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the edge pad for a fountain fill
1. Select the object with the fountain fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click Edit.
5. Adjust the value in the Edge Pad box to increase the percentage of start and end colors used to fill the object.

Higher values result in an even split between the two colors. Lower values result in a smooth transformation 
between the two colors.

Note
The Edge Pad option is not available for conical fills.

Tip
Enable the Set As Default check box on the Symbol Properties dialog box to apply these settings to all new 

objects you add.
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To adjust the intermediate colors in a fountain fill
1. Select the object with the fountain fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click Edit.
5. Click one of the direction buttons.

The line, counterclockwise, and clockwise buttons control how the fill's color blend moves through the 
spectrum. The black line in the color wheel display shows the direction of the path.

Tips
Use the color pickers provided to change the fill's start and end colors.
Watch the preview box in the top-right corner of the dialog box to see how your settings will affect the fill's 

appearance.
Enable the Set As Default check box on the Symbol Properties dialog box to apply these settings to all new 

objects you add.
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To change the midpoint of a fountain fill
1. Select the object with the fountain fill you want to edit.
2. Click Format, Symbol.
3. Click the Fill tab.
4. Click Edit.
5. Drag the Midpoint slider to change the start and end color proportions.

Higher values create a narrow, focused mid-point. Lower values create a wide, unfocussed mid-point.
Tip

You can also adjust the midpoint by typing a specific value in the Midpoint box. You must specify a value 
from 1 to 99.

{button ,AL(`fountain_proc;;;;;',0,"Defaultoverview",)} Related Topics



To copy fill attributes from one object to another
1. Hold down the right mouse button on the object with the fill you want to copy.
2. Drag the object over the object to which you want to copy the fill.
3. Release the mouse button, then click Copy Fill.
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To copy all attributes from one object to another
1. Hold down the right mouse button on the object with the attributes you want to copy.
2. Drag the object over the object to which you want to copy its attributes
3. Release the mouse button, then click Copy All Attributes.
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Printing



Printing your work
Size
What size will the final product be? Set up your artwork to those dimensions and work in “actual size” to avoid 
the problems inherent to resizing images (e.g., bitmap reproduction suffers when bitmaps are enlarged). If you 
wish to print the same material at different sizes, however, you may resize your image when you print.
The paper size and the working page size will not necessarily be the same. For instance, you can fit two pages 
that are 8.5 by 11 inches on one 11 by 17 inch piece of paper.
Orientation
What page orientation best accommodates your work? Portrait (vertical) or landscape (horizontal)? The 
orientation you choose when you print should match the orientation of the artwork.
Bleed
Must certain areas of your artwork extend to the edge of the final page? Then, you must allow for a "bleed", that 
is, ensure your artwork "overflows" the edge of your final page. To accomplish this you must print your work on 
paper that is larger than the paper size you ultimately want. This paper is then trimmed to the appropriate size. 
A bleed of .125 to .25 inches is usually sufficient. Any object extending beyond that needlessly uses up memory 
and may cause problems when you are printing more than one final page on a single sheet of paper.
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Printing text and graphics
Fonts
Make sure the typefaces and point sizes you choose are suitable for the paper stock you will be printing on. For 
example, delicate typefaces or small point sizes may not reproduce well on textured papers, or they may be 
difficult to read on colored or speckled paper.
Fills
Use fills judiciously; avoid complex fills ( e.g., fountain fills) on small objects that aren't big enough to warrant 
intricate details. If you are using a Level 1 PostScript device avoid complex fills with complex outlines and 
complex fills in text objects. When you set the postscript options you can enable tests that will warn you if there 
are any potential problems with your fills.
If you use fountain fills, be aware that too many steps may cause errors or slow down printing, and too few steps
may cause banding (the appearance of strips across a fountain fill). You can optimize your fountain fills when you
set the PostScript options.
Lean and clean
Keep file size manageable by deleting all unnecessary elements. Get rid of redundant objects hidden behind 
other objects, and any leftover objects outside the working page.
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PostScript
What is it?
PostScript is a page description language used to send instructions to a PostScript device about how to print 
each page. All the objects in a print job (e.g., curves and fills) are represented by lines of PostScript code that the
printer uses to produce your work.
PostScript is not the only method for sending a printer instructions, and some printers are not compatible with 
PostScript; however, there are several functions that are unavailable if you are not using the PostScript printer 
language. For example, without PostScript, you cannot adjust color separations and halftone screens.
There are two levels of PostScript available. PostScript level 2 is the most recent version of PostScript and it is 
more powerful than its predecessor, PostScript level 1.
Tip

When purchasing a printer or choosing a service bureau you should find out which type of PostScript you 
will be using. Where you have a choice, choose level 2.

Limitations of PostScript level 1
There are certain problems that may arise when you are using PostScript level 1 that have been largely 
eliminated in level 2.

To create curves, a PostScript device prints a series of short straight lines at varying angles. Each of these 
lines is a segment. Also, any straight line is a segment. Level 1 devices can't print Corel Draw objects with more 
than 1500 segments. This limits the allowable complexity of an object.

If you use a complex fill in an object, the allowable complexity is reduced further.
If you fill a text object with a texture fill then a level 1 PostScript may not be able to print it.

There are several ways around these limitations.
Wherever possible, break complex objects up into several less complex objects. This may not be possible if

you are using complicated line attributes or complex fills.
Use the PostScript features designed to reduce complexity (click How to for a list of help topics about how 

to use these features).
Note

If you are printing to a level 1 PostScript device, you should try to avoid including any of the problematic 
objects mentioned above into your design.
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Printing



Specifying what to print



To print a document
1. Click File, Print.
2. Choose All.
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To print only selected objects
1. Select the objects to print.
2. Click File, Print.
3. Choose Selection.

{button ,AL(`Specifying_what_to_print;',0,"Defaultoverview",)} Related Topics



To print only vectors, bitmaps or text
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Enable Vectors, Bitmaps, Text, or a combination of these.
5. (Optional) Enable Print All Text In Black if you want to print text in black instead of in color.
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To print only certain layers

1. Click Layout, Layers Roll-Up.
2. Enable or disable the Printable option for each layer, as required.
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To print the sheet being previewed
1. Point to the Preview box.
2. Click the right mouse button, click Print This Sheet Now.
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To print a CorelMEMO

1. Select the memo you want to print.
2. Click Edit, Note object, Open.
3. Click File, Print from inside the Memo window.
4. Choose a printing device.
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Setting up the print job



To select a device
1. Click File, Print.
2. Choose a printer or image setter from the Name list box. If the device driver you need is not listed, install it 

following the usual Windows procedure.
Tips

If you're proofing or printing a job in-house, choose the driver for your local device.
If you're sending a file to a service bureau, choose the device driver that's specified by the service bureau.
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To set the device properties
1. Click File, Print.
2. Click Properties.
3. If printing to a PostScript device, set only the Page Size, Orientation, Tray, and Resolution here. Leave all other 

options at their default and set them from Print options instead.
or
If printing to a non-PostScript device, set all relevant options here.

Note
As these are Windows-controlled options, see your Windows documentation for more information.

Tips
To verify the extent of the unprintable area for the selected device, click Unprintable Area.
To print on both sides of the page (duplex printing), click More Options.
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To print to file
1. Click File, Print.
2. Enable Print to File.
3. Enable For Mac if your print file is being sent to a service bureau with Macintosh equipment.

PostScript files created using the Print to File option contain two Control-D (^D) characters that prevent them 
from printing on any PostScript device controlled by Macintosh computers. Enabling the For Mac option 
removes the ^D characters from the files.

4. Click OK.
5. Type a filename and choose a destination. The appropriate extension (.PRN) will be appended to your filename.
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To print color artwork in black or grayscale
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click All Colors As Black or All Colors As Grayscale.
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To print multiple copies
1. Click File, Print.
2. Type the number of copies you need in the Number of copies number box.

{button ,AL(`Setting_up_the_print_job;',0,"Defaultoverview",)} Related Topics



Previewing your print job



To preview your print job
Click File, Print Preview.

Note
You can also preview your print job by clicking the Print Preview button in the Print dialog box.
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To specify a color or grayscale print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Preview In Color to specify a color preview. Disable this option to specify a

grayscale preview.
Tip

Displaying individual color separations in grayscale instead of color can be helpful when you are 
attempting to study color distribution. Yellow in particular can be difficult to discern against a white background. 
Even magenta and cyan, if sparse, can be easier to discern when displayed in grayscale.
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To specify full image or marquee drag in print preview
1. Point to the Preview box.
2. Click the right mouse button. Enable Full Image Drag to keep the image visible while it is being repositioned. 

Disable this option to change the image to a marquee box while it is being repositioned.
Tip

The default is Full Image Drag. To make the default drag marquee, click the Options tab, and in Special 
Settings, and choose Print Preview Drag Mode. Change the setting to Drag Marquee.
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Setting up your artwork



Sizing and Positioning your artwork



To size your artwork when printing
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Layout tab.
4. (Optional) Enable (or disable) Maintain Aspect.
5. Assign the height and width values in the unit of measurement you want

or
Drag the handles in the Preview box.

Notes
You can only size your artwork this way when you are using the Full Page layout style with no rows or 

columns, or when you are using the Manual layout style.
If you enabled Maintain Aspect, you can only resize the image proportionally.
This option does not affect the artwork itself, only the way it is printed.
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To fit your artwork to the page when printing
1. Click File, Print Preview.
2. Click the Print Options button. 
3. Click the Layout tab.
4. (Optional) Enable (or disable) Maintain aspect ratio.
5. Click Fit to Page.
Notes

Your artwork is automatically scaled (up or down) so that it fits the printable page. Your image will be 
distorted if you do not enable Maintain Aspect.

This option does not affect the artwork itself, only the way it is printed.
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To maintain the aspect ratio of your artwork when sizing
1. Click File, Print Preview.
2. Click the Print Options button. 
3. Click the Layout tab.
4. Enable Maintain aspect ratio.
Notes

This is the default setting.
This option does not affect your artwork. When you are finished printing you will still be able to change the 

aspect ratio of your work.
Tip

The height and width ratio of an image is known as its "aspect". If you are resizing or scaling your artwork 
using the print preview, it is a good idea to enable Maintain Aspect to prevent image distortion.
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To position your artwork manually for printing
1. Click File, Print Preview.
2. Click the Print Options button. 
3. Click the Layout tab.
4. Change the Top value (distance from the top of the printable area) and the Left value (distance from the left 

side of the printable area).
or
Drag the graphic in the Preview box.

Notes
This option does not affect the artwork itself, only the way it is printed.
If you select the Manual Layout style, you can place several working pages on a single printable page. 

Each of these pages can be sized and positioned individually. You can also use the Clone Page option to place 
several copies of the same working page on a single sheet of paper.
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To center your artwork for printing
1. Click File, Print Preview.
2. Click the Print Options button. 
3. Click the Layout tab.
4. Enable Center image.
Note

This option does not affect the artwork itself, only the way it is printed.
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Setting up the page



To set a bleed limit
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Layout tab.
4. Enable Bleed Limit.
6. Enter a bleed limit value. This value represents the distance the artwork will be allowed to bleed beyond the 

crop marks (i.e. the edge of final paper size).
Note

This setting has no effect unless the working page size is smaller than the printable page and your artwork
extends beyond the edge of the working page (see Page layout (and printing) in related topics).

Consult your service bureau or printing shop to determine the appropriate bleed limit for your job. 
Excessive bleeds waste film and may cause other problems.
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To print large artwork as tiles
1. Click File, Print Preview.
2. Click the Print Options button. 
3. Click the Layout tab.
4. Enable Print tiled pages.
5. Indicate by how much you want the tiles to overlap. Enter a value (e.g., a quarter of an inch) or a percentage 

of the page size.
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Working with PostScript devices



To use PostScript Level 2
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Use PostScript Level 2 Features.
Note
This option is only available to Level 2 PostScript devices. If you are not certain whether you will be printing on a 
Level 2 PostScript device, DO NOT enable this option.
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Controlling complex objects



To test for complex objects
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Complex Objects Warnings.
Note

This option is available to PostScript devices only.
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To reduce curve complexity by increasing flatness
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Increase the flatness value manually.

or
Enable Auto Increase Flatness.

Notes
If you enable Auto Increase Flatness, the printer increases the flatness of curves in each object which is too

complex by increments of 2. If the object is still too complex when the flatness value exceeds the value in the Set 
Flatness To box by 10, the printer will skip the problematic object and go on to the next object. With this option 
enabled, the PostScript program is far less likely to cause errors on complex printing jobs.

If the printer skips an object because Auto increase flatness is enabled then the object will NOT appear in 
the final output. You will not be informed that this has happened while you print. The problem will only become 
evident when the print job is imaged to paper or film. Therefore it is important to inspect proofs before your job is 
printed.

This option is available to PostScript devices only.
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To reduce curve complexity by limiting control points
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enter a value for Maximum points per curve.
Notes

Reducing this number helps alleviate printing problems caused by objects that are too complex. A lower 
number of points per curve will not reduce quality but it will increase printing time.

This option is available to PostScript devices only.
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Controlling fountain fills



To verify fountain fills for banding
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Banded fountain fill warnings.
Notes

This warning only applies to linear fountain fills.
This option is available to PostScript devices only.
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To increase fountain steps automatically
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Auto increase fountain steps.
Notes

This option will increase the number of steps that are used to render fountain fills to avoid banding (the 
appearance of discreet strips in a fountain fill). This may increase printing time, but it will ensure the best possible 
rendering of fountain fills.

This option is available to PostScript devices only.
Tip

You can enable both Auto increase fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.

{button ,AL(`Controlling_fountain_fills;',0,"Defaultoverview",)} Related Topics



To optimize fountain fills to reduce complexity
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Optimize fountain fills.
Note

This option is available to PostScript devices only.
Tip

You can enable both Auto increase Fountain steps and Optimize Fountain Fills. Fountain steps will be 
increased in fountain fills that require more steps and fountain steps will be reduced in fountain fills that have too 
many.
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Controlling fonts



To download type 1 fonts
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Click Download Type 1 Fonts.
Notes

If you enable the Download Type 1 Fonts , by default Convert True Type to Type 1 is also enabled. This 
ensures that True Type fonts are converted to Type 1 fonts so that they can be downloaded. Only disable this option 
if your output device has difficulty interpreting the Type 1 fonts.

This option is available to PostScript devices only.
Tip

Generally, you will want to leave this option enabled and let the driver download the Type 1 fonts to the 
output device. If you disable this option, fonts are output as graphics (either curves or bitmaps). This may be useful 
if the file contains a large number of fonts that would take an unacceptably long time to download, or not download 
at all, because of sheer size.
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To limit the number of bitmap fonts created
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Font Limit.
5. Enter a number between 0 and 250.
Notes

This option applies to text that will be printed on a PostScript printer.
If the font used meets certain criteria, a bitmap version of the font is created in the printer's memory. 

Bitmap character descriptions are used because they look better at small point sizes and they print faster than the 
normal character outline descriptions. The fonts created in this way consume a large amount of PostScript memory. 
As a result, you may need to limit the number of such fonts created to avoid a PostScript error when you are 
printing.

The following criteria must be met for a bitmap version of the font to be created in printer memory:
The printed character size is no larger than 75 pixels. This corresponds to a point size of 18 at 300 dpi, 9 

points at 600 dpi, and so on.
The text is not scaled or skewed.
The text does not have an outline or a fill other than a uniform fill.
The text does not have any envelopes (non-linear transformations) applied to it.
The drawing is not being printed using the Sizing options or Fit To Page option in the Print Options dialog 

box.
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To set a bitmap font size threshold
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From Special Settings choose Bitmap Font Size Threshold.
5. Enter a number between 0 and 1000. This value represents the bitmap height in pixels.
Notes

The value set here determines if a Bitmap representation of the font can be created by the printer if the 
specific font is not loaded on the printer. The value represents the bitmap height in pixels. The higher the value, the
bigger the bitmaps. If a bitmap cannot be created, the text can be sent to the printer as curves.

This option applies to text that will be printed on a Postscript printer.
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Controlling bitmaps



To control bitmap conversion to grayscale
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From the Special Settings group box, choose Color Bitmap Output.
5. Choose Send Color Bitmaps As Grayscale or Send Color Bitmaps As Color.
Notes

The default setting calls for color bitmaps to be reduced to grayscale if they are going to a grayscale 
device. Transmission time is much faster this way and the file size is smaller. If you switch this setting to Send As 
Color the device will do the conversion which results in slower transmission and a larger file size.

This option is available to PostScript devices only.
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To output color bitmaps in RGB
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Click PostScript Preferences.
5. Enable Output Color Bitmaps in RGB.
Note

This option is available to PostScript devices only. 
Tip

PostScript output normally uses the CMYK color model. If outputting color bitmaps to an RGB or CMY 
device, enable the Output Color Bitmaps in RGB option. RGB devices will then receive ready-to-use RGB values 
(instead of CMYK). CMY devices will have an easier time translating RGB to CMY (3-color model to 3-color model) 
than CMYK to CMY (4-color model to 3-color model).
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To set the halftone screen frequency
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Choose a screen frequency, expressed in lines per inch (lpi). Check with your service bureau for the optimum 

setting for your job.
Notes

When the screen frequency is set to Default, your artwork is printed using the default screen frequency of 
the output device.

If you are using the Advanced settings, found on the Separations page in the Print Options dialog box, set 
the screen frequencies for each color separation here. These settings override the settings on the Options page.

This option is available to PostScript devices only.

{button ,AL(`Controlling_bitmaps;',0,"Defaultoverview",)} Related Topics



Setting advanced options



To specify fountain steps
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Specify the number of steps to be used when rendering fountain fills.
Notes

Fountain steps set from the Options dialog box only affect the way fountain fills display on your monitor. To 
control how they actually print, you must set the fountain steps on the Print Options page.

A low value will print faster but the transition between shades may be rather coarse, causing what is 
known as "banding". A higher value will result in a smoother blend but the printing times will be longer.

Tip
You can assign a custom fountain fill to one particular object. Select the object and 'open' the lock in the 

Fountain Fill dialog box (if the lock is closed then the number box is grayed out). Objects that are locked will print 
according to the number of steps assigned in the Print facilities. For example, you might want to set a high number 
of fountain steps for the one or two big objects in your drawing and leave the smaller items locked into the printer 
settings to be printed at a smaller step setting.
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To print a job information sheet
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Enable Print job information sheet.
5. (Optional) To customize this report, click Info Settings and indicate which categories of information are to be 

included. Also specify whether the job information is to be saved to a file or printed or both.
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To define special settings
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. Choose an option from the Special Settings group box.
5. Choose a new setting for it.
Notes

In previous versions of Corel products, these options were only changed by editing the CORELPRN.INI file. 
This new feature in the Print Options dialog box allows you to customize these options directly from the Corel 
program.

This is a list of all of the special settings:
Bitmap Font Limit (PostScript only)
Bitmap Font Size Threshold (PostScript only)
Composite Crop Marks (PostScript only)
Conform to DSC (PostScript only) 
Grayscale Driver Bitmap Output (PostScript only) 

Overprint Black Threshold (PostScript only)
Postscript 2 Stroke Adjust (PostScript only)
Registration Mark Type (PostScript only)
Bitmap Printing
Drive Banding
Fill Clipping
Page Orientation Warning
Preview Image Default
Print Preview Drag Mode
Text Output Method
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To print bitmaps in small chunks
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From the Special Settings group box, choose Bitmap Printing.
5. Choose Output In 64K Chunks.
Note

This switch determines whether bitmaps are sent to non-PostScript printers all at once or in smaller blocks 
(below 64K). Usually, the driver tells the application which method it can or cannot handle. If you find that bitmaps 
do not print as expected, try forcing bitmaps to be output in a number of smaller blocks.
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To assign control over printer bands
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From the Special Settings group box, choose Driver Banding.
5. Choose Let Driver Handle Banding (the printer driver creates the bands) or Send Bands to Driver (the Corel 

application splits the print job into bands before sending it to the printer driver).
Note

This option applies to non-PostScript printers only.
Tip

Some printers can't hold a full page in memory; therefore they must print the page in multiple passes, or 
"bands". The default setting lets the driver split the page into bands before sending them to the printer. If this 
proves too slow, or you encounter problems, request that Corel send the page to the driver already split into bands.
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To assign control over fill clipping
1. Click File, Print Preview.
2. Click the Print Options button.
3. Click the Options tab.
4. From the Special Settings group box, choose Fill Clipping.
5. Choose Use Driver Clipping For Fills or Use Software Clipping For Fills.
Note

This option applies to non-PostScript printers only.
Tip

Any fill other than Uniform fill requires clipping if the object is not rectangular. The default setting is 
clipping controlled by the driver, because that usually means faster processing. If you encounter a problem printing 
non-Uniform fills, switch to clipping controlled by the software.
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The printer icon is in the second column from the left. When it is not grayed out (as in the fourth row), the layer 
will print.



The Enlarge Print Preview button allows you to switch from a regular to a full-screen print preview and back 
again.



These two arrow buttons allow you flip through the pages of your document. They are located at the lower-right 
corner of the Preview box.



The File Information button allows you to print the filename, current date, and time (and tile number, if 
applicable) at the bottom of the sheet.
If applicable, color separation information (color, screen frequency and angle, plate number) is printed at the top
of the sheet.



The Crop Mark button allows you to print crop marks. These marks are used as alignment aids when trimming 
the printed output down to its final size.



The Registration mark button allows you to print registration marks on each sheet. These marks serve as guides 
for aligning color separations.



The Page Number button allows you to place page numbers on the printed sheets.



The Calibration bar button allows you to print a bar of the six basic colors (red, green, blue; cyan, magenta, 
yellow) beside your artwork. These color patches are used to verify the quality of the printed output.



The Densitometer Scale button allows you to print a Densitometer Scale, a bar of varying shades of gray, on 
each separation sheet. This is an advanced feature that allows you to check the accuracy, quality, and 
consistency of the output with an instrument called a densitometer.



The Negative button allows you to print a negative image.



The Emulsion Down button allows you to specify that the film emulsion faces down.



The Print options button opens the Print Options dialog box.



Print dialog box
The Print dialog box allows you to set basic print settings, to set more complex print settings, and to print. Use 
the dialog box to indicate:

which device driver to use
whether to print to the device or to a file instead
which objects to print
how many copies you require
whether to collate the pages

You can also choose the following:
To change or to review your printer settings
To print using the settings you have chosen
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Print Options dialog box
The Print Options dialog box allows you to set more complex parameters.
Layout page
Use Layout page options to position and size your artwork.
Options page
Use the Options page to set various advanced options.
The Fountain steps option allows you to specify how many steps your linear fountain fills will contain when 
printed.
The Screen frequency option allows you to specify what halftone screen frequency you will use.
The PostScript Preferences button allows you to change your PostScript settings if you are using a PostScript 
device driver.
The Proofing options allow you to specify specific types of objects to print (e.g., text only). They also allows you 
to print colors as black or grayscale, to print text as black.
The Print job information sheet option prints a report with information about your print job. Use the Info Settings 
to customize the information sheet.
The Special settings option allows you to change settings that were previously edited in CORELPRN.INI.
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Print Job Information dialog box
The Print Job Information dialog box allows you to specify what type of information you want included in the print
job report. You can direct the report to a printer or text file or both.
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PostScript Preferences dialog box
The PostScript Preferences dialog box allows you to set advanced PostScript options. You can optimize object 
outlines and fills for printing, and control the way your PostScript driver handles fonts and bitmaps.
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Print Setup dialog box
The Print Setup dialog box allows you to select a device driver. Click Properties to change or review your printer 
settings.
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Formatting lines
When you format a line, you give it a new appearance by changing specific attributes. Corel Print Space's line 
formatting tools give you the power to format lines virtually any way you want. To this end, these tools let you 
set default line attributes or change the appearance of existing lines. You can use these tools to choose specific 
line types, widths, and colors or add arrowheads to improve your layout's effectiveness. You can even change 
straight lines to curves (or vice versa) in one simple step.
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To change the width of a line
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. Type a new line width in the Pen Width box.
Tips

To apply these settings to all new lines, enable the Set as default check box.
To choose a preset line width, click the Outline tool, then click the width you want.
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To redraw a line using a different line style
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. Choose a line style from the Line Style list box.
Tips

To apply these settings to all new lines, enable the Set as default check box.
For quicker access to preset outline styles, click the Outline tool to display its flyout menu.
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To change the color of a line
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. Click the Color picker, then click the color you want. If you want to create or select a custom color, click Other.
Tips

To apply these settings to all new lines, enable the Set as default check box.
Use the on-screen color palette to change a line's color more quickly. Select the line, then click the color 

you want with the right mouse button.
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To convert straight lines to curves
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. Choose Curved from the Type list box.
Note

You can only convert multi-segmented lines to curves.
Tip

To apply these settings to all new lines, enable the Set as default check box.
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To change curves to straight lines
1. Select the curve you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. Choose Straight from the Type list box.
Tip

To apply these settings to all new lines, enable the Set as default check box.
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To change a line’s arrowheads
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Arrows tab.
4. Choose the start, center, and end arrowheads using the arrow pickers provided.
Tips

To have an arrow point the other way, enable its Reverse check box.
To apply these settings to all new lines, enable the Set as default check box.
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To add arrowheads at every point in a multi-segmented line
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Arrows tab.
4. Choose the arrowhead you want using the Repeating Arrow picker.
Tips

To have the arrows point the other way, enable the Reverse check box.
To apply these settings to all new lines, enable the Set as default check box.
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To round the bends in a line
1. Select the line you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. In the Corners box, click the button that corresponds to the corner radius you want.

To specify a precise corner radius, type a value in the box provided.
Tip

To apply these settings to all new lines, enable the Set as default check box.
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To copy a line's attributes to another line
1. Hold down the right mouse button on the line with the attributes you want to copy.
2. Drag the line over the line to which you want to copy the attributes.
3. Release the mouse button, then click Copy Outline.
Tip

You can also use this procedure to copy the line's attributes to an object's outline.
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To delete a line node
1. Marquee select the node you want to delete.
2. Using the right mouse button, click the node, then click Delete.
Note

By deleting a node, you also delete any line segments it starts or ends.
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To add a node to a line
1. Marquee select the line segment to which you want to add a line.
2. Using the right mouse button, click the line, then Click Insert Nodes.

Corel Print Space inserts a node at the middle of the line segment. By dragging this node, you can change the 
shape of the line.

Note
To add nodes to all segments in a multi-segmented line, click the line with the right mouse button, then 

click Insert Nodes.
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To join line nodes to create a closed path
1. Marquee select the two line nodes you want to join.
2. Using the right mouse button, click one of the nodes, then click Join Nodes.

Corel Print Space joins the two nodes to create a closed path.
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Formatting object outlines
Every object you create has outlines. Corel Print Space's object formatting tools give you the power to change 
these outlines in virtually any way you want. You can use these tools to choose specific outline types, widths, 
and colors. In addition, you can apply these formats to a particular object or to all objects you add to your layout.
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To change an object's outline width
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Type a new outline width in the Pen Width box.
Tips

Enable the Set as default check box to apply these settings to all new objects.
To choose a preset outline width, click the Outline tool, then click the width you want.
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To redraw an object using a solid, dashed, or dotted outline
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Choose a line style from the Line Style list box.
Tips

To apply these settings to all new objects, enable the Set as default check box.
For quicker access to preset outline styles, click the Outline tool.
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To change an object's outline color
1. Select the object.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Click the Color picker, then click the color you want. If you want to create or select a custom color, click Other.
Tips

To apply your settings to all new objects, enable the Set as default check box.
Use the on-screen color palette to change an object's outline color more quickly. Select the object, then 

click the color you want with the right mouse button.
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To change an object's corner radius
1. Select the object you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. In the Corners box, click the button that corresponds to the corner radius you want.

To specify a precise corner radius, type a value in the box provided.
Tip

To apply these settings to all new objects, enable the Set as default check box.
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To copy outline attributes from one object to another
1. Hold down the right mouse button on the object with the attributes you want to copy.
2. Drag the object over the object to which you want to copy the attributes.
3. Release the mouse button, then click Copy Outline.
Tip

You can also use this procedure to copy the object's outline attributes to a line.
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Applying shadow effects
By applying a shadow effect to an object, you give it a three-dimensional appearance. Corel Print Space lets you 
apply simple or complex shadows to any object in any layout. You can also choose to set a default shadow that 
applies to all new objects. In all cases, you control the direction and offset of the shadow as well as its fill and 
outline attributes. You can even apply multiple shadows to an object to enhance the three-dimensional effect.
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To set the direction of an object's shadow
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Enable the Direction button that corresponds to the direction you want.
Tips

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply multiple shadows to an object
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Type the number of shadows you want in the Number box.
Tips

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.

{button ,AL(`shadow_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the shadow offset
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Specify a new offset value and unit using the boxes provided.
Tips

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To set a shadow's outline color
1. Choose the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Outline picker, then click the color you want.

Click the Other button to create or select a custom color.
Tips

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply a shadow with a uniform fill
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Uniform Fill button.
6. Click the color picker, then choose the color you want.

Click the Other button to create or select a custom color.
Tips

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply a shadow with a fountain fill
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Fountain Fill button.
6. Click the button that corresponds to the type of fountain fill you want.
7. Use the color pickers to choose the fill's start and end colors or click the Edit button to create a custom 

fountain fill.
Click the Other button to create or select custom colors.

Tips
To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply a shadow with a pattern fill
1. Select the object you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Pattern Fill button.
6. Click the Pattern picker, then click the pattern you want.
7. Click the topmost color picker, then click a color for the pattern's foreground.

Click the Other button to create or select a custom color.
8. Click the bottom color picker, then click a color for the pattern's background.

Click the Other button to create or select a custom color.
Tip

To apply your settings to all new objects, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To change the way you resize objects
1. Select the object.
2. Click File, Page Setup.
3. Click the Options tab.
4. If you want to have the object's center point stationary when you resize it with the mouse, enable the From 

center button.
If you want to have the object stretch in one direction only when you resize it with the mouse, enable the From
edges button.

Note
This setting applies to all objects in the current layout.
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Grouping and ungrouping objects
Corel Print Space’s Group command lets you bind objects together and manipulate them as a single unit. You'll 
find this command particularly effective for protecting and maintaining connections between objects and lines. 
For example, you can group all the objects in a flowchart and move them without disturbing their relative 
positioning. If you want to separate a group, you can do so using the Ungroup command.
Notes

If you group objects on different layers, they maintain settings applied to their respective layers
for example, whether printing or editing are enabled or disabled.

You can enter text in an individual object once it has been grouped with other objects. A text entry in a 
grouped object is bound by its borders.
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To group objects
1. Select the objects.
2. Click Arrange, Group.

You can now manipulate the objects as a single unit.
Notes

You can also group a series of groups to create nested groups.
You can group objects on different layers. However, each object maintains the properties of the layer on 

which it resides. For example, if you disable printing on a layer that contains an object grouped with objects on 
another layer, the object remains part of the group but does not appear on the printed page.

Tip
Group connected objects to prevent disturbance of their connections and relative positioning.
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To separate grouped objects
1. Select the group.
2. Click Arrange, Ungroup.

You can now manipulate the objects individually.
Note

Use this procedure to ungroup nested groups.
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Viewing system and program information
Corel Print Space provides easy access to information about your computer as well as Corel Print Space itself. 
Program information consists of the program name, version number, registration number, and user name. This 
information does not change. You'll find this information particularly useful if you ever need help from Corel 
Technical Support Services.
System information, on the other hand, shows the current state of your computer. You can choose any of five 
different categories of system information. These categories let you see details about your system, display, 
printers, Corel EXE and DLL files, and system DLL files. For example, you can use this feature to see how much 
memory you have on the drive to which you want to save a file. You can save any system information in a text 
file called SYSINFO.TXT.
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To view information about your computer system
1. Click Help, About Corel Print Space.
2. Click System Info.
3. Click the Choose a Category list box.
4. Click the information category you want.
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To view information about Corel Print Space
Click Help, About Corel Print Space.

Tip
Use this procedure to gain quick access to your product registration number.
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To save system information
1. Click Help, About Corel Print Space.
2. Click System Info.
3. Click the Choose a Category list box.
4. Click the information category you want.
5. Click Save.

Corel Print Space saves the information in a file named SYSINFO.TXT.
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Managing files
To manage files in Corel Print Space, you must possess three simple skills. First, you need to know how to 
indicate that you want to start a new layout. Once you’ve created a layout, you’ll need to know how to save it in 
a file so that you can retrieve it later. Finally, if you want to view and edit the work you’ve saved, you’ll need to 
know how to retrieve or open the file that contains your work.
By learning these three basic skills, you’ll be able to manage any job you tackle using Corel Print Space.
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Choosing a starting point
Now that you've started Corel Print Space, you're probably anxious to try out some of its tools and features. 
Before you begin working, however, you'll need to decide what type of work you want to do. Corel Print Space's 
File menu lets you choose from the following basic starting points:

creating a new layout
creating a new template
creating a new layout using a template

Once you choose a start point, you can begin learning how to use Corel Print Space's tools to get the results you 
want. Click the How To: button at the top of this page to get started.
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To create a new layout
1. Click File, New.
2. Click Layout.

Corel Print Space creates and opens a new Layout using its default all-purpose template. You can now create 
and save your Layout using Corel Print Space’s tools and features.

Tip
You can also start a new layout using Corel Print Space's default template by clicking the New Layout 

button on the toolbar.
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To create a new layout using a template
1. Click File, New.
2. Click From Template.
3. Double-click the template you want to use.

You can now create and save your layout using Corel Print Space’s tools and features.
Note

Corel Print Space provides templates with the program; however, you can also create your own templates. 
Tips

Corel Print Space's templates are organized alphabetically by type. 
To start a new layout using Corel Print Space's default template, click the New Layout button on the 

toolbar.
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To create a new layout template
1. Click File, New.
2. Click Template.

You can now define and save your template using Corel Print Space’s tools and features.
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To save a file
1. Click File, Save.
2. If you haven’t saved the file before, specify a directory and type a name for the file in the File Name box.
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To save a file using a new name or directory
1. Click File, Save As.
2. Type the new file name and specify the directory in which you want to save the file.
Note

If you previously saved the file with a different name, that version remains unchanged.
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To save all open files

1. Click File, Save All.
2. If you haven’t saved the files before, specify a directory and type a name for each file in the File Name box.
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To open a file
1. Click File, Open.
2. Choose the file type you want from the Files of Type list box.
3. Double-click the drive that contains the file.
4. Double-click the file you want to open.
Tips

Enable the Preview check box to see a preview of your file before you open it.
Try clicking the Open button on the toolbar to open a file.
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To close a file
Click File, Close.

If you haven’t saved the file, Corel Print Space prompts you to confirm whether you want keep or discard your 
changes.
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Moving and positioning objects
Corel Print Space’s positioning tools let you choose between simplicity and precision when you move objects in 
your layouts. The mouse provides the quickest and simplest mode of object movement. By putting together two 
basic mouse actions clicking and dragging

you can move an object anywhere in your drawing. 
The Transform dialog box, on the other hand, gives you the advantage of precision without sacrificing ease of use. 
You can use the controls provided to position your object at an exact coordinate (based on Corel Print Space’s ruler 
system) or move your object a precise amount in any direction.

Corel Print Space also gives you the option to move or nudge
objects in small increments using the keyboard. By setting the nudge distance, you can make the increment any 
size you want.
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To move an object using the mouse
1. Select the object you want to move.
2. Drag the object to the position you want.
Notes

You can also use this procedure to move multiple objects and groups.
Moving several objects simultaneously has no effect on their relative positioning.

Tips
Hold down SHIFT as you drag to constrain the object’s movement to the horizontal and vertical planes only.
To leave a copy of the original object behind, drag the object with the right mouse button, then click Copy 

Here.
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To move an object using the keyboard
1. Select the object.
2. Press the Arrow key(s) to move the object to the position you want.
Tip

Click Tools, Options to change the distance the object moves
that is, the nudge distance
when you press an Arrow key.
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To position an object at a precise location
1. Select the object.
2. Click Transform, Position.
3. Specify a new position by typing values in the H (horizontal) and V (vertical) number boxes.
4. Click Apply.
Tip

Use the Anchor Points control to position the object using a handle on its selection box.
Each check box corresponds to a handle on the object's selection box. For example, you would enable the 
bottom-left check box to have the object’s bottom-left sizing handle occupy a specific coordinate. The default 
setting is the center check box, which represents the highlighting box’s center point.
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To position an object relative to its current location
1. Select the object.
2. Click Transform, Position.
3. Enable the Relative Position check box.
4. Specify how much you want to move the object by typing values in the H (horizontal) and V (vertical) number 

boxes.
For example, if you want to move an object 3 units to the left and 2 units up, type -3 in the H number box and 
2 in the V number box.

5. Click Apply.
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Copying objects
Corel Print Space provides two ways to copy objects. The Duplicate command copies objects without using the 
Windows Clipboard. When you duplicate an object, Corel Print Space places the duplicate on top of and slightly 
offset from the original object. Duplication is the quickest way to make and use a copy of any object.
The Copy command provides more flexibility but slightly less speed than the Duplicate command. Unlike the 
duplicate command, the Copy command uses the Windows Clipboard. As a result, Corel Print Space doesn’t place
the duplicate object in your layout immediately. Instead, you need to paste the object from the Clipboard. 
However, the Copy command’s use of the Clipboard gives you two important options. First, you can paste a 
copied object as often as you want. Second, you can paste a copied object into any compatible program.
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To duplicate an object
1. Select the object.
2. Click Edit, Duplicate.
Notes

Corel Print Space places the duplicate on top and slightly offset from the original object.
You can also use this procedure to duplicate text, lines, grouped objects, or multiple objects.

Tip
To duplicate an object quickly, click the object with the right mouse button, then click Duplicate.
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To copy an object
1. Select the object.
2. Click Edit, Copy.
Notes

Corel Print Space copies the object to the Windows Clipboard. You can now paste the object into Corel Print 
Space or any other compatible program. The object remains on the Clipboard until you copy or cut another object 
using Corel Print Space or any other program.

You can also use this procedure to copy text, lines, grouped objects, or multiple objects.
Tip

To copy an object quickly, click the object with the right mouse button, then click Copy.
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Removing objects
Corel Print Space provides two ways of removing objects from your layout. The Delete command removes 
objects from layouts without using the Windows Clipboard. In other words, once you delete an object, you can’t 
retrieve it.
The Cut command gives you extra flexibility in terms of removing objects from layouts. Unlike deleting, cutting 
removes objects from drawings but places them on the Windows Clipboard. This use of the Clipboard gives you 
two important options. First, you can paste the object you cut as often as you want (until you cut or copy again). 
Second, you can paste the object you cut into any compatible program.
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To cut an object
1. Select the object.
2. Click Edit, Cut.
Notes

Corel Print Space removes the object from the layout and places it on the Windows Clipboard. You can 
paste the object into Corel Print Space or any other compatible program. The object remains on the Clipboard until 
you copy or cut another object using Corel Print Space or any other program.

You can also use this procedure to cut text, lines, grouped objects, or multiple objects.
Tip

To cut an object quickly, click the object with the right mouse button, then click Cut.
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To delete an object
1. Select the object.
2. Click Edit, Delete.
Notes

When you delete an object, Corel Print Space removes it from the layout but does not place it on the 
Windows Clipboard. As a result, you should only delete an object if you know you won’t need it later.

You can also use this procedure to cut text, grouped objects, or multiple objects.
Tip

To streamline this procedure further, click the object with the right mouse button, then click Delete.
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Pasting objects
Corel Print Space’s Paste command represents one of the simplest ways to place existing objects in your layouts.
When you choose the paste command, Corel Print Space places the contents of the Windows Clipboard at the 
center of your layout’s printable page. In Corel Print Space, you place objects on the Clipboard using the Cut and 
Copy commands. You can paste any object created using Corel Print Space or those created using other 
compatible programs.
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To paste the contents of the Clipboard
Click Edit, Paste.

Note
By default, Corel Print Space pastes the object or text at the middle of the page. You can then manipulate 

the object to suit your needs.
Tip

To streamline this procedure further, click the right mouse button in the drawing window, then click Paste. 
Corel Print Space pastes the object at the spot you clicked.

{button ,AL(`cut_proc;copy_proc;;;;',0,"Defaultoverview",)} Related Topics



Mirroring objects
Corel Print Space’s Mirror command lets you make a reflection of any object or objects in a layout. You can mirror
an object on two planes horizontal and vertical. By mirroring an object horizontally, you flip it so it appears 
backwards. Similarly, by mirroring an object vertically, you flip it so it appears upside-down. When you mirror an 
object horizontally and vertically, then, it appears upside-down and backwards. You can mirror any object in your
drawing.
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To mirror an object horizontally
1. Select the object.
2. Click Transform, Size.
3. Click the Horizontal Mirror button to depress it.
4. Using the Anchor Points control, enable the selection box handle you want to use to mirror the object.

Each check box corresponds to a handle on the object's selection box. For example, to have Corel Print Space 
create the mirror object directly to the selected object's right, enable the right-center check box.

5. Click Apply.
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To mirror an object vertically
1. Select the object.
2. Click Transform, Size.
3. Click the Vertical Mirror button to depress it.
4. Using the Anchor Points control, enable the selection box handle you want to use to mirror the object.

Each check box corresponds to a handle on the object's selection box. For example, to have Corel Print Space 
create the mirror object directly below the selected object, enable the bottom-center check box.

5. Click Apply.
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To mirror an object diagonally
1. Select the object.
2. Click Transform, Size.
3. Click the Vertical button to depress it.
4. Click the Horizontal Mirror button to depress it.
5. Using the Anchor Points control, enable the selection box handle you want to use to mirror the object.

Each check box corresponds to a handle on the object's selection box. For example, to have Corel Print Space 
create the mirror object from the top-left corner of the selected object, enable the top-left check box.

6. Click Apply.
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To mirror an object using the mouse
1. Select the object.

When you select the object, its selection box appears.
2. Point to one of the handles on the selection box.
3. Drag the handle across the object.

To mirror horizontally, drag the left-middle or right-middle handle. To mirror vertically, drag the top-middle or 
bottom-middle handle. To mirror horizontally, drag one of the corner handles.
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Adding text
Corel Print Space provides three simple ways to add text to your layouts. The first and most basic method adding
unframed text

lets you add text that has no horizontal or vertical borders. You'll find this method particularly useful for short text 
entries that require only simple formatting.
By adding framed text, on the other hand, you can constrain text inside invisible borders of any dimension. You can 
also take advantage of advanced features like automatic wrapping and hyphenation, indenting, and bullets. You'll 
find framed text most effective for more extensive entries (for example, paragraphs) that call for advanced 
formatting techniques.

The third method adding text inside symbols
combines the skills and options of adding framed and unframed text. Adding text inside shapes gives you the same
speed and convenience as unframed text. In addition, Corel Print Space automatically constrains text inside a 
symbol's border and lets you apply advanced formatting features. This combination of power and ease of use will 
suit any layout that combines symbols and text.
In all three cases, you start by using the mouse to indicate where you want the text. Once you've indicated a 
starting point, you can simply begin typing.
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To add unframed text to a layout
1. Click the Text tool.
2. Click the spot where you want to add text.
3. Type the appropriate text.
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To add text inside a symbol
1. Click the Text tool.
2. Click inside the symbol.
3. Type the appropriate text.
Note

Text inside symbols follows the same conventions as text inside frames. For example, Corel Print Space 
automatically wraps the text as you approach the right edge of the symbol.

Tip
To streamline this procedure, select the symbol and begin typing.
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To add framed text
1. Choose the Text tool.
2. Position the mouse where you want a corner of the text frame.
3. Drag the mouse diagonally.
4. Release the mouse button when the frame is the size you want.

When you release the mouse button, a text cursor appears in the frame's top-left corner.
5. Type the appropriate text.
Note

Corel Print Space automatically wraps the text as you approach the right edge of the text frame.
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Selecting text
Before you begin formatting and manipulating the text in your layouts, you need to know how to select it. By 
selecting specific text characters or entries, you indicate that you want your next action or command to apply to 
that text only. Similarly, by deselecting text, you indicate that you want to stop manipulating it.
Corel Print Space provides simple ways to select specific characters and entire text entries, each involving basic 
mouse skills. Once you learn to select text, you can begin exploring Corel Print Space's extensive text formatting 
and manipulating options.
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To select an entire text entry
1. Click the Pick tool.
2. Click any part of the text entry.

When you select a text entry this way, a highlighting box surrounds it.
Notes

If you use this procedure to select text inside a symbol, you also select the symbol.
You can also drag a marquee box to select an entire text entry.
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To select specific text characters
1. Choose the Text Tool.
2. Drag the mouse to highlight the appropriate text.

As you position the pointer over text, it changes to a text cursor.
Tip

To select an entire word, choose the Text tool, then double-click the word you want.
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To copy an entire text entry
1. Click the Pick tool.
2. Click any part of the text entry.
3. Click Edit, Copy.

Corel Print Space places a copy of the text on the Windows Clipboard.
Note

If you use this procedure with text inside a symbol, Corel Print Space copies both text and symbol.
Tip

Use the Paste command to insert the text at additional locations in your layout.
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To copy specific text characters
1. Click the Text Tool.
2. Drag the mouse to highlight the appropriate text.
3. Click Edit, Copy.

Corel Print Space places a copy of the text on the Windows Clipboard.
Tip

Use the Paste command to insert the text at additional locations in your layout.
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To delete an entire text entry
1. Click the Pick tool.
2. Click any part of the text entry.
3. Click Edit, Delete.
Notes

If you use this procedure with text inside a symbol, Corel Print Space deletes both symbol and text.
You can't retrieve text after you've deleted it.

Tip
You can also delete text by pressing DELETE.
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To delete specific text characters
1. Click the Text tool.
2. Drag the mouse to highlight the appropriate text.
3. Click Edit, Delete.
Note

You can't retrieve text after you've deleted it.
Tip

You can also delete text by pressing DELETE.
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To cut an entire text entry
1. Choose the Pick tool.
2. Click any part of the text entry.
3. Click Edit, Cut.

Corel Print Space removes the entry from the layout and places it on the Windows Clipboard.
Note

If you use this procedure with text inside a symbol, Corel Print Space cuts both symbol and text.
Tip

Use the Paste command to insert the text at a different location in your layout.
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To cut specific text characters
1. Choose the Text tool.
2. Drag the mouse to highlight the appropriate text.
3. Click Edit, Cut.

Corel Print Space removes the characters from the layout and places them on the Windows Clipboard.
Tip

Use the Paste command to insert the text at a different location in your layout.
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To paste text from the Clipboard
Click Edit, Paste.

Corel Print Space places the pasted text in the center of the drawing page.
Tip

You can also paste text at a specific location. Click the right mouse button where you want to paste the 
text, then click Paste.
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Changing character attributes
Each text character has a set of attributes that governs its appearance, placement, and relation to other 
characters. Corel Print Space's character formatting tools give you complete control over each of these 
attributes. For example, you can apply distinctive fonts, styles, and effects to single characters, words, and 
paragraphs. Or, you can change character color and spacing to create unique effects. With effective character 
formatting, you can enhance a layout's appearance, clarity, and overall effectiveness.
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To change fonts
1. Select the text you want to change.
2. Click Format, Text.
3. Choose a new font from the Font list box.
Tips

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
Use the controls on the Text toolbar for faster changes to text attributes.
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To change font styles
1. Select the text you want to change.
2. Click Format, Text.
3. Choose the style you want from the Style list box.
Tips

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
Use the controls on the Text toolbar for faster changes to text attributes.
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To change the font size
1. Select the text you want to change.
2. Click Format, Text.
3. Specify a size and unit using the Size boxes.
Tips

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
Use the controls on the Text toolbar for faster changes to text attributes.
You can resize unframed text using the mouse. Select the entire entry using the Pick tool, then drag one of 

the handles on its selection box.
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To change text colors
1. Select the text you want to change.
2. Click Format, Text.
3. Click the Color picker to display its color palette.
4. Click the color you want.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change text character placement
1. Select the text you want to change.
2. Click Format, Text.
3. Click the Character button.
4. Choose an option from the Placement list box.

You can choose normal, subscript, or superscript character placement.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change text character effects
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Choose an option from the Effect list box.

You can choose to apply no effect, small capital letters, or all capital letters.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To add underlines to text
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Choose an underline type from the Underline list box.
Tips

Click the Edit button to the right of the list box to change underline attributes.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change the thickness and placement of underlines
1. Select the text that has the underline you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Edit button beside the Underline list box.
5. Change the thickness and placement of the appropriate underline type using the boxes provided.
Tips

To save time, set thickness and placement values for all the underline types.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To add overlines to text
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Choose an overline type from the Overline list box.
Tips

Click the Edit button to the right of the list box to change overline attributes.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change the thickness and placement of text overlines
1. Select the text that has the overline you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Edit button beside the Overline list box.
5. Change the thickness and placement of the appropriate overline type using the number boxes provided.
Tips

To save time, set thickness and placement values for all the overline types.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To add strikeout lines to text
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Choose a strikeout type from the Strikeout list box.
Tips

Click the Edit button to the right of the list box to change strikeout attributes.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change the thickness and placement of text strikeout lines
1. Select the text that has the strikeout you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Edit button beside the Strikeout list box.
5. Change the thickness and placement of the appropriate strikeout type using the boxes provided.
Tips

To save time, set thickness and placement values for all strikeout types.
Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change character spacing
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Alignment tab.
5. Specify a value in the Character number box.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change word spacing
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Alignment tab.
5. Specify a value in the Word box.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change the line height
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Alignment tab.
5. Specify a line height and unit using the Line boxes.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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To change character alignment
1. Select the text you want to change.
2. Click Format, Text.
3. Click Character.
4. Click the Alignment tab.
5. In the Alignment box, enable the button beside the alignment option you want.
Tip

Enable the Set As Default check box to have Corel Print Space apply your settings to all text you add.
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Changing paragraph attributes
Paragraphs, like individual text characters, have sets of attributes that govern their appearance. Corel Print 
Space's paragraph formatting tools give you complete control over each of these attributes. For example, you 
can change line, word, and character spacing to give paragraphs a distinctive look. Or, you can change 
paragraph alignment and add tabs to help organize your information. With effective paragraph formatting, you 
can enhance any layout's appearance, clarity, and overall effectiveness.
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To change paragraph character spacing
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the space you want between characters using the Character box.

The value you set represents a percentage of the SPACE character in the selected font.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change paragraph word spacing
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the space you want between words using the Word number box.

The value you set represents a percentage of the SPACE character in the selected font.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change paragraph line height
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the line height you want using the Line boxes.

The value you specify can be a number of points, a percentage of character height, or a percentage of point 
size

Tip
To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 

dialog box.
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To change the space before and after a paragraph
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the space you want above the paragraph using the Before Paragraph box.

The value you specify represents a percentage of the paragraph's character height.
6. Specify the space you want below the paragraph using the After Paragraph box.

The value you specify represents a percentage of the paragraph's character height.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change paragraph alignment
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. In the Alignment box, enable the button beside the alignment type you want.
6. If you selected full or forced justification, use the boxes provided to specify maximum word spacing, minimum 

word spacing, and maximum character spacing. If you selected another alignment type, these boxes appear 
grayed out.

Tip
To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 

dialog box.
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To set maximum word spacing in justified paragraphs
1. Select the justified paragraph you want to edit.
2. Click Format, Text.
3. Click the Paragraph button.
4. Click the Spacing tab.
5. Specify the maximum allowable space between words using the Max. Word Spacing box.

The value you specify represents a percentage of the current value in the Word box.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To set minimum word spacing in justified paragraphs
1. Select the justified paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the maximum allowable space between words using the Min. Word Spacing box.

The value you specify represents a percentage of the current value in the Word number box.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To set maximum character spacing
1. Select the justified paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the maximum allowable space between characters using the Max. Char. Spacing box.

The value you specify represents a percentage of the current value in the Character number box.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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Using automatic hyphenation
By having Corel Print Space hyphenate words automatically as you type, you can give your paragraphs a neater 
appearance and fit more text in each text frame. Without Automatic Hyphenation, Corel Print Space 
automatically wraps words that don't fit at the end of a text line. With Automatic hyphenation, however, Corel 
Print Space automatically hyphenates words at the right place and wraps the characters after the hyphen.
In unjustified text, Automatic Hyphenation helps eliminate ragged right margins and lets you fit more text on 
each line. In justified text, Automatic Hyphenation helps reduce the space between words. This reduction, in 
turn, lets you maximize the space provided by your text frame or symbol.
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To apply automatic hyphenation
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Enable the Automatic Hyphenation check box.
6. Use the controls provided to set hyphenation preferences. 
Note

You can use this procedure for framed text or text inside symbols.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To disable automatic hyphenation
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Disable the Automatic Hyphenation check box.
Note

You can use this procedure for framed text or text inside symbols.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To allow hyphenation of capitalized words
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Enable the Break Capitalized check box.
Notes

You can use this procedure for framed text or text inside symbols.
You must enable the Automatic Hyphenation check box to set hyphenation options. If the Automatic 

Hyphenation check box is disabled, the hyphenation option controls appear grayed out.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To prevent hyphenation of capitalized words
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Disable the Break Capitalized check box.
Notes

You can use this procedure for framed text or text inside symbols.
You must enable the Automatic Hyphenation check box to set hyphenation options. If the Automatic 

Hyphenation check box is disabled, the hyphenation option controls appear grayed out.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.

{button ,AL(`hyphenation_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set the hyphenation hot zone
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Spacing tab.
5. Specify the point at which hyphenation occurs using the Hot Zone boxes.

The Hot Zone represents the distance between the end of the line and the right margin. When a line of text 
reaches the Hot Zone, hyphenation occurs as is necessary. A smaller hot zone results in more hyphens and 
more consistent word spacing along the margin.

Notes
You can use this procedure for framed text or text inside symbols.
You must enable the Automatic Hyphenation check box to set hyphenation options. If the Automatic 

Hyphenation check box is disabled, the hyphenation option controls appear grayed out.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To specify rules regarding hyphen placement
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click the Paragraph button.
4. Click the Spacing tab.
5. Specify the smallest word length to which Corel Print Space can apply automatic hyphenation using the 

Minimum Word Length box.
6. Specify the minimum number of characters (including spaces) that must appear in the Hot Zone before 

hyphenation occurs using the Minimum Characters Before box.
7. Specify the minimum number of characters (including spaces) allowed after a hyphen using the Minimum 

Characters After box.
Notes

You can use this procedure for framed text or text inside symbols.
You must enable the Automatic Hyphenation check box to set hyphenation options. If the Automatic 

Hyphenation check box is disabled, the hyphenation option controls appear grayed out.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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Setting tab stops
By default, Corel Print Space sets tab stops at 0.5-inch intervals starting from the left margin of each text frame 
or symbol to which you're adding text. You can reposition or delete any of these tab stops or add your own as 
required. You can also apply leading characters to any tab stop or apply alignments right, left, center, or decimal

to give paragraphs the appearance you want.
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To set tab stops at consistent increments
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Specify an increment and unit of measurement using the Apply Tabs Every boxes.
6. Specify the alignment and leader you want.
7. Click the Apply Tabs Every button.
Note

You can use this procedure for framed text or text inside frames.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change the alignment of a tab stop
1. Select the paragraph that contains the tab stop.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Choose the appropriate tab from the tabs list.
6. In the Alignment box, enable a new alignment option.
Note

You can use this procedure for framed text or text inside symbols.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To delete a tab stop
1. Select the paragraph that contains the tab stop.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Choose the appropriate tab from the tabs list.
6. Click Delete.
Note

You can use this procedure for framed text or text inside shapes.
Tips

You can also delete a tab stop by dragging it off the ruler at the top of the dialog box.
To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 

dialog box.
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To add a tab stop
1. Select the paragraph to which you want to add a tab stop.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Type the location in the box below the Apply Tabs Every button.
6. Choose alignment and leader options using the controls provided.
7. Click Add.
Note

You can use this procedure for framed text or text inside shapes.
Tips

You can also add tabs by clicking the desired position on the ruler at the top of the dialog box.
To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 

dialog box.
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To delete all tab stops in a paragraph
1. Select the paragraph.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Click Delete All.
Note

You can use this procedure for framed text inside shapes.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To move a tab stop
1. Select the paragraph that contains the tab stop.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Tabs tab.
5. Choose the tab stop from the tabs list.

The tab stop appears in the box at the top of the list.
6. Type a new location.
7. Click Add.
Note

You can use this procedure for framed text or text inside shapes.
Tips

You can also move a tab stop by dragging it within the ruler at the top of the dialog box.
To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 

dialog box.
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To apply a leading characters before a tab stop
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Select an existing tab stop or type a location for a new tab stop.
5. Enable the Leadered check box.
6. Specify the leader character by typing it or by specifying its character number.
7. Specify the spacing between leader characters using the slider or box provided.

You can specify a value from 0 (tight spacing) to 10 (loose spacing).
Note

You can use this procedure for framed text or text inside shapes.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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Setting indents
Indents can often help improve layout clarity by providing a way to distinguish between different types of 
paragraphs. For example, you can use indents to draw attention to an important list or to the start of longer 
paragraphs. By using indents effectively, you can convey text-based information in an organized and effective 
fashion.
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To set paragraph indents
1. Select the paragraph you want to edit.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Indents tab.
5. Specify the first line indent and unit of measurement using the boxes provided.

If you change the unit, the Rest of Line and Right Margin controls automatically incorporate the change.
6. Specify the indent you want for the rest of the lines using the box provided.
7. Specify the right margin indent using the box provided.
Note

You can use this procedure for framed text or text inside shapes.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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Adding bullets to paragraphs
Like indents, bullets help make text entries easier to read and understand. When used in a list, for example, 
bullets help draw attention to each point, thereby enhancing the list's clarity and effectiveness.
Corel Print Space provides a wide range of symbols for use as bullets. Once you select a symbol, you can set its 
size and position as well as the indent that precedes it.
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To add a bullet to a paragraph
1. Select the paragraph.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Enable the Bullet button.
6. Choose a bullet and apply the settings you want.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change bullets
1. Select the paragraph that has the bullet you want to change.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Choose a font from the Symbol Category list box.
6. Click the symbol you want or type its symbol number in the Symbol # box.
Note

If you haven't enabled the Bullet button, you can't make bullet settings.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To change the size of a bullet
1. Select the paragraph that has the bullet you want to change.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Specify the size and unit you want using the Bullet Size boxes.
Note

If you haven't enabled the Bullet button, you can't make bullet settings.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To set the indent of a bulleted paragraph
1. Select the paragraph.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Specify the indent you want before the bullet using the Bullet Indent box.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To set the vertical placement of a bullet
1. Select the paragraph that contains the bullet.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Specify the bullet's vertical placement using the Baseline Shift number box.
Notes

The baseline aligns the bottom edges of a line of characters. Specify a negative number to shift the bullet 
below the baseline; specify a positive number to shift the bullet above the baseline.

If you haven't enabled the Bullet button, you can't make bullet settings.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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To remove a bullet from a paragraph
1. Select the paragraph.
2. Click Format, Text.
3. Click Paragraph.
4. Click the Effects tab.
5. Enable the No Effect button.
Tip

To apply your settings to all new paragraphs, enable the Set As Default check box on the Shape Properties 
dialog box.
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Finding and replacing text
Corel Print Space's Find command lets you search your layout for specific text. You can include upper and lower 
case characters in your search criteria.
The Replace command lets find and replace text while maintaining its formatting attributes. As with the Find 
command, you can include upper and lower case characters in your search criteria.
When the Text Tool is selected, searching begins at the insertion point and continues to the end of the selected 
text. When the Pick Tool is active, Corel Print Space searches the entire layout one text object at a time.

{button ,AL(`paratext_overviews;text_overviews;;;;',0,"Defaultoverview",)} Related Topics



To find text
1. Select the text entry you want to search.

Deselect all objects to search all text entries.
2. Click Edit, Find.
3. In the Find box, type the text you want to find.
4. Enable the Match Case check box to conduct a case-sensitive search.
Note

You can type as many as 100 characters into the Find and Replace boxes. The text scrolls horizontally as 
you type.
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To find and replace text
1. Select the text entry you want to search.

Deselect all objects to search all text entries.
2. Click Edit, Replace.
3. In the Find box, type the text you want to find.
4. Enable the Match case check box to conduct a case sensitive search.
5. In the Replace With box, type the replacement text.
6. Click Find.
7. Click Replace to replace the occurrences one at a time.

Click Replace All to replace all occurrences at once.
Note

You can type as many as 100 characters into the Find and Replace boxes. The text scrolls horizontally as 
you type.
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Checking your spelling
Corel Print Space's Spelling Checker makes it easy to remove spelling and typographical errors from your 
layouts. When you run the Spelling Checker, it searches your layout for unrecognized text strings. You can 
correct or ignore any unrecognized string or add it to a personal dictionary.
Like many of Corel Print Space's tools, you can adjust the Spelling Checker so that it operates exactly the way 
you want. For example, you can adjust the Spelling Checker's search criteria or have it use your personal 
dictionaries in addition to its built-in dictionary.
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To run a spelling check
1. Select the text entry you want to check.

Deselect all objects to have Corel Print Space check all text in the layout.
2. Click Tools, Spelling.
3. Choose the scope of the spelling check using the Check range list box.
4. For each unknown word, choose one of the following options:

Edit the word in the Sentence box. The unrecognized word is highlighted. Click the word and make your 
changes as you would in the document window.
Click Next Sentence to skip the current sentence.
Click Change if the Change To box shows the word you want. Click Change All to substitute each occurrence.
Click Change All if you want to change all instances of the word to the contents of the Change To box.
Click Ignore to leave the current word unchanged. Click Ignore All to ignore every occurrence of the word.
Click Add Word to include unrecognized words in the current personal dictionary.

Note
By default, the Spelling Checker refers to the Personal Dictionary USERPD during spelling checks.

Tip
Click Options to customize your spelling check.
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To set the formality level of a spelling check
1. In the Spelling Check dialog box, click the Options button.
2. Choose an option from the Formality Level list box.
Tip

Click Tools, Spelling to run the Spelling Checker.
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To undo a change in the Spelling Checker
1. In the Spelling Check dialog box, click Options.
2. Click Undo Edit.
Tip

Click Tools, Spelling to run the Spelling Checker.
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To create a new personal dictionary
1. In the Spelling Check dialog box, click Options.
2. Click Create New Dictionary.
3. Type a name for the new dictionary.
4. Click OK.

The new dictionary becomes the current dictionary.
Tip

Click Tools, Spelling to run the Spelling Checker.
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To choose a personal dictionary
1. In the Spelling Check dialog box, click Options.
2. Click Personal Dictionary.
3. Click the dictionary you want.
Tip

Click Tools, Spelling to run the Spelling Checker.
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To add a word to a personal dictionary
1. Click Tools, Spelling and run a spelling check.
2. When the Spelling Checker highlights the word you want to add, click Add Word.
3. Click the appropriate dictionary.
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To see an explanation of a spelling error
1. Click Tools, Spelling and run a spelling check.
2. Click Options, Explain Error.
Note

By default, the Spelling Checker provides an explanation for every unknown word.
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To set advanced spell checking options
1. In the Spelling Check window, click Options.
2. Click Advanced Options.
3. Choose language options using the list boxes provided.
4. Enable the check box provided to have the Spelling Checker supply alternative word spellings.
5. Enable the check box provided to use personal dictionaries.
6. Enable the appropriate check boxes to choose the dictionaries you want.
Note

You can set the maximum number of sentence elements for each language that you initialize. Sentence 
elements are words or punctuation that International Proofreader treats as units. The default setting for each 
language should be acceptable for most text; you should not change the default unless you need to reduce the 
memory overhead required by the buffer-processing function.

Tip
Click Tools, Spelling to run the Spelling Checker.
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To change the Spelling Checker's proofreading criteria
1. Click Tools, Spelling to run the Spelling Checker.
2. Click Options.
3. Click Rule Manager.
4. Choose a profile from the User Profile list box.
5. Choose Spelling from the Check mode list box.
6. Specify the formality level using the Formality list box.
7. Enable or disable the rules as required.
Note

Click New to create a new user profile.
Tip

Click a rule to see its description.
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Using the Thesaurus
Corel Print Space's thesaurus can help you add variety and clarity to the text in your layouts. The thesaurus 
gives you access to synonyms, antonyms, and definitions for virtually any word you select.
Tip

Since the thesaurus is always available, you can use it to look up synonyms of any words, not just those in 
the current drawing.
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To use the thesaurus
1. With the Text tool active, click the word for which you want to find synonyms.
2. Click Tools, Thesaurus.
3. Click the synonym you want.
4. Click Replace.
Tips

Double-click a synonym to see its definition and synonyms.
Click a definition to see its synonyms.
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Using Type Assist
Corel Print Space's Type Assist feature lets you correct misspelled words and capitalization errors automatically. 
For example, you can have Type Assist replace "teh" with "the" and "NAme" with "Name". You can also have Type
Assist insert common words, phrases, and symbols automatically. For instance, you can store the word "building"
using the text string "bldg". Then, whenever you type bldg followed by a space, Corel Print Space replaces it with
"building".
Whatever your layout, you'll find Type Assist a valuable verification and time-saving tool.
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To have Corel Print Space capitalize the first letter of sentences automatically
1. Click Tools, Type Assist.
2. Enable the Capitalize First Letter of Sentences check box.
Tip

Corel Print Space applies your settings to all new text entries you add. To apply your settings to one entry 
only, select it with the Pick tool before clicking Tools, Type Assist.
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To have Corel Print Space change straight quotes to typographic quotes
1. Click Tools, Type Assist.
2. Enable the Change Straight Quotes to Typographic Quotes check box.
Tip

Corel Print Space applies your settings to all new text entries you add. To apply your settings to one entry 
only, select it with the Pick tool before clicking Tools, Type Assist.
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To have Corel Print Space correct consecutive initial capitals
1. Click Tools, Type Assist.
2. Enable the Correct Two Initial, Consecutive Capitals check box.
Tip

Corel Print Space applies your settings to all new text entries you add. To apply your settings to one entry 
only, select it with the Pick Tool before clicking Tools, Type Assist
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To have Corel Print Space capitalize the names of days
1. Click Tools, Type Assist.
2. Enable the Capitalize Names of Days check box.
Tip

Corel Print Space applies your settings to all new text entries you add. To apply your settings to one entry 
only, select it with the Pick Tool before clicking Tools, Type Assist.
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To have Corel Print Space automatically replace text as you type
1. Click Tools, Type Assist.
2. Enable the Replace Text While Typing check box.
3. In the Replace box, type the text you want Corel Print Space to replace.
4. In the With box, type the replacement text.
5. Click Add.
Tip

Use automatic replacement to speed up text entry and prevent typographical errors. You can accelerate 
text entry by having Corel Print Space replace abbreviations with words and phrases
for example, "bldg" for building or "asap" for "as soon as possible". You can also correct common typographical 
errors
for example, replacing "hte" or "teh" with "the".
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Setting advanced spell checking options
The Advanced Options dialog box lets you control the behavior of the Spelling Checker by indicating the 
language you'll be using in your layout. You can also choose which language the Spelling checker uses to check 
your layout and to display any errors. Further, you can specify whether you want the Spelling Checker to display 
alternative spellings, whether you want to use a personal dictionary, and the maximum number of elements 
allowed in each sentence.
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Creating personal dictionaries and user profiles
The New Personal Dictionary dialog box lets you create a custom dictionary that incorporates your own spellings,
abbreviations, and acronyms. By default, Corel Print Space keeps these custom settings in the personal 
dictionary "USERPD". Type a new name if you want to create a new personal dictionary.
The New User Profile dialog box lets you create a custom file containing your own rule changes for the Spelling 
Checker. By default, Corel Print Space keeps these settings in the user profile USERPF. If you turn off a rule or rule
type without saving your settings, the Rule Manager discards the information at the end of the work session.
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Specifying rules for the Spelling Checker
The Rule Manager lets you enable and disable proofreading rules to suit different types of writing. You can then 
save these rule combinations and load them for specific layouts. These rule combinations, called user profiles, 
are saved with your document and are used each time you run a spelling check on it. If you turn off a rule or rule
type without saving your settings, the Rule Manager discards the information at the end of the work session.
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Editing underlines, overlines, and strikeouts
Use the Edit Underline, Overline, and Strikeout dialog boxes if you want to change the default underline, 
overline, and strikeout thickness or baseline shift. You can also use the Edit Underline, Overline, and Strikeout 
dialog boxes to change unit of measurement if required.
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Using field text
Corel Print Space's field text option lets you display specific information about any object in your layout. Field 
text differs from normal text in that instead of typing the text, you specify only the type of information you want. 
Once you specify an information type, Corel Print Space fills in the values automatically. For example, you can 
use field text to have an object or text frame display the current time or date. Or, you can have the object or 
frame display the date or time it was created.
You can also have a field text entry display information about another object. For example, you can add an entry 
that displays information about object width, length, or height. Once you've added this entry, you can connect it 
to another object and learn the specified dimension. You'll find this feature particularly useful for creating 
dimension lines in technical layouts.
You can add field text to any shape or text frame and (if desired) connect it with any type of object.
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To add field text to a text frame
1. Select the text frame to which you want to add field text.
2. Click Format, Text.
3. In the Shape Text box, enable the Field button.
4. Choose the type of field text you want from the list box provided.

For example, if you want the text frame to display the current date, choose Current Date.
Notes

Field text replaces any text currently inside the text frame.
You can format field text just as you edit framed text, unframed text, and text inside shapes. You can't edit 

field text directly.
Tips

You can attach a framed field text entry to an object so that it displays information about the object. For 
example, if you choose Width from the list box, you can attach the frame to a shape so that it displays the shape's 
width. The field text automatically updates to reflect any changes you make to the shape's width.

If no information is available for the type of field text you select, the frame displays question marks. Once 
you provide a source of information
for example, by attaching the frame to another object so that Corel Print Space can read its dimensions
the frame will display the information you want.
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To add field text to a shape
1. Select the shape to which you want to add field text.

This shape must already contain text or have a text cursor displayed inside it.
2. Click Format, Symbol.
3. Click the text tab.
4. In the Shape Text box, enable the Field button.
5. Choose the type of field text you want from the list box provided.

For example, if you want the shape to display the current date, choose Current Date.
Notes

Field text replaces any text inside the shape.
You can format field text just as you edit framed text, unframed text, and text inside shapes. You can't edit 

field text directly.
Tips

You can attach a field text entry to an object so that it displays information about the object. For example, 
if you choose Length from the list box, you can attach the shape to a line so that it displays the line's length. The 
field text automatically updates to reflect any changes you make to the line.

If no information is available for the type of field text you select, the shape displays question marks. Once 
you provide a source of information
for example, by attaching the shape to a line so that Corel Print Space can read its dimensions
the shape will display the information you want.
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To protect a text entry
1. Select the object or frame that contains the text you want to protect.
2. Click Format, Text.
3. In the Shape Text box, enable the None button.
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To enable field text
1. Select the shape or text frame for which you want to enable field text.
2. Click Format, Text.
3. In the Shape Text box, enable the Field text button.

You can now add field text to this frame or shape.
Tip

Enable None to prevent accidental changes to the text entry. Enable Normal to replace field text with text 
you type in manually.
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To import files using drag and drop
Drag the file you want to import into the Corel Print Space window.
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Linking and embedding objects
Linking and embedding let you include information from a file created in another application. When you link an 
object in Corel Print Space, you establish an active connection between your layout and the linked object's 
source document. Corel Print Space then uses this connection to update the object as you modify its source. As a
result, you should use linking if you want Corel Print Space to update your layout whenever you make changes to
the original object. You can specify when updates occur, or update the information automatically whenever the 
source file changes.
When you embed an object, you copy the object from its source document and place it in your layout. After this 
point, Corel Print Space will not automatically incorporate changes you make to the source file directly. If you 
want Corel Print Space incorporate changes, you must use Corel Print Space to open its source document. Once 
you've edited the object, you can save it and return to Corel Print Space to see that your layout has incorporated
your changes.
Note

To have a link work properly, you must ensure that the linked file is available to the host file. For example, 
if you send a file to another computer, you must include all the linked files.
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To embed a new object starting from Corel Print Space
1. Click Edit, Insert New Object.
2. Enable the Create New button.
3. In the Object Type box, choose the type of object you want to create.

The list includes items from applications on your system that support object linking and embedding. You need 
to install these applications using their setup programs if you want them to appear on the list.

4. Click OK to open the source application.
5. Create the object you want to embed.
6. Choose Update, Exit, or Exit and Return from the source application's File menu.

In some applications, a dialog box appears prompting you to update. Click Yes or OK.
Note

Corel Print Space places the embedded objects in the center of your layout. You can select the object and 
move it as required.

Tips
You can edit an embedded object by double-clicking the object in Corel Print Space. This will launch the 

server application and allow you to edit the information. When you exit and return to Corel Print Space the changes 
will be reflected in your drawing.

You can insert an embedded object by pasting the object from the source program.
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To embed an existing object starting from Corel Print Space
1. Click Edit, Insert New Object.
2. Enable the Create From File button.
3. Click Browse and select the file that contains the object you want.

The list includes items from applications on your system that support object linking and embedding.
4. Click OK to open the source application.
5. Select the object you want to embed.
6. Choose Update, Exit, or Exit and Return from the source application's File menu.

In some applications, a dialog box appears prompting you to update. Click Yes or OK.
Note

Corel Print Space places the embedded objects in the center of your layout. You can select the object and 
move it as required.

Tips
You can edit an embedded object by double-clicking the object in Corel Print Space. This will launch the 

server application and allow you to edit the information. When you exit and return to Corel Print Space the changes 
will be reflected in your drawing.

You can also insert an embedded object by pasting the object from the server applications.
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To embed an object starting from the source program
1. Open the source program.
2. Choose or create the object you want to embed.
3. Copy the information to the Windows Clipboard.
4. Open Corel Print Space.
5. Click Edit, Paste.
Note

You can also insert an embedded object by opening the source file from Corel Print Space.
Tips

You can edit an embedded object by double-clicking the object in Corel Print Space.

{button ,AL(`embed_proc;;;;;',0,"Defaultoverview",)} Related Topics



To embed a file
1. Click Edit, Insert New Object.
2. Click Create from File.
3. Type the name, including the directory path and extension, of the file you want to embed. If you don't know 

the name of the file or its location, click the Browse button to display the Browse dialog box.
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To edit an embedded object
1. Select the embedded object. 
2. Click Edit.
3. Click the object type (for example, Spreadsheet Object), then click Edit.

This launches the object's source program.
3. Make the changes you want.
Note

Try double-clicking the embedded object to launch its source program.
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To link a new object starting from Corel Print Space
1. Click Edit, Insert New Object.
2. Enable the Create New button.
3. Enable the Link check box.
4. In the Object Type box, choose the type of object you want to create.

The list includes items from applications on your system that support object linking and embedding. You need 
to install these applications using their setup programs if you want them to appear on the list.

4. Click OK to open the source application.
5. Create the object you want to link.
6. Choose Update, Exit, or Exit and Return from the source application's File menu.

In some applications, a dialog box appears prompting you to update. Click Yes or OK.
Notes

Corel Print Space places the linked object in the center of your drawing. You can select the object and 
move it as required.

Corel Print Space uses this link to incorporate any changes you make to the information in the source file.
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To link an existing object starting from Corel Print Space
1. Click Edit, Insert New Object.
2. Enable the Create From File button.
3. Enable the Link check box.
4. Click Browse and select the file that contains the object you want.

The list includes items from applications on your system that support object linking and embedding. You need 
to install these applications using their setup programs if you want them to appear on the list.

5. Click OK to open the source application.
6. Select the object you want to link.
7. Choose Update, Exit, or Exit and Return from the source application's File menu.

In some applications, a dialog box appears prompting you to update. Click Yes or OK.
Notes

Corel Print Space places the linked object in the center of your drawing. You can select this object and 
move it as required.

Corel Print Space uses this link to incorporate any changes you make to the information in the source file.
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To link an object from the source application
1. Start the application used to create the object you want to link.
2. Open the file that contains the object.
3. Select and copy the object.
4. Start or open Corel Print Space and click Edit, Paste Special.
5. Enable the Paste Link button.
6. In the Data Type box, select the type of information that corresponds to the object you want to a link.
Notes

Corel Print Space places the linked object in the center of your page. You can select the object and move it 
to any position.

Corel Print Space places the linked object in the center of your drawing. You can select this object and 
move it as required.

Tips
You can also insert a linked object by opening the source file from Corel Print Space.
You can link an object by dragging it into the drawing window while pressing CTRL + SHIFT.
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To specify automatic or manual link updating
1. Select the linked information in the destination file you want to update.
2. Click Edit, Links.
3. Choose Manual or Automatic.
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To update a link manually
1. Click Edit, Links.
2. In the Links box, select the links you want to update.
3. Click Update Now.

Your layout now incorporates any changes made to the source file since the last update.
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To update all links in a file
1. Click Edit, Links.
2. Select all the links in the Links box.
3. Click Update Now.
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To jump to a linked object's source file
1. In your layout (the destination file), select the linked objects you want to edit.
2. Click Edit, Links.
3. Click Open Source to launch the source application and file.

You can now edit and save the source file as required.
Notes

If you make the changes in the destination file, Corel Print Space will ignore them when it updates the link.
You can also double-click a linked object to jump to the source file.
If you don't need further updates from the source file, you can break the link.
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To change a link
1. Select the linked object in your layout.
2. Click Edit, Links.
3. Click Change Source.
4. In the source box, type a new name for the source file.

{button ,AL(`link_proc;;;;;',0,"Defaultoverview",)} Related Topics



To break a link
1. Select the linked object.
2. Click Edit, Links.
3. Click Break Link.
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Ordering objects
In most basic terms, a Corel Print Space layout consists of a series of objects stacked on top of one another. The 
vertical order of these objects the stacking order

determines their absolute relationship and, therefore, the appearance of the drawing
Corel Print Space’s To Front and To Back commands let you change the stacking order. For example, if you select the
bottom object and choose the To Front command, Corel Print Space places it on top of all other objects. The topmost
object becomes the second object, the second moves to third, and so on.

The Behind and In Front Of commands also let you place objects at an exact location in the stacking order. For 
example, if you have ten overlapping objects, you can use the Behind command to place the top object behind 
the third object. To restore the previous order, you would use the In Front Of command and place the object back
on top.
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To move an object to the front
1. Select the object.
2. Click Arrange, To Front.
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To move an object to the back
1. Select the object.
2. Click Arrange, To Back.
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To move an object behind another object
1. Select the object you want to move.
2. Click Arrange, Behind.

The mouse pointer becomes a horizontal arrow.
3. Click the object behind which you want to place the selected object.
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To move an object in front of another object
1. Select the object you want to move.
2. Click Arrange, In Front Of.

The mouse pointer becomes a horizontal arrow.
3. Click the object in front of which you want to place the selected object.
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Introducing Corel Print Space
Welcome to Corel Print Space, the advanced printing application that allows CorelCAD models to be printed 
along with any other type of OLE objects. You can view CorelCAD models in frames which are created using a 
special Frame tool. Viewing, scaling and rendering of each frame can be independently controlled. As well, you 
can add text and create objects using the text and drawing tools.
In Corel Print Space, you can create layouts and templates for presenting and printing your CorelCAD drawings. A
layout file contains all elements on your Corel Print Space page including links to the CorelCAD drawings in the 
frames. A template contains any text, and graphics created in Corel Print Space. It also includes frames, but does
not save the CorelCAD drawings in the frames. 
Corel Print Space's features let you take full advantage of Windows 95 and its 32-bit architecture to create 
superior layouts for printing. To help you build layouts, Corel Print Space provides a set of precision drawing 
tools. Once you've started building a layout, you can manipulate the object and then use Corel Print Space's 
formatting and verification tools including a spell-checker and thesaurus

to add in the finishing touches.
With its combination of new and enhanced features, Corel Print Space merges power, versatility, and ease of use to 
help you tackle any layout.
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Getting help
Corel Print Space's extensive, multi-faceted online help system provides easy access to descriptions and 
procedures that cover all of Corel Print Space's features and functions. By using the help system, you'll be able 
to get the information you need and return to your work quickly.
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To get help on using Corel Print Space
Click Help, Corel Print Space Help Topics.

If you need help finding the information you need, press F1.
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To get help on a menu command
1. Click the Help button on the toolbar.
2. Click the menu that contains the command.
3. Click the command.
Tip

You can also get help by pressing F1 when a command is highlighted.
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To get help on tools and controls
1. Click the Help button on the toolbar.
2. Click the item for which you want help.
Tips

You can also get help by clicking an item with the right mouse button, then clicking the What's This? menu 
command.

Corel Print Space also provides "pop-up" help
called Tooltips
on toolbar and toolbox buttons. Position the mouse pointer over any button to see its name or function.
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To get help in a dialog box
1. Click Help.

If the dialog box doesn't have a Help button, try pressing F1.
Tip

You can also get help by clicking an item with the right mouse button, then clicking the What's This? menu 
command.
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Setting up your layout
Corel Print Space's Page Setup dialog box lets you adjust the size, orientation, and margins of your drawing page
to suit the layout you want to create. To help you set up your page, Corel Print Space provides easy access to 
several pre-defined page sizes and orientations, including standard legal and letter paper. You can also 
customize the drawing page if your layout calls for an unusual page size or specify precise margins to make sure 
your layout fits on the page exactly as you want it.
In addition, you'll find controls that let you control the display of hidden objects as well as how objects appear 
during selection. You'll also find controls for overriding protected or locked objects.
By setting up the layout first, you can prepare your work environment so that it meets your exact needs.
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To set the page orientation
1. Click File, Page Setup.
2. Enable the Landscape button if you want the horizontal dimension of the page to be greater than the vertical 

dimension.
Enable the Portrait button if you want the vertical dimension of the page to be greater than the horizontal 
dimension.

Note
When you print a layout, a message appears if the current orientation does not match the printer's page 

orientation. Click Yes to change the printer's orientation to match that of the Working Page.
Tips

Click Set From Printer to set the size and orientation of your page to the current printer settings.
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To choose a preset page size
1. Click File, Page Setup.
2. Choose a preset paper size from the Paper list box.
Tips

Click Set From Printer to set the size and orientation of your page to the current printer settings.
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To define a custom page size
1. Click File, Page Setup.
2. Choose Custom from the Paper list box.
3. Specify the page dimensions using the Width and Height boxes.
Tips

Click Set From Printer to have the size and orientation of your page match the current printer settings.
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To choose a simulated paper color
1. Click File, Page Setup.
2. Click the Layout tab.
3. Choose a paper color using the Paper Color picker.
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To set the page margins
1. Click File, Page Setup.
2. If required, change the unit using the list box provided.
3. Specify margins using the Left, Right, Top, and Bottom boxes.
Note

The values you specify represent the distance from the corresponding edge of the page.
Tip

To have equal margins, specify a value for one margin, then enable the Equal Margins check box.
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To display hidden objects
1. Click File, Page Setup.
2. Click the Options tab.
3. Enable the View Hidden objects check box.
4. Click Apply.
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To enable object highlighting
1. Click File, Page Setup.
2. Click the Options tab.
3. Enable the Highlight Objects check box.
4. Click Apply.
Tip

To see the effect of enabling object highlighting, point to any object. As you move the mouse pointer over 
an object, Corel Print Space highlights its outline.

{button ,AL(`preferences_proc;;;;;',0,"Defaultoverview",)} Related Topics



To disable object highlighting
1. Click File, Page Setup.
2. Click the Options tab.
3. Disable the Highlight Objects check box.
4. Click Apply.
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To override object protection
1. Click File, Page Setup.
2. Click the Options tab.
3. Enable the Override Object Protection check box.
4. Click Apply.
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 Lets you create a frame on the working page of your layout in which you can associate a CorelCAD file.



Lets you rotate objects using the mouse. Also lets you move an object's center of rotation/connector pin.



Lets you draw straight lines with single or multiple segments.



Displays a color palette. Click the color you want or click the Other button to create a custom color.



Lets you pick up a color from the Mixing Area.



Lets you mix colors in the Mixing Area.



Changes the Reference Color swatch so that it matches the New Color swatch.



Lets you draw rectangles and squares by dragging the mouse.



Lets you draw ellipses and circles by dragging the mouse.



Lets you draw polygons and stars by dragging the mouse.



Lets you draw freehand lines and shapes by dragging the mouse.



Displays the Line, Autorouted Line, Freehand, and Curve tools.



Lets you draw curves by dragging the mouse.



Specifies a uniform fill for the selected object or FlowLine.



Opens the Fill Flyout, which provides preset fills as well as access to tools for setting uniform, fountain, and 
pattern fills.



Specifies no fill for (or removes the fill from) the selected object or FlowLine.



Specifies a fountain fill for the selected object or FlowLine. You can choose linear, radial, conical, and square 
fountain fills.



Specifies a linear fountain fill for the selected object or FlowLine.



Specifies a radial fountain fill for the selected object or FlowLine.



Specifies a conical fountain fill for the selected object or FlowLine.



Specifies a square fountain fill for the selected object or FlowLine.



Specifies a pattern fill for the selected object or FlowLine.



Locks and unlocks the Steps number box.



Determines the intermediate fountain fill colors using a straight line across the color wheel.



Determines the intermediate fountain fill colors using a counterclockwise path around the color wheel.



Determines the intermediate fountain fill colors using a clockwise path around the color wheel.



Adjusts the midpoint between colors in the fountain fill.



Opens the Outline Flyout, which provides a series of preset line styles that you can apply to lines and object 
outlines.



Displays the Shadow Flyout, which provides a series of preset shadows that you can apply to any object.



Enables and disables color overriding of a layer.



Indicates the active layer.



Allows or prevents editing of a layer.



Makes a layer visible or invisible.



Enables and disables printing of a layer.



Creates and opens a new layout using Corel Print Space's all-purpose default template.



Displays the Open dialog box.



Mirrors the selected object horizontally.



Represents the selected object's center of rotation and the eight handles its selection box. Click a box to have its
corresponding handle remain stationary during mirroring, rotating, and resizing.



Mirrors the selected object horizontally.



Lets you enter and edit framed text, unframed text, and text inside symbols.



Lets you add tab stops by clicking the mouse. Drag an existing tab stop to reposition it.



Lets you control how FLOW reroutes connecting lines around obstacles.



Lets you reposition the ruler origin point by dragging onto the drawing window.



Lets you select, reposition, and resize objects using the mouse. You can also use the Pick Tool to reshape a line or
curve.



Displays the Open dialog box so that you can open a Smart Library.



Rolls a Smart Library up or down.



Displays the Zoom Flyout, which provides tools for changing your vantage point on your drawing.



Lets you magnify your view of a specific part of a layout by dragging the mouse.



Lets you reduce your view of a layout by clicking the mouse.



Shows your layout at actual size.



Magnifies or reduces your viewpoint so that the selected objects fit in the drawing window.



Magnifies or reduces your viewpoint so that all objects fit in the drawing window.



Magnifies or reduces your viewpoint so that the drawing page fits inside the drawing window.



Lets you move your layout within the drawing window by dragging the mouse.



 Aligns selected objects in a vertical column.



 Aligns selected objects in a horizontal row.



 Extends the palette to display all of its colors. 



 Let you create a color by specifying exact values for each component in a color model.



 Saves your fountain fill and adds it to the list of presets.



 Lets you get help on menu commands and toolbar buttons.



 Lets you create Autorouted connecting lines between objects.



Displays the Rectangle, Ellipse, and Polygon tools.



Rotating objects
Like its other positioning tools, Corel Print Space’s rotation tools are effective, flexible, and easy to use. Corel 
Print Space’s rotation tools let you choose between speed and precision when you rotate objects in your layouts. 
The mouse provides the quickest and simplest mode of object rotation. By putting together two basic mouse 
actions clicking and dragging

you can rotate an object around any point in your layout. The Transform dialog box, on the other hand, gives you 
the advantage of precision. You can use the controls provided to rotate an object by a precise amount around any 
coordinate in your layout.
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To rotate an object with the mouse
1. Select the object.

When you select the object, its selection box appears. A selection box consists of eight handles.
2. Click the Rotate tool.

Rotation handles replace the object's sizing handles. The center of rotation appears as a round dot at the 
absolute center of the selection box.

3. Drag the object to achieve the rotation you want.
Tip

Hold down SHIFT as you drag to constrain rotation to 15-degree increments.
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To change an object’s center of rotation with the mouse
1. Select the object.

When you select the object, its selection box appears. A selection box consists of eight handles.
2. Click the Rotate tool.

Rotation handles replace the object's sizing handles. The center of rotation appears as a round dot at the 
absolute center of an object’s handles.

3. Drag the center of rotation to the location you want.
The object now rotates around this point.
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To rotate an object by a precise amount
1. Select the object.
2. Click Transform, Rotate.
3. Use the Angle number box to specify the angle by which you want to rotate the object.
4. Click Apply.
Note

Use the controls in the Center box to specify a precise center of rotation.
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To specify a precise center of rotation
1. Select the object.
2. Click Transform, Rotate.
3. Specify the coordinates for the new center of rotation using the Horizontal and Vertical boxes.

The object now rotates around this coordinate.
Note

The Anchor Point control corresponds to the handles on the object's selection box. To rotate the object 
around one of these handles, enable the corresponding check box. For example, enable the top-center check box to 
rotate the object around the top-center handle.
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To move the center of rotation by a specific amount
1. Select the object.
2. Click Transform, Rotate.
3. Enable the Relative Center check box.

You must perform this step if you want to position the center of rotation relative to one of its rotation handles.
4. Specify how much you want to move the center of rotation using the H (horizontal) and V (vertical) boxes.

For example, if you want to move the center of rotation 3 units to the left and 2 units up relative to the 
bottom-left handle, type -3 in the Horizontal box and 2 in the Vertical box.
The object now rotates around this point.

Notes
The Anchor Point control corresponds to the handles on the object's selection box. To rotate the object 

around one of these handles, enable the corresponding check box. For example, enable the top-center check box to 
rotate the object around the top-center handle.
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To set the object rotation increment
1. Click Tools, Options.
2. Click the Objects tab.
3. Specify an angle using the Rotation Constraint box. You must use a value from 1 to 359.
4. Click Apply.

When you rotate an object with the mouse, Corel Print Space forces it to rotate in the increment you specified.
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Working with grids and rulers
Corel Print Space’s grid and ruler system combines simplicity and precision to help you arrange objects in your 
layouts. Corel Print Space’s movable on-screen rulers provide a visual reference that can help you determine the 
size and position of objects in your drawing. As you move in the drawing window, the rulers let you determine 
your current position relative to the origin (the position where the rulers’ 0 points intersect). You can have the 
rulers display the unit of measurement that best suits your layout.
The grid system works with the rulers to help you align objects accurately. Corel Print Space displays the grid as 
a series of intersecting dotted lines spaced according to your settings. By displaying the grid, you have an easy 
and accurate way to position objects relative to one another and to the printable page. In addition, you can use 
Corel Print Space’s Snap to Grid command to have objects automatically line up with the grid as you move them.
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To set a precise ruler origin
1. Click Format, Grid and Ruler Setup.
2. Click the Ruler tab.
3. Set the ruler origin using the Horizontal and Vertical Origin boxes.

The numbers you specify represent the position of the 0,0 ruler coordinate the origin
relative to the bottom-left corner of the drawing page. For example, if you set 1.0 for the horizontal coordinate and 
5.0 for the vertical coordinate, Corel Print Space places the ruler origin 1 inch to the right and 5 inches up from the 
bottom-left corner of the drawing page.

Tips
You can also set the ruler origin by dragging the ruler intersection point onto the screen. The ruler insertion

point is the button located at the junction of the horizontal and vertical rulers.
Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.
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To change the units of measurement on the rulers
1. Click Format, Grid and Ruler Setup.
2. Click the Ruler tab.
3. Choose the horizontal ruler units.
4. Choose the vertical ruler units.
Note

When you change the ruler units, you must also specify a new grid frequency.
Tips

If you choose inches as the unit of measurement, you can use the Tick Divisions list box to specify how 
many division marks you want between the inch markers.

Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.
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To set the number of tick division marks
1. Click Format, Grid and Ruler Setup.
2. Click the Ruler tab.
3. Choose the option you want from the Tick Divisions list box.
Note

You must set inches as the unit of measurement to specify tick divisions.
Tip

Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.

{button ,AL(`ruler_change_units;;;;;',0,"Defaultoverview",)} Related Topics



To reposition a ruler
Hold down SHIFT and drag the ruler to a new position.

Tips
Hold down SHIFT and double-click a ruler to return it to its previous position.
Hold down SHIFT and drag the ruler intersection point to move both rulers simultaneously.
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To choose a preset drawing scale
1. Click Format, Grid and Ruler Setup.
2. Click the Ruler tab.
3. Click Edit Scale.
4. Choose a drawing scale from the Typical Scales list box.

The drawing scale represents the relationship between the units displayed on the rulers and real world 
distances. For example, if you choose a drawing scale of 1:10, 1 unit on the ruler corresponds to 10 units of 
"real" distance.

Tip
Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.
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To set a custom drawing scale
1. Click Format, Grid and Ruler Setup.
2. Click the Ruler tab.
3. Click Edit Scale.
4. Choose the page distance you want to use as the base unit of your drawing scale.
5. Choose a unit for your drawing scale.
6. Choose the world distance you want represented by each unit of page distance.
Tip

Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.
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To display the grid
1. Click View.
2. Enable the Grid command.

When enabled, the Grid command has a check mark to its left.
Note

You can also display the grid by enabling the Show Grid check box on the Grid and Ruler Setup dialog box.
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To hide the grid
1. Click View.
2. Disable the Grid command.

When enabled, the Grid command has a check mark to its left.
Note

You can also hide the grid by disabling the Show Grid check box on the Grid and Ruler dialog box.
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To set the grid frequency
1. Click Format, Grid and Ruler Setup.
2. Click the Grid tab.
3. Specify how many horizontal and vertical grid lines you want per unit of measurement using the Horizontal 

and Vertical number boxes.
The unit of measurement corresponds to the unit or units set for the rulers.

Notes
Changing the grid frequency unit also changes the corresponding ruler unit. If the drawing scale setting is 

not 1:1, the Grid Frequency units appear grayed out and correspond to the drawing scale units.
The Horizontal and Vertical field units are accurate up to two decimal places.

Tips
To space the grid lines more than one unit apart, specify a Grid Frequency value between 0 and 1. To have 

grid lines 2 units apart, for example, you would specify a grid frequency of 0.5.
Try double-clicking a ruler to open the Grid and Ruler Setup dialog box.
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To have objects snap to the grid
1. Click Format.
2. Enable the Snap to Grid command.

When enabled, the Snap to Grid command has a check mark to its left.
Note

You can also have objects snap to the grid by enabling the Snap To Grid check box on the Grid and Ruler 
Setup dialog box.
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To display the grid on the drawing page only
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Limit grid to extent of page check box.
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Working with guidelines
Corel Print Space’s guidelines serve as a simple and effective way to align objects. Guidelines are non-printing 
horizontal or vertical lines that you can place anywhere in the drawing window. You can then use these 
guidelines as rough or precise visual references to help you align the components of your layout. You can also 
move and delete guidelines as required. When you save your layout, Corel Print Space saves all your guidelines 
so that you can use them as often as you need.
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To move a horizontal guideline
1. Click Format, Guidelines Setup.
2. Click the Horizontal tab.
3. Choose the guideline from the list.

Corel Print Space lists the guidelines by location.
4. Type a new location relative to the 0 point on the horizontal ruler.

If you want to move the guideline to the left of the 0 point, type a negative number.
5. Change the unit of measurement as required.
6. Click Move.
Tips

You can also move a guideline by dragging it.
Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To move a vertical guideline
1. Click Format, Guidelines Setup.
2. Click the Vertical tab.
3. Choose the guideline from the list.
4. Type a new location relative to the 0 point on the vertical ruler.

If you want to move the guideline below the 0 point, type a negative number.
5. Change the unit of measurement as required.
6. Click Move.
Tips

You can also move a guideline by dragging it.
Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To add a horizontal guideline
1. Click Format, Guidelines Setup.
2. Click the Horizontal tab.
3. Type a location for the guideline (relative to the 0 point on the horizontal ruler).

If you want to put the guideline below the 0 point, type a negative number.
4. Choose a unit from the Unit list box.
5. Click Add.
Tips

You can also set up a horizontal guideline by pointing to the horizontal ruler and dragging into the drawing 
window.

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To add a vertical guideline
1. Click Format, Guidelines Setup.
2. Click the Vertical tab.
3. Type a location for the guideline (relative to the 0 point on the vertical ruler).

If you want to put the guideline to the left of the 0 point, type a negative number.
4. Choose a unit from the Unit list box.
5. Click Add.
Tips

You can also set up a vertical guideline by pointing to the vertical ruler and dragging into the drawing 
window.

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To delete a horizontal guideline
1. Click Format, Guidelines Setup.
2. Click the Horizontal tab.
3. Choose the guideline you want to delete.

Corel Print Space lists the guidelines by location.
4. Click Delete.
Tips

You can also delete a horizontal guideline by dragging it off the drawing window.
Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To delete a vertical guideline
1. Click Format, Guidelines Setup.
2. Click the Vertical tab.
3. Choose the guideline you want to delete.

Corel Print Space lists the guidelines by location.
4. Click Delete.
Tips

You can also delete a vertical guideline by dragging it off the drawing window.
Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To delete all horizontal guidelines
1. Click Format, Guidelines Setup.
2. Click the Horizontal tab.
3. Click Clear.
Tip

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To delete all vertical guidelines
1. Click Format, Guidelines Setup.
2. Click the Vertical tab.
3. Click Clear.
Tip

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To delete all guidelines
1. Click Format, Guidelines Setup.
2. Click Clear All.
Tip

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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To display guidelines
1. Click Format, Guidelines Setup.
2. Enable the Show Guidelines check box.
Tip

Try double-clicking a guideline to open the Guidelines Setup dialog box.

{button ,AL(`guideline_proc;;;;;',0,"Defaultoverview",)} Related Topics



To hide guidelines
1. Click Format, Guidelines Setup.
2. Disable the Show Guidelines check box.
Tip

Try double-clicking a guideline to open the Guidelines Setup dialog box.
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Scaling and stretching objects
When you scale or stretch an object in Corel Print Space, you change its horizontal and/or vertical dimensions 
without altering its basic shape. Corel Print Space’s scaling and stretching tools let you opt for speed or precision
as you decide how you want to change objects in your diagrams. The mouse provides the quickest and simplest 
method of stretching and scaling objects. By using two basic mouse actions--clicking and dragging--you can 
stretch or scale any object. The Transform dialog box, on the other hand, gives you the advantage of precision. 
You can use the controls provided to scale your object precisely or to resize it to exact dimensions.
You can use these tools and techniques to stretch any object in Corel Print Space for example, unframed text, 
text frames, lines, and groups.
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To scale an object by a precise amount
1. Select the object.
2. Click Transform, Size.
3. Specify the percentage by which you want to scale the object’s height and width using the Scale Height and 

Width boxes.
4. Click Apply.
Notes

You can use this procedure to scale grouped or multiple objects or text. When you apply your changes, the 
objects maintain their positions relative to one another.

Tip
Enable the Proportional check box to have Corel Print Space maintain the scale proportions as you change 

the horizontal and vertical scale factor.
Change the object's scale anchor point to have one of its sizing handles remain stationary during scaling.
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To resize an object by giving it precise dimensions
1. Select the object.
2. Click Transform, Size.
3. Specify the object’s new dimensions using the Height and Width boxes.
4. Click Apply.
Note

You can also use this procedure to resize grouped or multiple objects or text. When you apply your 
changes, the objects maintain their positions relative to one another.

Tip
Change the object's scale anchor point to have one of its sizing handles remain stationary during resizing.
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To change an object's scale anchor point
1. Select the object.
2. Click Transform, Size.
3. Use the Anchor Point control to specify the handle you want to use as the scale anchor point.

The Anchor Point the series of check boxes to the right of the Height and Width number boxes
represents the selected object's sizing handles. If you want to make the top-left handle the scale anchor point, 
enable the top-left check box.
4. Scale or resize the object using the appropriate controls.

When you click Apply, the point you specified remains stationary.
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To scale an object using the mouse
1. Select the object.

When you select the object, its selection box appears. A selection box consists of eight sizing handles.
2. Drag one of the corner handles to achieve the desired size.

As you drag, the object's center point remains stationary.
Note

You can also use this procedure to scale grouped or multiple objects or text. As you stretch them, the 
objects maintain their positions relative to one another.

Tips
To scale the object in one direction only, hold down SHIFT as you drag.
To scale the object's horizontal and vertical dimensions by different amounts, hold down CTRL as you drag.
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To stretch an object using the mouse
1. Select the object.

When you select the object, its selection box appears. A selection box consists of eight sizing handles.
2. Drag one of the side handles to achieve the desired height or width.

As you drag, the object's center point remains stationary.
Note

You can also use this procedure to stretch grouped or multiple objects or text. As you stretch them, the 
objects maintain their positions relative to one another.

Tip
To stretch the object in one direction only, hold down SHIFT as you drag.
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To stretch an object by a precise amount
1. Select the object.
2. Click Transform, Size.
3. Specify the percentage by which you want to stretch the object’s height or width using the Scale Height or 

Width box.
4. Click Apply.
Note

You can also use this procedure to stretch grouped or multiple objects or text. When you apply your 
changes, the objects maintain their positions relative to one another.

Tip
Change the object's scale anchor point to have one of its sizing handles remain stationary during resizing.
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Selecting objects
Before you begin manipulating the objects in your drawings, you need to know how to select them. By selecting 
an object, you indicate that you want your next action or command to apply to that object only. Similarly, by 
deselecting an object, you indicate that you want to stop manipulating it.
Corel Print Space provides two easy ways to select objects using the mouse. The quickest method involves 
pointing to the object you want to select, then clicking the left mouse button. The second method, called 
marquee selecting, involves dragging the mouse to enclose an object in a "marquee box". Using these simple 
techniques, you can select single or multiple objects, groups, text items, and lines. You can then begin learning 
how to manipulate the objects you’ve created.
In addition, Corel Print Space lets you search for and select objects based on shared properties. For example, you
can select an object, then use Select By Properties to find other objects that have similar outline, fill, and shadow
properties.
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To select an object
1. Click the Pick tool.
2. Click the object.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To deselect all objects
1. Click the Pick tool.
2. Click any open space in the drawing window.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To deselect a specific object
1. Click the Pick tool.
2. Hold down SHIFT and click the object you want to deselect.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To marquee select an object
1. Choose the Pick tool.
2. Drag the mouse diagonally until a marquee box encloses the entire object.
3. Release the mouse button.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To marquee select a group
1. Choose the Pick tool.
2. Drag the mouse diagonally until a marquee box encloses the entire group.
3. Release the mouse button.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.

{button ,AL(`;;select_procedures;;;;',0,"Defaultoverview",)} Related Topics



To marquee select multiple objects
1. Choose the Pick tool.
2. Drag the mouse diagonally until a marquee box encloses all the objects you want to select.
3. Release the mouse button.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To select a group
1. Choose the Pick tool.
2. Click any object in the group.
3. Release the mouse button.
Tip

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
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To select multiple groups
1. Choose the Pick tool.
2. Hold down SHIFT.
3. Click an object in each group.
Tips

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
Hold down SHIFT and click a selected group to deselect it.
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To select multiple objects
1. Choose the Pick tool.
2. Hold down SHIFT.
3. Click each object.
Tips

If you’re using any of Corel Print Space’s drawing tools, press SPACEBAR to choose the Pick tool.
Hold down SHIFT and click a selected object to deselect it.
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To select objects based on shared properties
1. Select an object that has one or more of the properties for which you want to search.
2. Click Edit, Select By Properties.
3. Enable the check boxes that correspond to the properties you want to use for your search.

For example, if you want to find objects that have the same outline width and color as the selected object, 
enable the Width and Color check boxes.

4. Click OK to conduct your search.
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Starting Corel Print Space
Corel Print Space follows all Windows 95 conventions for starting programs. You can start Corel Print Space using 
the Windows 95 Start menu, the run command, or by creating a desktop shortcut.
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To start Corel Print Space using the Start button
1. On the Windows taskbar, click Start, Programs.
2. Point to the folder that contains Corel Print Space.
3. Click Corel Print Space.
Tip

Refer to Windows 95 documentation to learn how to create a shortcut to Corel Print Space.
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To start Corel Print Space using the Run command
1. On the Windows taskbar, click Start, Run.
2. In the Open list box, type Corel Print Space’s folder location and file name.

For example, if Corel Print Space resides on your "C" drive in the directory CORELCAD\PROGRAMS, you would 
type: c:\CORELCAD\PROGRAMS\PRINTSPACE.EXE.

Tip
Refer to Windows 95 documentation to learn how to create a shortcut to Corel Print Space.
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To exit Corel Print Space
Click File, Exit.

Note
If you haven’t saved an open file, Corel Print Space will prompt you to choose whether you want to save or 

discard your changes.
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Undoing and redoing operations
When you work on a layout, Corel Print Space keeps track of the operations and commands you perform. Corel 
Print Space’s Undo and Redo commands let you take advantage of this memory functionality. For example, if you
make a mistake or change your mind about a specific operation, you can use the Undo command to reverse it. 
Similarly, you can use the Redo command to reproduce the operations you reverse.
Corel Print Space also lets you set a limit on the number of consecutive actions you can undo. You can set any 
value from 1 to 99. By setting a high value, you give yourself confidence in knowing that you can change almost 
any previous error. However, setting a high value also takes up more of your computer’s memory, as Corel Print 
Space needs to keep track of your actions. As a result, your computer may operate slightly slower than normal. 
By setting a lower value, you can still provide a good level of safety without sacrificing any computer or program 
speed.
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To undo an operation
Click Edit, Undo.

Note
You can change the number of consecutive operations you can undo, redo, or repeat. Click Tools, Options 

to set the value using the Undo Levels box.
Tip

For quick access to the Undo command, click the right mouse button anywhere in the drawing window, 
then click Undo.
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To set the undo limit
1. Click Tools, Options.
2. Click the General tab.
3. Use the Undo Levels box to specify the maximum number of consecutive operations you can redo or undo.
Note

You must specify a value from 1 to 99.
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To redo an operation
Click Edit, Redo.

Notes
You can only redo an operation you reversed using the Undo command.
You can change the number of consecutive operations you can redo, undo, or repeat. Click Tools, Options 

to set the value using the Undo Levels box.
Tip

For quick access to the Redo command, click the right mouse button anywhere in the drawing window, 
then click Redo.
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Adjusting your vantage point
No two people work exactly alike and no two projects are exactly alike. As a result, how you view your Corel Print
Space layouts can be almost as important as the tools you use to create them. Corel Print Space eliminates any 
questions regarding your vantage point by giving you all the tools you need to examine your work.
Corel Print Space’s Zoom flyout menu provides easy-to-use tools that let you reduce or magnify your view of 
your layout. You can use these tools to get a closer look or an overview of individual objects, groups of objects, 
the drawing page, or the entire layout. Zooming has no effect on the final printed product. Rather, zooming is 
much like moving towards or away from a picture to get a better look at it you change only your vantage point.
Corel Print Space also lets you adjust your viewpoint by moving your layout within the drawing window or by 
having Corel Print Space refresh your window to clear up any marks created by editing actions. As with the Zoom
tools, moving or refreshing your layout has no effect on the final product.
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To magnify an area of your drawing
1. Click the Zoom tool to open its flyout menu.
2. Click the Zoom In tool.
3. Drag the mouse diagonally until the marquee box encloses the area you want to magnify.
Note

You can continue magnifying until you reach the magnification limit for your screen.
Tip

For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 
window or the toolbar.
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To see more of your layout
1. Click the Zoom tool to open its flyout menu.
2. Click the Zoom Out tool.
Note

When you click the Zoom Out tool, your viewpoint zooms out by a factor of two. If you are using a 
magnified view, choosing Zoom Out returns you to the previous viewpoint.

Tip
For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 

window or the toolbar.

{button ,AL(`zoom_proc;;;;',0,"Defaultoverview",)} Related Topics



To see your drawing at actual size
1. Click the Zoom tool to open its flyout menu.
2. Click the Zoom to Actual tool.
Note

When you click the Zoom to Actual tool, Corel Print Space displays your drawing in 1:1 scale. In other 
words, 1 on-screen inch is actually 1 real-world inch.

Tip
For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 

window or the toolbar.
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To zoom in on selected objects
1. Select the objects you want to view.
2. Click the Zoom tool to open its flyout menu.
3. Choose the Zoom to Selected tool.
Note

When you click the Zoom to Selected tool, Corel Print Space magnifies or reduces your viewpoint to display
the selected objects at the largest size possible.

Tip
For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 

window or the toolbar.
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To see all objects in your layout
1. Click the Zoom tool to open its flyout menu.
2. Choose the Zoom to All Objects tool.
Note

When you click the Zoom to All Objects tool, Corel Print Space magnifies or reduces your viewpoint to 
display the objects in your drawing at the largest size possible.

Tip
For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 

window or the toolbar.
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To see the entire printable page
1. Click the Zoom tool to open its flyout menu.
2. Choose the Zoom to Page tool.
Note

When you click the Zoom to Page tool, Corel Print Space magnifies or reduces your viewpoint to display the
entire printable page at the largest size possible.

Tip
For easier access to the tools on the Zoom flyout, point to the flyout's border and drag it onto the drawing 

window or the toolbar.
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To scroll the drawing window
Click next to any scroll bar thumb to move the window in that direction. You can also drag a scroll bar 

thumb to move the window.
Note

You can also use the Panning tool to scroll the drawing window in any direction.
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To refresh the screen
Press CTRL+W. 
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To drag your layout within the drawing window
1. Choose the Panning tool.
2. Drag your layout in any direction.
Notes

Corel Print Space moves the point where you started dragging to the point where you stopped dragging.
You can also drag or click next to a scroll bar thumb to scroll the window.
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Manipulating windows in Corel Print Space
Manipulation of the Corel Print Space window and its drawing windows follows Windows 95 conventions. You can 
resize, arrange, and move these windows the same way you do with conventional Windows 95 programs. Please 
refer to Windows 95 documentation for more information on manipulating windows.
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To resize the Corel Print Space window using the mouse
1. If the window is maximized, click the Corel Print Space window's restore button.
2. Drag a side, top, or bottom border to resize the window horizontally or vertically.

Drag a corner border to resize the window horizontally and vertically.
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To resize the Corel Print Space window using the keyboard
1. If the window is maximized, press ALT, SPACEBAR, R.
2. Press ALT, SPACEBAR, S.
3. Press the Arrow key that corresponds to the border you want to move.

For example, if you want to resize by moving the bottom border, press the Down Arrow key.
4. Press the Arrow keys to move the border.
5. Press ENTER when the window is the size you want.
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To view all open drawing windows
Click Window, Tile Horizontally/Tile Vertically.
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To cascade all open drawing windows
Click Window, Cascade.
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To arrange minimized drawing windows
Click Window, Arrange Icons.

{button ,AL(`window_arrange;;;;;',0,"Defaultoverview",)} Related Topics



To move the Corel Print Space window
Drag the title bar until the window occupies the position you want.
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To move the drawing window
Drag the title bar until the window occupies the position you want.
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Working with frames
Corel Print Space uses frames to lay out CorelCAD files and print them. The frames are containers for CorelCAD 
files. You can change the properties of the frame such as the outline style and the shadow. As well, you can 
change the way in which the CorelCAD file is displayed and printed by setting the View properties and the 
CorelCAD layer properties. View includes rotation, distance, pan and zoom, rendering, and projection. Layer 
properties include, visibility, color, and line style. 
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To create a new frame
1. Click the Frame tool.
2. Position the mouse pointer where you want a corner of the frame.
3. Hold down the left mouse button.
4. Drag the mouse diagonally until the frame is the size you want.
5. Release the mouse button.
6. In the Select CorelCAD Document dialog box, choose the folder and drive.
7. Double-click the CorelCAD file that you want to load into the frame.
Tips

Hold down SHIFT to draw the frame from the center outward.
Enable the Snap to Grid command to draw more precisely.
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To delete a frame
1. Select the frame.
2. Click Edit, Cut.
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Formatting frame outlines
Every frame you create has outlines. Corel Print Space's frame formatting tools give you the power to change 
these outlines. You can choose specific outline types, widths, and colors. In addition, you can apply these formats
to a particular frame or to all frames you add to your layout.
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To change a frame's outline width
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Type a new outline width in the Pen Width box.
Tips

Enable the Set as default check box to apply these settings to all new frames.
To choose a preset outline width, click the Outline tool, then click the width you want.
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To redraw a frame using a solid, dashed, or dotted outline
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Choose a line style from the Line Style list box.
Tips

To apply these settings to all new objects, enable the Set as default check box.
For quicker access to preset outline styles, click the Outline tool.
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To change a frame's outline color
1. Select the frame.
2. Click Format, Symbol.
3. Click the Outline tab.
4. Click the Color picker, then click the color you want. If you want to create or select a custom color, click Other.
Tips

To apply your settings to all new frames, enable the Set as default check box.
Use the on-screen color palette to change a frame's outline color more quickly. Select the frame, then click 

the color you want with the right mouse button.
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To change a frame's corner radius
1. Select the frame you want to edit.
2. Click Format, Line.
3. Click the Outline tab.
4. In the Corners box, click the button that corresponds to the corner radius you want.

To specify a precise corner radius, type a value in the box provided.
Tip

To apply these settings to all new objects, enable the Set as default check box.
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To copy outline attributes from one frame to another
1. Hold down the right mouse button on the frame with the attributes you want to copy.
2. Drag the frame over the frame to which you want to copy the attributes.
3. Release the mouse button, then click Copy Outline.
Tip

You can also use this procedure to copy the object's outline attributes to a line.
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Applying shadow effects to a frame
By applying a shadow effect to a frame, you give it a three-dimensional appearance. Corel Print Space lets you 
apply simple or complex shadows to any frame in any layout. You can also choose to set a default shadow that 
applies to all new frames. In all cases, you control the direction and offset of the shadow as well as its fill and 
outline attributes. You can even apply multiple shadows to a frame to enhance the three-dimensional effect.
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To set the direction of a frame's shadow
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Enable the Direction button that corresponds to the direction you want.
Tips

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply multiple shadows to a frame
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Type the number of shadows you want in the Number box.
Tips

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To set the shadow offset
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Specify a new offset value and unit using the boxes provided.
Tips

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To set a shadow's outline color
1. Choose the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Outline picker, then click the color you want.

Click the Other button to create or select a custom color.
Tips

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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To apply a shadow with a uniform fill
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Uniform Fill button.
6. Click the color picker, then choose the color you want.

Click the Other button to create or select a custom color.
Tips

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.

{button ,AL(`frameshadow_proc;color_overview;;;;',0,"Defaultoverview",)} Related Topics



To apply a shadow with a fountain fill
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Fountain Fill button.
6. Click the button that corresponds to the type of fountain fill you want.
7. Use the color pickers to choose the fill's start and end colors or click the Edit button to create a custom 

fountain fill.
Click the Other button to create or select custom colors.

Tips
To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.

{button ,AL(`frameshadow_proc;color_overview;;;',0,"Defaultoverview",)} Related Topics



To apply a shadow with a pattern fill
1. Select the frame you want to edit.
2. Click Format, Symbol.
3. Click the Shadow tab.
4. Enable the Use Shadow check box.
5. Click the Pattern Fill button.
6. Click the Pattern picker, then click the pattern you want.
7. Click the topmost color picker, then click a color for the pattern's foreground.

Click the Other button to create or select a custom color.
8. Click the bottom color picker, then click a color for the pattern's background.

Click the Other button to create or select a custom color.
Tip

To apply your settings to all new frames, enable the Set as default check box.
For quick access to preset shadows, click the Shadow tool.
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Changing the view in a frame
You can change the view of a CorelCAD file in the frame using the View command on the Format menu. Display 
options such as projection and render can be set. As well, you can scale and position the file in the frame.

{button ,AL(`frame_over;;;;;',0,"Defaultoverview",)} Related Topics



To change the projection in a frame
1. Select the frame.
2. Click Format, View.
3. In the Projection list box, choose a projection.
Note:

Enable the Set as default checkbox, to choose the selected projection as the default for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the render type in a frame
1. Select the frame.
2. Click Format, View.
3. In the Render list box, choose a render type.
Note:

Enable the Set as default checkbox, to choose the selected render type as the default for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display render shadow in a frame
1. Select the frame.
2. Click Format, View.
3. Enable the Render Shadow checkbox.
Note

Enable the Set as default checkbox, to have Render Shadow as the default for all frames. If you choose to 
use the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape 
Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display text in a frame
1. Select the frame.
2. Click Format, View.
3. Enable the Text checkbox.
Note

Enable the Set as default checkbox, to show text as the default for all frames. If you choose to use the Set 
as default checkbox, all changes made during the current session in any of the tabs for the Shape Properties dialog 
box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display dimensions in a frame
1. Select the frame.
2. Click Format, View.
3. Enable the Dimensions checkbox.
Note

Enable the Set as default checkbox, to show dimension lines as the default for all frames. If you choose to 
use the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape 
Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display silhouettes in a frame
1. Select the frame.
2. Click Format, View.
3. Enable the Silhouette checkbox.
Note

Enable the Set as default checkbox, to show silhouettes as the default for all frames. If you choose to use 
the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape Properties
dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To display colored hidden lines in a frame
1. Select the frame.
2. Click Format, View.
3. Enable the Color checkbox.
Note

To set the color of hidden lines, you must have Hidden or Hidden (Visible) selected in the Render list box 
and Silhouette must be disabled.

Enable the Set as default checkbox, to show colored hidden lines as the default for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the scale in the frame
1. Select the frame.
2. Click Format, View.
3. In the Scale list box, choose a preset scale.
Note

Enable the Set as default checkbox, to choose the selected scaling option as the default for all frames. If 
you choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for 
the Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To customize the scale in a frame
1. Select the frame
2. Click Format, View.
3. In the Printed Units box, enter the value of the printed unit.
4. In the Real World Units box, enter the equivalent value in the CorelCAD file.

For example, if you want to print your drawing at a scale of ¼ inch = 1 foot, enter ¼" in the Printed Units box 
and 1' (or 12") in the Real World Units box.

Note
Enable the Set as default checkbox, to choose the customized scaling values as the default for all frames. 

If you choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for 
the Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the position of the file in the frame
1. Select the frame
2. Click Format, View.
3. Enter a value in the Pan X box to move the file left or right.
4. Enter a value in the Pan Y box to move the file up or down.

The display box above illustrates how the file looks in the frame.
Note

Enable the Set as default checkbox, to choose the selected position of the file as the default for all frames. 
If you choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for 
the Shape Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the CorelCAD file in the frame
1. Select the frame
2. Click Format, View.
3. Click Browse.
4. In the Select CorelCAD Document dialog box, choose the folder and drive.
5. Double-click the CorelCAD file you want to load.
6. Click OK.
Note

Enable the Set as default checkbox, to choose the selected file as the default for all frames. If you choose 
to use the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape 
Properties dialog box will be set as the default.

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



Using CorelCAD layers in Corel Print Space
When you have created a CorelCAD file and placed it in a frame in Corel Print Space, you can then determine 
which of the layers is to be displayed in the frame. The Layers tab in the Shape Properties dialog box allows you 
make layers visible and invisible. It also allows you to change the line style and color for each layer. However, 
the settings in this dialog box only affect the frame in Corel Print Space and not the CorelCAD file.

{button ,AL(`frame_over;;;;;',0,"Defaultoverview",)} Related Topics



To display a CorelCAD layer in a frame
1. Select the frame
2. Click Format, Layers.
3. Click the layer in the Layers list box.
3. Enable the Visible checkbox.
Note

Enable the Set as default checkbox, to set the selected layer as visible for all frames. If you choose to use 
the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape Properties
dialog box will be set as the default.

{button ,AL(`framelayer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To hide a CorelCAD layer in a frame
1. Select the frame
2. Click Format, Layers.
3. Click the layer in the Layers list box.
3. Disable the Printable checkbox.
Note

Enable the Set as default checkbox, to set the selected layer as hidden for all frames. If you choose to use 
the Set as default checkbox, all changes made during the current session in any of the tabs for the Shape Properties
dialog box will be set as the default.

{button ,AL(`framelayer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the color of objects in a CorelCAD layer 
1. Select the frame
2. Click Format, Layers.
3. Click the layer in the Layers list box.
3. Enable the Override Color checkbox.
Note

Enable the Set as default checkbox, to set the color for objects in the selected layer for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`framelayer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the line style of a CorelCAD layer
1. Select the frame
2. Click Format, Layers.
3. Click the layer in the Layers list box.
3. In the Line Style list box, choose a line style.
Note

Enable the Set as default checkbox, to set the selected line style as the default for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`framelayer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To change the color of a CorelCAD layer
1. Select the frame
2. Click Format, Layers.
3. Click the Color button.
4. Choose a color from the color palette.

If you want to choose a color other than those on the palette or create your own color, click Other.
Note

Enable the Set as default checkbox, to set the selected layer color as the default for all frames. If you 
choose to use the Set as default checkbox, all changes made during the current session in any of the tabs for the 
Shape Properties dialog box will be set as the default.

{button ,AL(`layer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To reset CorelCAD layers
1. Select the frame
2. Click Format, Layers.
3. Click Reset.

{button ,AL(`layer_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set full image resolution
1. Click Tools, Options.
2. Click the Advanced tab.
3. Click Full: Large images may take a long time to print.

{button ,AL(`preference_proc;;;;;',0,"Defaultoverview",)} Related Topics



To set automatic image resolution
1. Click Tools, Options.
2. Click the Advanced tab.
3. Click Automatic: Let Print Space reduce the resolution of large images.

{button ,AL(`preference_proc;;;;;',0,"Defaultoverview",)} Related Topics



To show/hide all CorelCAD views
Click View, Show All CAD Views.

Note
This command toggles between Show All CAD Views and Hide All CAD Views.
Enable Hide All CAD Views on the View menu to ensure that the CorelCAD images are not redrawn each 

time you edit the frames in your layout. When you have finished editiing, click View, Show All CAD Views.
If you select None as your render type in the View tab of the Shape Properties dialog box, you can hide the 

CorelCAD image in the current frame. 

{button ,AL(`3dview_proc;;;;;',0,"Defaultoverview",)} Related Topics



No related topics were found.



No procedure topics were found.



Sets the display options for the selected frame. It allows you to change the projection, rendering, scale and 
position of the CorelCAD file. As well, you can set the display of shadow, text and dimensions. Settings in this 
dialog box only affect the drawing in Print Space the CorelCAD file remains unchanged.



Displays the name of the current view. To switch to another view, click the arrow to the right of the view name 
and select a view from the list.



Displays the rendering quality to be applied to the drawing in the frame. To switch the rendering quality, click the
arrow and select a quality from the list. The option "None" allows you to display a frame with no image, which 
allows you to arrange frames quickly without having to wait for the screen to redraw. 



When this check box is enabled, the image in the frame will be rendered with shadow. Shadow will only appear in
the rendered image if you have selected one of the higher quality rendering modes (Preview to Raytrace full).



When this check box is enabled, text included in the file will be displayed.



When this check box is enabled, dimensions will be displayed.



Select a scale for the printed image. Click the arrow to the right of this box to select a predefined scale, AutoFit, 
Fit to Frame, or Custom from the list. If you select Custom, you must then use the next two boxes to specify the 
number of printed units relative to real world units. If you select Fit to Frame, the CorelCAD file is sized to fit the 
frame. If you select AutoFit, the largest CorelCAD view is used to fit the frame.



Enter a value and a unit (e.g. 3") to specify the size of the printed image relative to the real world units. It 
represents the left side of the scale equation (e.g. ¼" = 1').



Enter a value and a unit (e.g. 1') to specify the size of the printed image relative to the real world units. It 
represents the right side of the scale equation (e.g. ¼" = 1').



Displays the position of the image within the frame.



Updates the display of the image in the Position window.



Select a positive value to move the image to the right within the frame, or a negative value to move it to the left.



Select a positive value to move the image up within the frame, or a negative value to move it down.



Click here to search for another file from the drives and folders to which you have access. Select a file to load it 
into the Print Space frame.



Displays the name of the current CorelCAD file in the frame.



Opens the View tab on the Shape Properties dialog box. This tab provides controls for changing the view of the 
CorelCAD file in a frame. 



Opens the Layer tab on the Shape Properties dialog box. This tab provides controls for CorelCAD layers.



Displays the layers from the CorelCAD drawing in the selected frame. It allows you to make layers visible or 
invisible. It also allows you to change the line style and color for each layer. Settings in this box only affect the 
drawing in Print Space the CorelCAD file remains unchanged.



Enable this checkbox to make the selected layer visible and printable. Disable it to make the layer invisible and 
not printable.



Enable this checkbox if you want the layer color to override any color selected for specific objects in your 
drawing. (e.g. if your CorelCAD drawing has an object on the F-WALL layer that has the color red assigned to it 
from the color palette, the object will be displayed in red if the Override Color check box is not enabled. If 
Override Color is enabled and blue is selected from the Color palette, blue will override the assigned color for the
object.)



Displays the line style for the selected layer. To change the line style, select another line style from the list of line
styles.



Displays the color for the selected layer. To change the color, click the arrow to the right of this box to display a 
color palette, then select a color.



Click this button to clear all settings and return to the layer settings specified in the CorelCAD drawing.



Frame Tool
Lets you create a frame on the working page of your layout in which you can associate a CorelCAD file.



Displays the available layers in the CorelCAD file and indicates whether the layer is visible or colored. If the icons
for Visible and Color are CorelCAD icons, the CorelCAD layer settings are being used.



Hides all interior lines in the drawing, producing a silhouette effect.



Displays the hidden lines in color.



Sets the image resolution to full. A high resolution is used to render the drawing.



Sets the image resolution automatic. A lower resolution is used to render the drawing faster.



Displays all of the CorelCAD images in the current layout. The command toggles between Show All CAD Views 
and Hide All CAD Views. Hide All CAD Views hides all of the CorelCAD images.




